


1

N



Using
Dreamweaver 4



Other Computer Titles

by

Robert Penfold

BP450 How to Expand and Upgrade Your PC
BP467 How to Interface PCs
BP470 Linux for Windows users
BP479 How to Build Your Own PC
BP484 Easy PC troubleshooting

Other Titles of Interest

BP433 Your Own Web Site on the Internet
BP483 Fun Web Pages with JavaScript
BP504 Using Flash 5
BP494 Basic Internet Skills
BP490 Web Pages Using Microsoft Office 2000
BP404 How to Create Pages for the Web Using HTML
BP501 XHTML and CSS Explained
BP453 How to Search the World Wide Web Efficiently
BP403 The Internet and World Wide Web Explained
BP464 E -Mail and News with Outlook Express
BP420 E -Mail on the Internet
BP477 Using Microsoft FrontPage 2000
BP461 Using FrontPage 98
BP488 Internet Explorer 5 Explained
BP460 Using Microsoft Explorer 4 on the Internet
BP507 Easy Internet Troubleshooting



Using
Dreamweaver

Robert Penfold

Bernard Babani (publishing) Ltd
The Grampians
Shepherds Bush Road
London W6 7NF
England
www.babanibooks.com



Please note

Although every care has been taken with the production of this book to
ensure that any projects, designs, modifications, and/or programs, etc.,
contained herewith, operate in a correct and safe manner and also that
any components specified are normally available in Great Britain, the
Publisher and Author do not accept responsibility in any way for the
failure (including fault in design) of any projects, design, modification,
or program to work correctly or to cause damage to any equipment that
it may be connected to or used in conjunction with, or in respect of any
other damage or injury that may be caused, nor do tie Publishers accept
responsibility in any way for the failure to obtain specified components.

Notice is also given that if any equipment that is still under warranty is
modified in any way or used or connected with home -built equipment
then that warranty may be void.

c 2001 BERNARD BABANI (publishing) LTD

First Published - April 2001

British Library Cataloguing in Publication Data

A catalogue record for this book is available from tie British Library

ISBN 0 85934 503 3

Cover Design by Gregor Arthur

Printed and bound in Great Britain by Cox and Wyman



Preface

No doubt many potential users of Dreamweaver are reluctant to give the
program a chance because it is the standard web design program for
professional users. In general, top programs for the professionals have
a reputation for being difficult to learn and use. Dreamweaver "breaks
the mould" by being straightforward to learn and use while still having
the power to produce large and sophisticated web sites. Whether you
wish to build a simple text -on y web site or a huge site having all the
"bells and whistles", Dreamweaver can handle the task and it will not
make life unnecessarily difficult. Beginners at web site design can start
with a simple site and develop it into something more sophisticated as
their expertise increases. Those with some experience of web site design
should soon learn to produce impressive results using Dreamweaver.

Although Dreamweaver is an HTML editor, it is not necessary to learn
HTML coding in order to use the program effectively. It can be used to
design web pages by placing text and images on the WYSIWYG (what
you see is what you get) design view, and ther letting Dreamweaver
write the code. It is possible to expand the capabilities of the prog -am
by adding your own code, and ultimately you may well wish to do things
this way. Initially though, it is easier to concentrate on designing pages
using the WYSIWYG method. Very sophisticated sites can be produced
in this way, so it is by no means essential for Dreamweaver user3 to
learn HTML coding.

Dreamweaver is available in a Windows PC verson and for Macintosh
computers. The PC versior was used in the production of this book,
but in use there is very little difference between the two. The differences
are mainly brought about by the use of different conventions in the way
the two types of computer are used, and by differences in the
nomenclature used in menus. Provided you are reasonably fluent in the
use of a Macintosh computer you should have I ttle difficulty following
the methods described in this book. Even if you use the PC version you
will still need to know the fundamentals of using the computer, but with
either version you do not need to be a computer expert.

No previous experience with Dreamweaver or of web design is requ red
to use this book. It seems reasonable to assume that anyone learning
to use Dreamweaver is familiar with using web sites and knows a few
Internet basics. This book can be used on its own to learn about



Dreamweaver, but it is strongly recommended that it is used in
conjunction with the program itself. The only way to learn about any
creative software is to try it out, follow a few examples, and then try
some ideas of your own. PC and Macintosh demonstration programs
can be downloaded from the Macromedia web site
(www.macromedia.com), and these are fully operational for 30 days.
About an hour or so per day for half that period should be sufficient to
become reasonably skilled in using Dreamweaver.

Robert Penfold

Trademarks
Microsoft, Windows, Windows Me, Windows 98 and Windows 95 are
either registered trademarks or trademarks of Microsoft Corporation.

All other brand and product names used in this book are recognised
trademarks, or registered trademarks of their respective companies.
There is no intent to use any trademarks generically and readers should
investigate ownership of a trademark before using it for any purpose.
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Interface

Dabbling
Programs for building web sites tend to have reputations for being difficult
to learn and use. I suppose it is fair to say that learning to use a program
like Dreamweaver is a bit more difficult than leaning to use a typ cal
word processor. This does not mean that mastering Dreamweaver is
difficult in absolute terms, out unlike many modern word processors, it
is not "child's play". With a word processor it is possible to produce
letters and other simple documents just by "playing" with the program
to see what things do. In fact it would probably be possible tc produce
quite long and sophisticated documents in this way, given sufficient time.

With a program like Dreamweaver you are unlikely to produce a
worthwhile web site using the "suck it and see" method. This approach
works well enough with word p-ocessors, drawinc programs, and many
applications programs. However, with these programs you can produce
the finished article without ary outside assistance. These days virtually
all programs have the ability to import files from other pieces of software,
but you can still produce a great deal of excellent work without using
this facility. The situation is dif'erent with an applica'ion like Dreamweaver,
where the finished article is often largely assembled from components
produced using other programs.

I will not say that it is impossible to produce a really sophisticated web
site using Dreamweaver afore, because it might just be possible. I will
state categorically that this is not the normal way of tackling things. Trying
to produce a top quality web s to using Dreamweaver alone is a bit ike
trying to make a table and chairs using a full set of carpentry tools but
no wood. Dreamweaver is best regarded as the tools for the job, but
not the raw materials.

Ideally you should learn a litt1e background information and have some
source files to experiment with prior to trying out Dreamweaver for the
first time. Being realistic about things, few peopla will be able to resist
the temptation to run the program and start clicking on a few icons at

1
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1 Interface
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Fig.1.1 The opening screen should look something like this

the earliest opportunity. Consequently, we will look at the user interface
first, and then consider some background information. However, you
may wish to return to this section after reading the next chapter in order
to make sure you have a clear understanding of the user interface. Later
chapters cover each part of the user interface in detail, explaining how
Dreamweaver can be used to assemble professional looking web sites.

This book can be used as a sort of primer so that you have a good idea
of how things work when you finally start using Dreamweaver. It is not
primarily intended for use in this way though, and ideally you should
have a computer with Dreamweaver installed so that you can actually
try out the facilities of the program and experiment with them. There are
plenty of examples to follow, but in order to exploit any creative program
it is necessary to experiment and "do your own thing". In this way you
learn just what the program can and can not achieve, and gain fluency
in its use.

Note that it is not essential to buy Dreamweaver in order to try it out. A
demonstration version sometimes appears on the cover discs of
computer magazines, and it is also available as a free download from
the Macromedia web site at www.macromedia.com. The file for the

2



Interface

Dreamweaver demonstration is substantial at
around 25 megabytes, but it should take no
more than about two hours tc download using
a 56k modem. Once installed you have what is
actually a fully working version of Dreamweaver,
but it will only operate for 30 cays. This should
be more than adequate to go through the
examples in this book and do some
experimenting of your own. The Save function
of the demonstration program is fully
operational, so you can save your work ready
for use if you should decide to buy "the real
thing".

User interface
When Dreamweaver 4 is run you should get
something like the screen of Figure 1.1. The
exact appearance depends on the screen
resolution used, the sizing of the windows, etc.,
but there should be a mair window, complete
with a menu bar. There are fox- other windows,
all of which are "floating" anc can therefore be
positioned where you wish. Three of them are
also resizable, and any or a I of them can be
closed if they are not needed. There is a toolbar
beneath the menu bar, but this can also be
closed via the View menu. It can be toggled on
and off via the Toolbar entry in this menu.

Compared with many programs the
Dreamweaver user interface can look a little
cluttered and messy, but yoJ have to bear in
mind that it is being used to perform tasks that
are rather more complex tian most pieces of
software. The user interface of Dreamweaver is
not particularly cluttered by the standards of
graphic oriented programs and it is really quite
efficient. Things are kept as straightforward as
possible by having windows and palettes that
are context sensitive. In other words, the
contents of the window or palette changes
according to the type of thing you are doing at

Commoi

r-r- r-

1 6a2riii"

ii

View

OL)

Fig.1.2 The Objects
palette
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Fig.1.3 The default Preferences dialogue box

the time. This avoids filling the screen with unnecessary elements that
are not relevant to the types of task being undertaken. It has to be
admitted that context sensitive windows and palettes are not to
everyone's liking, and some users prefer a consistent user interface.
However, with complex software, even if you are using a high -resolution
screen, there is usually no practical alternative to this way of doing things.

Most people find a well designed context sensitive interface easier to
learn than one having vast numbers of tools, etc., permanently on the
screen. As these things go, Dreamweaver does not have one of the
more challenging user interfaces. If you would really prefer not to use
this type of interface any more than is absolutely necessary, then use
the conventional menu system wherever possible and use the palettes,
etc., only when there is no alternative.

Objects palette
The vertical palette on the left in Figure 1.1 is the Objects Palette. In its
standard form this has icons that act as buttons, and an enlarged view
of it is shown in Figure 1.2. To select an alternative version go to the Edit
menu and select the Preferences option. This will bring up a window
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Interface 1

like the one in Figure 1.3. The range of options
available depends on the category selected
in the left-hand column. In this case it is the
default category (General) :hat is required.
The Object Panel entry near the bottom of the
window provides three options, which are Text
Only, Icons Only, and Text and Icons.
Selecting the latter changes the Objects
Palette to one like Figure 1.4. This has the
advantage of providing a name for each icon,
making it easier to remember the function of
each one. The drawback is nal the palette
shows only a relatively limited r umber of tools
at any one time unless it is expanded to
virtually the full height of the screen.

EMU
Common

Image

-

Rollover ..

Table

IT '11 Tabular ..

a Layer

Also, bear in mind that positioning the cursor co
over an icon in the Icon Only version of the oNavigatio..
palette brings up a short description of the
icon under the pointer. Even so, you might Horizont
prefer to use this version whi e learning to use
the program. The Text Only version (Figure cf.
1.5) is reasonably compact and explicit, and Layout
is the one to opt for if you do not like an icon

t'" 'sbased user interface. Note that the little up
and down arrows in the palette enable it to
be scrolled if there is insufficient space for all T..
the objects to be displayed at once.

Whichever version of the palette you decide
to use, its function is the exactly same. It

largely duplicates the Insert menu, and gives Fig.1.4 The text and
quick access to a range of oojects that can icons versi)n
be added to a web page. It is not necessary
to understand the available objects at this stage, but some are fairly
straightforward, such as image, table, and date. The Objects Palette is
a context sensitive part of the user interface, and the defau17. palette is
just one of six that are available. It is possible to select any of the six
palettes manually by left -click ng on the downward pointing arrowhead
towards the top right-hand corner of the palette. This produces a fly -out
menu from which the required palette can be selected (Figure 1.6).
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COMMOn
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Rollover I...

Table
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Navigatio...

Horizonta...

Email Link:

Date

Server -Si...

Fireworks...

Layout
L f?.

Y.it 1.4 .

Characters

Common

Forms

Frames

Head

Invisibles

Special

L.4

4A

Layout

,

Fig.1.5 The text version Fig.1.6 Switching between pages

The Common palette is the default version, and is the one shown in
Figures 1.3 to 1.5. Three of the other palettes are shown in Figure 1.7
and the other two appear in Figure 1.8. These are shown in their Icon
Only versions, but all six palettes are also available in Text Only and Text
and Icon guises. Various types of objects are covered in detail later in
this book, but here is a brief description of the type of objects found in
each palette.

Common
As its name suggests, this palette contains the objects that are used the
most frequently, and hence it is the default palette. It is used for things
such as images, the date, layers, and tables.

6
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'Forms -

Fig.1.7 The Characters, Forms, and Frames palettes

Characters

This palette gives easy access to text characters that are not included
on an ordinary OWERTY keyboard. Typical examples are the C copyrigt-t
symbol, the R and trademark symbols, and currency symbols suci
as the Yen (Y). In other words, what are often referred to as symbols ii
word processor terminology and when dealing with scme graphics
programs.

7
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Special

m
ktiO

_ Layout

--Mew

Fig.1.8 The Head, Invisible, and Special palettes

Forms

If you have ever filled in an online questionnaire, order form, etc., you
will have made use of text boxes, radio buttons, checkboxes, and simple
menus. This palette provides the special componeits of this general
type that are needed when producing forms.

8
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Frames

Frames are used in many web sites these days, and the idea of frames
is to divide a web page into multiple and effectively independent HTML
pages. If you look at anything other than a very basic web page you will
notice that it is divided into separate zones, and in most cases each of
these is a frame. This palete provides access to framesets that enable
the frames to peacefully coexist on the same web page. This facil ty is
available if you are using Dreamweaver versions 3 or 4, but not in earlier
versions.

Head

This palette is used to place objects into the Head tag of a web page.
This could, for example, be a META tag containing a keyword to help
Internet search engines find your web site. Objects of this type are not
actually visible on finished web pages, but they are still an important
part of most web sites.

Invisibles
Further invisible objects are available via this palette. For example, many
web sites use very long pages rather than large numbers of pages. It

can then be useful to have a link to a particular position on the page
rather than just a general link to the top of the page. An invisible ooject
called a named anchor car provide a link of this type.

Special

This is used to add Java applets, ActiveX controls, and plug -ins. The
Special palette is not included in versions prior to Dreamweaver 4.

Layout View
The buttons at the bottom of the Objects Palette are also new to
Dreamweaver 4, as is the layout view. By defau t the program operates
with the Standard View, but it can be set to Layout View by operating the
right-hand button in the View section at the bottcm of the Object Palette.
The two buttons just above this in the Layout section then become active,
and they enable tables to be produced quickly and easily. Tables can
be used to display data in tabular form, but they can also be used as
means of accurately laying opt web pages. The layout view and layout
tables are designed to make life easier when using tables in t-iis fashion.
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Fig.1.9 The Properties Inspector with text selected
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Fig.1.10 The Properties Inspector with an image selected

Properties Inspector
The non-resizable window towards the bottom of the screen is the
Properties Inspector. This is very similar to equivalent features in many
graphics and desktop publishing programs. If you select some text for
example, the Properties Inspector will show various parameters of that
text, such as the font, letter size, and alignment. In addition to ordinary
desktop publishing and word processor properties there will also be
web site related parameters such as link information. The Properties
Inspector is context sensitive, so the parameters it displays will change
to suit the item or items selected for inspection. Figures 1,9 and 1.10
respectively show the Properties Inspector with some text and an image
selected.

Of course, although this window is called the Properties Inspector, it can
be used for more than just looking at the properties of the selected
objects. It is really a properties editor rather than ar inspector. If some
text is selected, its font, size, etc., can be changed using the Properties
Inspector. In Figure 1.11 the mouse has been left clicked on the
arrowhead beside the font listing, and this has brought up a list of
available fonts. Left clicking on one of the fonts in the list changes the
text to that font.

D di, FOCI
anal.1-Mrsaca, sint-psnt
TImes Ns. Raman. Tomes.
Coks,er Nev. Couts mono
box Times New

Ewmatida,

1.,01 AIV IMMA
II Al 04

Fig.1.11 The font menu of the Properties Inspector
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Fig.1.12 The Properties Inspector has a pop-up colour palette

Colour is important in web design, and the Properties Inspector makes
colour changes easy. Operating the button to the left of the B (bold text)
button brings up a colour palette, as shown in Figure 1.12. Left clicking
on the one of the squares it the colour chart changes the selected item
or items to the chosen colour. Alternatively, operating the button with
the circular icon at the top of It e colour palette brings up the new wirdow
of Figure 1.13. Here you can produce your own custom colours that
can then be applied to objects.

Using buttons, menus, etc., it is possible to alter the size of images, text
styles and alignment, or any property that is shown in the Properties
Inspector. When designing a page you are likely to change your mind

Col or ? x
Ussic colcrs

77E7 711111-1-
E NI FR NI

. 1-I ..t'"'..
r-smommusN ummome.

INKEV171111-
...istom colors

( 0. J Cancel

ColorISQluo 20 Blue

Add to Custom Color; a
Fig.1.13 With this window 1! is possible to produce custom colours
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Assets for Site 'Lessons - Ore... 12

TH' Plane Mpg

swapTe,t_surhn
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swapText_biking
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surfing_on.gif
surfing. gif
SpacerTranspare
spacer_cleargif

CI 49
Fig.1.14 The Assets palette

quite frequently about factors
governing the appearance of
objects, and the Properties
Inspector makes it possible to
quickly implement these
changes. It is important to
practise using this feature and to
become reasonably expert in its
use.

Reference and
Styles
The Reference window is part of
the built-in help system. It
provides three online reference
books dealing with HTML,
JavaScript, and CSS. This is
undoubtedly a useful feature, but
does not really justify having this
window permanently on the
screen. Operating the Assets tab
changes this panel to one that is

designed to give centralised control over the assets (image files, etc.)
used in the web site (Figure 1.14). Left clicking the Refresh button at the
bottom of the panel results in the image files used in your web site being
listed in the main section of the panel. The buttons down the left-hand
side of the panel allow other types of asset to be selected, such as
colours and URLs (Figure 1.15). Operating the Favorites radio button
results in only the selected assets being shown rather than all assets of
the relevant type in the site. The HTML Styles panel (Figure 1.16) enables
text to be formatted using HTML tags.

Launchers
Dreamweaver has two launchers, one of which is the Mini Launcher that
is situated at the right-hand end of the status bar at the bottom of the
screen (Figure 1.17). The purpose of the launcher is to provide a quick
and easy way of activating palettes and panels. Once launched, a panel
or palette can be closed using the close button on its window, or by
operating its button on the Mini Launcher. In commor with many modern

12
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programs, but particularly
graphics types, Dreamweaver
can be largely controlled via
floating windows of one type or
another. Many functions are also
available via the pop -down
menus, but the palettes and
panels generally provide a
quicker method of control.
Unfortunately, even when using
a high -resolution screen it can be
difficult to work with a screen that
is permanently cluttered wish
small windows.

Clearly you should work using
whatever set-up you find the best,
but most users probably
maximise the main document
window and have whatever
palettes or panels they need
opened on top of the main
window. You soon get used to
opening windows when they are
needed and closing
them again when they
are not. Remember
also, that none of the
small windows are
anchored, and that
they can all be moved
around the screen.
This enables them to
be positioned where
they will not be too
much in the way.
Another point to keep
in mind is that virtually
all the windows are to
some extent
resizable. This can
again help to keep
them as unobtrusive
as possible.

Assets for Site 'Lessons - Dre...

..>Peferencel Id Assets

UFILs. 6` Site r Favorites

Ar

t1

http //download macron-

Value

httpNdownload.m... HTT

4l 1

Fig.1.15 Various asset types
can be selected

HTML StylesniTe. Be
Clear Selection St ,'le

,11' Clear Paragraph Style
a+ E:old

11 Caption
11 Copyright

Emphasis, sans -serif
Fixed -width

Fig.1.16 The HTML Styles palette
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I1020 x 668 1 sec ota ti)  di (i)
Fi.g.1.17 The Mini Launcher is in the bottom right-hand corner of the

document window

:rt j i >
Site Assets I-TML Styles CSS Behavtors I 1-6sttcy Code Inspector Po.

Fig.1.18 The Launcher offers the same facilities as the Mini version

Assets

LiJ

HTML Styles

CSS Styles

Behaviors

History

Code Inspector

Fig.1.19 The vertical
form of the
Launcher

The Launcher (Figure 1.18) has the same basic
function as the Mini Laur,cher, but it is in the
form of a conventional pa ette. To activate the
Launcher select Launcher from the Window
menu. It can be closed by repeating this process
or via the usual close button on the Launcher
window. The Launcher is easier to use than the
mini version because it is larger and has text
descriptions below each icon. It can usually be
positioned out of the way at the right-hand end
of the title and menu bars. However, if you can
get used to the small icons of the Mini Launcher,
there is little point in using the larger version.
Although the Launcher window is not resizable,
by left clicking on the smal button in the bottom
right-hand corner it can be switched to operate
vertically (Figure 1.19). Left -click on the button
again to switch the window back to the
horizontal version.

History
It is worth experimenting with the Launcher or
Mini Launcher to see what happens when the
various icons are operated, even if you do not
understand the exact function of the pop-up
windows at this stage. The History palette
(Figure 1.20) shows the last actions performed

14



Interlace 1

on the current frame. Try bring ng
up this window on the screen and
typing some text onto the main
document window. Left clicking
on this window will produce a
standard text cursor towards he
top left-hand corner, and some
text can then be typed onto the
screen. If you use the Properties
Inspector to change the text style,
font, and colour you will find that
each change is listed in the
History palette. Like the History Fig.1.20 The History palette
palette in some graphics
programs, it does not meraly
show each change, but car be used to undo and redo actions. Move
the slider at the left of the screen upward to unco actions, and mcve it
down again to reinstate tl-em. Note that this feature is in add tion to the
standard facility to undo and redo the last act on, which is available
from the Edit menu. The H story palette can also be used to generate
and replay a sequence of commands, giving a form of macro facility.

History j_il-&,)errne
A

Code Inspector
With Dreamweaver it is poss ble to produce web pages by using a largely
or even totally visual approach. In other words, you add text by typing
it onto the screen, change its size or colour by selecting the text and
setting the required
parameters using the
Properties Inspector,
and so on. Changes
made can be seen 4).

on the screen, but
the screen of ="0000000"

Text' </font></p>Dreamweaver is faoe=*Georgie, Times Now Roman, Times, senlf
one thing and the .=',CC0033">Text.</font></font> </p>

screen of a

browser is another.
Dreamweaver has to
convert the web .11

pages you generate Fig.1.21 The Code Inspector shows the
on the screen into HTML code
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Fig.1.22 Various window sizes are available from this menu

Preleruncos

do,
Code Formes
Code Rewriting
CSS Styles
Fie Types / Editors
Fonts / Encoding

Irnssibie Elements
Layers
Layout View
Panels
Preview in Browser
D000i Tsq F ditor

Sleius Bei

Dndow Sizes (Ph ht1211fc.-I

I .

Connechun Spelled I. Id 1.11,euit. psi Sid,wit.1

bundler P Show Launder in Steii.s Bei

Oc I encel I Help

Fig.1.23 The preset window sizes are customisable
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code that standard browsers can interpret correctly. The code usec by
browsers is HTML, and the Code Inspector (Figure 1.21) shows the code
that is generated by Dreamweaver. This is actually a simple editor, and
it can be used to add your own code or modify the existing code.

Document window
This is the main window that has the menu bar, etc., at the top, and t is
the one that shows the WYSIWYG representation of web pages. -he
Mini Launcher in the status bar at the bottom of this window has already
been covered. The left-hand section of the status bar shows the relevant
HTML tags for the current selection. Further along the status bar there
is a box that shows the size of the document window in terms of p.xel
width and height. If you drag tie window to resize it, the states display
will show the window's new size. There are some popular preset sires
available if you left -click on the size box to bring up a menu (Figure
1.22). The appropriate 13-eierences window appears (Figure 1.23) if

you select the Edit Sizes option and it is then possible to edit the existing
sizes or add new ones.

The box to the right of the size indicator is the statistics indicator, and it
shows the size of the web page in terms of kilobytes, together with the
download time using a 28.3k modem. Incidentally, other standard
modem speeds are available via the preferences window for the status
bar (Figure 1.23). We would all like to produce dynamic and exciting
web pages, but it is as well to keep the download times reasonably
short. Users will not appreciate your artistry if they get fed up waiting for
the page to download and move on to another s te! Bear in mind that
the indicated download time assumes a perfect connection. Real world
loading delays are likely to be somewhat longer than the figure indicated.

Customising
A degree of customisation is possible with the document window via
the View menu. The first three options enable this window show the
HTML code, the normal design view, or both using a split screen (Figure
1.24). Amongst the other options there is the ability to show a grid on
the screen, and the Edit Grid option in the submenu brings up the winc ow
of Figure 1.25. This enables the size and colour of the grid to be adjusted,
and either dots or lines are available. The Snap to Grid opt on in the
submenu enables the grid tc cperate as a snap grid as well as a visual
type.
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Fig.1.24 The main window can be split to show both code and
design views

Another option in the View menu enables rulers to be displayed along
the left and top edges of the document area, and the rulers can be
calibrated in inches, centimetres, or pixels. These can also be very useful
when you need to position objects with good precision. Select Rulers
and then the Show option to turn the rulers on or off. Select Rulers and
then Pixels. Inches, or Centimetres to set the units of measurement.
Figure 1.26 shows the document window with both rulers and a line grid

added, but in normal
use you would
probably settle for
one or the other and
not both. Placing the
pointer at the point
where the two rulers
join and then
dragging the origin toDisplay a Lines
the desired point onQots beip
the screen relocates
the origin for theFig.1.25 The Grid Settings menu rulers. Crosshairs
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Fig.1.28 The Preferences window for invisible elements

appear on the screen (Figure 1.27) while this is being done. Go to the
View menu and select Rulers and Reset Origin to reset the 0-0 origin to
the top left-hand corner of the screen.

Invisible elements

The main document window gives a WYSIWYG view of the web pages
you produce, and the pages therefore appear the same within
Dreamweaver as they will when viewed using a browser. Obviously this
is normally what is required, and it avoids having to load web pages into
a browser in order to see what they will look like in use. On the other
hand, web pages often include things that are hidden away in the
background and are not supposed to be seen by users.

An example of this is comments added into the code by the programmer
to remind him or her what each section of code is for. These invisible
elements can be made visible or hidden from view by going to the View
menu and selecting Visual Aids and then Invisible Elements. This
operates in standard toggle fashion, and there is a tick against the menu
entry when this feature is enabled. You can select The elements that are
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Fig.1.29 When using the spit screen mode, text selected in one view

is selected in the o.'her as well

shown on the screen via the appropriate preferences window (Ficure
1.28). Go to the Edit menu select Preferences, and then let -click on
Invisible Elements in the list an the left.

Editing text
Text can be typed into the main document window, which is in many
ways like a text editor or word processor. The usual Cut, Paste, and
Copy options are available from the Edit menu. To select text ei-.her
double-click on a word to se.ect that word, or hold down the left mouse
button and drag the cursor over the text you wish to select. If the window
is used in split mode to show the code and design views simultaneoL sly,
text selected in one section o' the window will also be selected in the
other section (Figure 1.29). Arything selected in the design window will
also be highlighted in the Code Inspector if this is already active or if it is
launched after a selection has been made. Left cicking on a paragraph
tag (<p>) in the code view or the Code Inspector will select the
appropriate paragraph in the design view.

21



1 Interface

f_

' 111111frk _ _

4.7

9.1 :F. !I 1.1*.

T11

i we elf.nre on1,99n1

ran .9.n.. Colov.....1
IbIe ins. bake on
90.10  AN.» r 

- Al

laim D 0

Fig.1.30 The grouped palettes can be ungrouped if preferred

Entering and editing text into the document view of Dreamweaver is not
quite as free and easy going as entering text into a modern word
processor, but a lot of word processor style features are present. Chapter
4 explains the finer points of typing or loading text into Dreamweaver.

Finally
For the benefit of those not familiar with this type of interface it is perhaps
worth pointing out that where panels are grouped together, such as the
History, Layers and Frames panels, they can be separated if desired.
Simply drag the tab of a panel away from the group, and the rest of the
panel will follow. Drag the tab back into place to reunite it with another
panel or group of panels. Figure 1.30 shows some panels that have
been separated in this way. If you use Dreamweaver a great deal there
are many other customisable features that can make the program quicker
and easier to use.
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Background

Beneath the surface
Web pages are written using what could be regarded as a form of
programming language, known as HTML (hypertext mark-up larguage).
As its name suggests, it is actually more like a mark-up language used
in a desktop publishing program than a true programming lalguace.
Those of us that can remember desktop publishing in the days before
that term had been invented can also remember the relatively crude
way in which pages were produced. There were no true WYSIWYG
(what you see is what you gat; desktop publishing programs for the
early PCs and other computers of that era.

Instead, embedded codes were used to indicate that pieces of text should
be in a certain font, style, and size. What appeared on the monitor was
the text plus the embedded codes in the standard font of the text card.
This was usually a pretty cruda monospaced font. In order to see wi-at
a page looked like you had to print it out. If there were any problems or
you simply did not like some aspect of the page design, the embedded
codes had to be changed and then the page was printed out agaln.
This sounds like slow and tough going, and it was.

Modern desktop publishing programs do not work on this basis, and
the monitor does provide something close to a true WYSIWYG display.
The resolution of even a good monitor is usually well below the fir al
printed resolution, requiring some compromises to be made in the
version displayed on the monitor, but you get a good idea of what the
final printed version will look li.'e before it is proof printed. This is not to
say that the embedded codes have disappeared, and they are still used
by some programs. There is often a mode that enables the user to sae
the raw text plus these codes and even make changes to the text and
the embedded codes.

However, with a modern WYSIWYG desktop publishing program there
is no need to use or know anytling about the method of codi -lg. You
can simply format pages using tie palettes, pop -down menus, etc. Tie
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program displays a good facsimile of the final printed version, generates
the embedded codes, and eventually converts the text and code into
the finished product.

Originally it was necessary to understand HTML before you could
produce web pages, because there was no WYSIWYG program that
would do the job for you. The situation has changed over the years of
course, and there are now plenty of programs that enable web pages to
be produced by those having no understanding of HTML. In some cases
the program may totally shield the user from the underlying HTML code,
but even though you can not see it the code is still there. HTML is the
language understood by web browsers, and it is what all web site and
web page creation programs have to generate.

Roundtrip HTML
Dreamweaver is a WYSIWYG program that generates web sites in HTML.
Producing web pages using Dreamweaver is in many ways like using a
WYSIWYG desktop publishing program, and changes made to the font
size or colour of some text will be immediately represented on the display.
The HTML code will also be changed, and the user can look at the code
that the program generates. Dreamweaver's main claim to fame is that
you are not restricted to simply looking at the HTML code, and you can
make manual changes to it. This is what is called "roundtrip" HTML in
Dreamweaver terminology.

With most HTML editors that have a WYSIWYG mode you can not
manually change the code that is generated. All changes have to be
made via the program's tools and menus rather than by direct changes
to the HTML. This may seem a rather strange way to do things, but
these programs can only handle HTML code written in a specific fashion.
Any code produced manually may not conform tc the program's way of
doing things and can not be interpreted properly. In some cases
Dreamweaver may not be able to understand the code you have written,
but it will still leave it intact rather than trying to change or delete it.
Provided you have written the code correctly, it will be carried through
to the web site and will work properly.

On the face of it, roundtrip HTML is not of any importance. You can
produce web pages using the tools, menus, etc., without the need for
any manual editing of the code. Indeed, you do not need to see the
code let alone make changes to it. To some extent this is true, and
beginners will prefer to use the WYSIWYG approach rather than trying
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to write any HTML code themselves. One reason it is of importance to
more advanced users is because HTML has not reached the stage where
it is properly standardised. It is still being developed to meet tie
increasing demands that are p aced upon it. With Dreamweaver ypu
can add up-to-date HTML code that Dreamweaver can not understar d,
and it will be used in the web sire. Whether all browsers will be able to
interpret it correctly is another matter. You should always endeavour to
develop sites that will still be usable by people who do not have the very
latest versions of the popular browser programs. Another reason 'or
adding your own code is that little enhancements tiat are not otherwise
possible using Dreamweaver can be incorporated into web pages.

Although Dreamweaver enables you to write your own HTML code. it
has to be emphasised that you do not need to know anything about
HTML in order to use the program effectively. It is tempting to say that
you can get by with Dreamweaver if you know nothing about HTML
code, but you can actually do much more than get by with it. Very
sophisticated sites can be produced using Dreamweaver in its VVYSIWvG
mode, and no "home made" HTML code. On the other hand, as with
many things in computing, the greater your knowledge of how things
work, the better the results you are likely to produce. Also, with a deep
understanding of how things work you are in a much better position to
sort out problems when things do not go according to plan.

If you only wish to produce some relatively straightforward web sites
there is probably no need to bother too much about learning HTML
code, now or ever. If you wish to produce web sites that push the
technology to its limits you will certainly have to learn about HTML, aid
probably a few other things as well. Even if you decide not to learn
HTML coding, I would certainly recommend learning a few basics of this
subject, and you will certainly need to understand some of tie
terminology.

Mark-up
HTML is derived from SGML (standard general mark-up language), which
is a standard for the representa:ion of text in digital form. Like Adobe's
popular PDF (portable document format) it was designed not to be
specific to one type of computer or operating system. This cross platfo-m
capability is retained in HTML, and web pages can therefore be viewed
correctly on a Mac, a PC using any practically any version of Windows,
Linux, or whatever, or on any sys:em that has a suitable browser program.
Another reason for the success of HTML is its hyperlink feature, or just
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plain "links" as they are often called. If you use the Internet you can
hardly fail to have encountered these. Practically every web page has
links to other pages in the same site, to pages in other sites, or in some
cases to other places on the same over -length web page. Most browsing
is done by clicking on links rather than typing web addresses into the
browser.

HTML basics
You can get an instant example of basic HTML by running Dreamweaver
and launching the Code Inspector. Although the default web page will
be empty initially, it still has a basic HTML description, and this will be
visible in the Code Inspector (Figure 2.1). Each HTML page must have
certain tags, and these are the HTML, head, title and body tags. A tag
indicates what the code is describing, and in the case of the HTML tag it
is the page itself. Many (but not all) tags use opening and closing
containers. If you look at the code for the default page you will notice
that it starts with "<html>" and finishes with "</html>". These are
respectively the opening and closing containers, and because the HTML
tag is for the entire page, they appear at the beginning and end of the
code.

Most elements of HTML code are comprised of three sections, which
are the tag itself, the attribute, and the value. If you look at the default
code there is a section like this:

<body bgcolor="#FFFFFF" text="#000000">

</body>

Here body is clearly the tag, and the attribute is "Dgcolor", which is the
background colour. The attribute is in double quotation marks, and is a
numeric value that determines the background colour. Although
#FFFFFF may not look like a number, that it is because it is in
hexadecimal and not ordinary decimal numberiig. Hexadecimal, or
just "hex" as it is often called, operates in base '6 and uses numbers
from 0 to 9 plus letters from A to F. The hash (#) sign indicates that the
number is in hexadecimal and not in decimal. A value of #FFFFFF is
the maximum value that can be used and gives a white background.

Try changing the value to #AAAAAA and then left clicking on the main
document window. This should change the background to a mid -grey
colour. Repeat the process using values of #00FFFF, #FF0OFF, and
#FFFF00. These should produce background colours of cyan, magenta,
and yellow respectively, which are the three pr mary colours. Each
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/body>
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Fig.2.1 Some HTML code displayed in the Code Inspector

primary colour has its own two -digit strength value, and by using the
appropriate value for each cne it is possible to produce any colour within
the video system's repertc ire. In the case of colour it is not usually
worthwhile doing things manually, because the program provices a
colour mixing tool to make the job much easier. However, this simple
example does serve to show Vie basic way in which the coding operates.

Tags
When just about anything s added to an HTML page, at the code level
it is a tag plus an attribute a lc a value. In Figure 2.2 a bitmap image has
been added to the page. The image is selected in the design view, so
its code is shown highlighted in the Code Inspector to the right of the
image. The tag is " < img", and the attribute that follows this is "src", or
the source of the image in other words. The value is the path and filename
for the image file. It will be apparent from this that the value in HTML
code does not have to be .3 numeric value. It can be whatever data is
needed to permit the object to be displayed correctly. Note That the tag
selector in the bottom left-hand corner of the screen shows the relevant
tag or tags for whatever is ;elected in the document window.

You can learn quite a lot about HTML code simply by add ng otjects
into the design view of and then examining the code that Dreamweaver
generates. Unlike some WYSIWYG web programs, Dreamweaver
produces what is usually efficient and straightforward HTML code so it
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Fig.2.2 The highlighted text in the Code Inspector window is the

HTML code for the image of an anchor

is relatively easy to see what is going on. You shoulc find it quite easy to
edit things like text and the names of objects using tie code view or the
Code Inspector. Once you have grasped a few basic concepts, learning
HTML code should not be too difficult.

Why use HTML
Using HTML may seem to be doing things the harc way, but there are
good reasons for using a mark-up language for web pages. It is possible
that we will all have high-speed Internet access before too long, but until
then the average Internet connection can only handle data at a rate of a
few kilobytes per second. The screen image on an average computer is
a bitmap that contains around one to four megabytes of data. A simple
web page sent as a bitmap would require the transfer of a similar amount
of data, and a large scrollable page would require a much larger transfer.

Data compression techniques could reduce the amounts of data involved,
but it could still require something like 100 to 300 kilobytes per page.
This represents a download time of around 20 seconds to one minute
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per page with a 56k modem and a pretty gooc telephone connection.
With a poor connection these times would have to be doubled or trebled.

Using a mark-up language such as HTML it is possible to reduce simple
web pages to just a few kilobytes of data. Complex pages can still
require the transfer of substantial amounts of data, especially where
large colour photographs are involved. However, HTML helps to keep
amounts of data to low leve s where this is possible, and keeps dowiload
times relatively short. A few compromises may be involved in using a
mark-up language, but at present the advan7ages far oLtweigl the
drawbacks. Where some degree of interactiity is required, s mply
downloading pages as bitmaps will not give the desired result anyway.
With an increasingly interacrive Internet there is no real alternative to
HTML. JavaScript, etc.

File types
As pointed out in the previoLs chapter, Dreamweaver is mostly used in
conjunction with files generated using other programs. These pros rams
work in their own file formats, but can also generate files in certain
standard formats so that they can export work to programs like
Dreamweaver. Although Dreamweaver can not handle a huge rarge of
file types, it can handle tne most important ones for web use, and most
programs of relevant types can therefore export files to Dreamweaver.
These are the most importart of the standard file types:

Jpeg or Jpg
Whether called Jpeg or Jpg, it is pronounced jay -peg. This is now the
most common format used for bitmaps. A bitmap is an image t-iat is
made up of dots, or pixel; as they are termed. A computer monitor
produces images in this fashion, and any type of graphic can be
represented as a bitmap. However, it produces large files and often
gives relatively poor results when applied to ine drawings. This file
format is mainly used with photographic images, or pseudo photographic
images, where it enables good results to be obtained without resorting
to large file sizes. The modest file size is achieed using compression,
and with some programs you can use varying degrees of compression
and up to three different types.

Note that the small file sizes obtained when using high degrees of
compression are obtained at the expense of reduced picture qual ty. In

Internet applications it is clearly helpful to have small files in order to
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Fig.2.3 This Jpeg image has been subjected to minimal compression,
and has a file size of about 900k

keep download times to a minimum. On the other hand, there is no
point in having an image that downloads quickly if no one can see what
it is meant to be! The borderline between acceptable and unacceptable
quality is a subjective matter, and can only be determined using the
"suck it and see" approach. Figure 2.3 shows a photograph that has
been saved in Jpeg format using minimal compression, and Figure 24
shows the same photograph with maximum compression. These
produce file sizes of about 900k and 100k respectively, and there is
surprisingly little difference between them. However, with a colour image
any artefacts added by the compression tend to be more noticeable, so
this monochrome image is perhaps overstating the case for using large
amounts of compression.
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Fig.2.4 This version of the photograph has been compressed to about
100k of data

GIF

The full name for this format is CompuServe GIF, and programs that use
it have to be licensed by CompuServe. This format is generally preferred
for line ar. such as graphs and most diagrams, or practically any ion -
photographic images. In fact the GIF image format is sometimes used
for monochrome photographs, but these days Jpeg is the mere popular
choice for images of this type. With suitable images it combines small
file sizes and high quality. Up to 256 colours is supported, and these
can be any colours rather than those from a predetermined set. No
compression is used with this format, but the file sizes are kept small by
the inherently compact method of storing images.

With a line art format the image is stored on the basis of (say; a line of a
certain width going from one co-ordinate to anotler, rather than as 3 set
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This is some text that
will look chunky if
it is enlarged, due to
the low resolution
of the bitmap used
to produce it.

Fig.2.5 Bitmaps tend to give poor results
when enlarged

chunky looking results when printed large.

cf pixels to depict the
line. An advantage of
this system is that
images are produced
in high quality on
high -resolution
printers, etc. The
higher the resolution
cf the output device,
the higher the quality
cf reproduction with
line art images.
Bitmap images,
unless very large
numbers of pixels are
used, produce rather

Figure 2.5 shows an example
of this effect. GIF files can be used for simple animations incidentally.

Png

This is a relatively new file format for images, and it is apparently
pronounced pong, as in nasty smell or Ping-Pong. It is designed to be
a sort of universal licence -free image format that wi I eventually replace
the GIF format. Although relatively new, any reasonably modern browser
should be able to handle Png images (Internet Explorer 4 or later for
example). These days many graphics programs can export images in
this format.

Txt

This is a simple text file, and any word processor or text editor should be
able to produce a file in this format. It is important to realise that this
type of file can only handle basic text, and that all or virtually all formatting
information is lost when a file is saved in this format. Hard carriage
returns should be retained, but text size, font, anc colour information
are lost. Tabulation tends to go astray when text is swapped using this
format. You can use a word processor to generate blocks of text and
then format then in Dreamweaver, but it might be better to export the text
in HTML format. In practice this method will not give perfect results
every time, but no more than a small amount of editing should be needed
to restore any lost formatting. Most modern word irocessors such as
Microsoft's Word can save documents in HTML format.
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Swf

Files in Macromedia Flash format. These are used to provide animations
including rollovers, etc.

Aif or Aiff
A sound file format.

File types are usually indicated by a three or four letter extension b the
filename. For instance, a tile called myphotol .jpg would be a bi:map
image in Jpeg format. Three letter extensions were used in the days of
MS/DOS, but this limit is not present in modern operating systems.
However, some people still use three letter extensions, and it is for this
reason that some extensions exist in three and four letter vers ons. Thus,
a Jpeg image file can have jpg or jpeg as its extension.

Conversion
Such is the importance of th 3 web these days that practically any graphics
program can produce files in GIF or Jpeg format. In many cases both
formats will be available, while in others only one or the other will be
available, depending on the types of image the program is designed to
handle. Being relatively new the Png format is less well supported, but
as pointed out previously, it is nevertheless supported by many modern
graphics packages. It is inc uded as an output format in the la-.er versions
of Adobe PhotoShop for example. If your graphics program does not
support at least one of the popular web graphics formats you are cerainly
using the wrong program for this type of work.

If you are not prepared to switch to a different program there is the
option of using a conversion program. A file saved in a standard graphics
format can be converted to a GIF, Jpeg, or Pric file using one of these
programs. Commercial software of this type seems to be a bit "thin on
the ground" these days, but it can usually be found from one of the
larger shareware suppliers. Graphics programs such as hoto Shop
and Paintshop can import and export images in a wide range of file
formats and can therefore be used as conversion programs, although
this is rather under -utilising their abilities.
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Other formats
There are other file formats in use on the Internet, but most of these are
not used in quite the same way as (say) a Jpeg image that forms part of
a web page when it is viewed using a browser. It is more usual for these
other file formats to be downloaded and then viewed and (or) heard via
a suitable program such as a media player. Some of the more common
of these file types are listed here:

AVI

A movie format that can also handle sound.

Mpeg or Mpg

Another movie format that can handle sound as well.

Mov

Apple QuickTime movie/animation files.

PDF

This is the Adobe portable document format. It is actually a general-
purpose file format that can handle text and any type of image. This
book was sent to the printers in the form of a PDF file for example. A
high degree of compression is used, but results of excellent quality are
produced. Adobe Acrobat Reader is needed to view PDF files, but the
reader program is free from the Adobe web site and is available for
several types of computer and various operating systems. The popular
web browsers link to the reader program so that they can effectively be
used to display PDF documents. This format is a popular choice for
complex and (or) large documents.

MP3

An audio format that uses a large amount of compression but still
manages to produce some impressive results.

MIDI

MIDI was originally designed for use with synthesisers and other
electronic musical instruments. A MIDI file can be played by having a
synthesiser connected to the MIDI port of a ccmputer, but these days
most sound cards can play MIDI files, albeit with a 'air amount of help
from the soundcard's driver software.
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Note that the standard web graphics file types can be used where large
or complex images need to be cownloaded, and they are not restricted
to use within web pages.

DHTML
DHTML is an extension of HTML that uses a variety of technologies to
permit clever things to be ac-iieved. For example, graphics or other
objects can change when the pointer is placed over them, or other things
can change when the pointer is at a certain point on the page These
are languages that DHTML uses in addition to standard HTML, with a
brief explanation of each one.

JavaScript
This should not be confused with the Java programming language, which
is completely different. The Java name was licensed by Netscape from
Sun Microsystems, but only the name was used, not Java technolocy.
JavaScript is now very popular and is used to add all manner of clever
tricks to web sites. It is often used to provide better interactivity with the
user. For instance, many financial web sites can produce graphs showing
price data for shares and this tyoe of thing. Without JavaScrip-. a chart
has no interactive capability you wish to zoom it on part of the chart,
either it is not possible at all, or fresh parameters hae to be set and then
the chart is redrawn "from scratch".

With JavaScript charts you can use the mouse to indicate the part of the
chart that is of interest, and then you get a zoomed view of that section.
Using JavaScript it is rather I ke using a charting application on your
computer rather than just downloading web pages, and I suppose that
when using JavaScript you are downloading and using a program on
your computer. JavaScript is used in other ways, such as for rollovers
and testing browser compatibility. Note that you do not have to learn
JavaScript in order to use it with Dreamweaver. If you should decide to
learn JavaScript it is more difficult to master than HTML, but should not
be difficult for anyone having some previous programming experience.

CSS

CSS stands for Cascading Style Sheets. This is a relatively new page
layout system but it is supported by any reasonably up-to-date browser.
It is designed to give better and more precise control over page layoLts
than HTML.
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DOM

DOM is the acronym for document object module, and it provides a link
to external scripting and programming protocols such as ActiveX. It

also enables so-called plug -ins to be used, such as Flash or Shockwave.

XML

XML (Extensible Mark-up Language), like H-ML, is based on SGML.
Extensible simply means that it can be extended and it is extended by
designers creating their own tags. XML is a subject that goes beyond
the scope of this book.
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Basic pages
Armed with the background knowledge of the previous chapter and the
knowledge of the Dreamweaver user interface gained in chapter 1, the
best way forward is to produce some simple web pages. If you have
experience with a word processor, or better still a desktop publishing
program, producing simple web pages using Dreamweaver should be
relatively straightforward. Even if you have only limited computing
experience it should not be that difficult, but it is assumed here that the
reader has a basic knowledge of how to use his or her computer. It is
also assumed that the reader has used the Internet and knows wl-at
web pages look like and how they are used.

Open
As with most programs, Dreamweaver can load existing files so ff-at
they can be updated, or new files can be created "from scratch' . At this
point there will obviously be no existing HTML files of your own to open,
but some sample files are loaded onto the hard disc during the installation
process. If you wish to load and look at these go to the File meru,
choose the Open option, and then use the file browser to select one of
the example files. Left -click or the Open button and the selected file will
be displayed in the main document screen.

By default the file browser will show any type of fi e that Dreamweaver
can open. However, left clicking on the downward pointing arrowhead
at the right end of the "File of type" text box produces a list of file types
(Figure 3.1). You can then select a specific file type, which makes it
easier to find the one you require in a folder that has a large number of
files of various types. As is new standard practice, Dreamweaver has a
list of recently opened files listed near the bottom of the file menu. In

order to load one of these simp y left -click on its entry in the list.
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New and Save
To create a new document go to the File menu and select New. This will
create a blank document with the default settings in the main document
window. Having created web pages you will need to save them to disc
for later use. To save the currart page select Save from the File menu,
which will bring up the usual fila browser window (F gure 3.2). By default
documents are called Untitledl , Untitled2, etc., but you can edit the
name in the text box to someThing more suitable and then operate the
Save button to save the document to disc under this name.

Of course, once a document I -as been saved, it is immediately saved to
disc the next time the Save option is selected. Its existing name will be
used, and the original copy will De overwritten. Dreamweaver does rot
make backup copies of old versions when new versions of files are saved.
Use the Save As option to sake the document under a differerr name.

Extensions
By default, files are saved with a htm extension in the case of PCs, or an
html extension if you use a Mac. The default extension can be altered
by going to the Edit menu and selecting the Preferences option. This
brings up the window of Figure 3 3. If you do not wish to use an extension
at all, remove the tick in the Add Extension When Saving check pox. a

different extension is required make appropriate changes to 9- e text in
the textbox just to the right of this.

One use of the Save As feature is to save copies of a document to disc
so that they can be opened and modified later. This provides a quirk
means of generating several web pages that are basically similar,
although it is necessary to take great care to remove anything from tie
original that is not needed in the new version. There is also a template
feature, and it is well worthwhile investigating this when you have become
more fluent at using Dreamweaver.

You may sometimes make unsatisfactory modifications to a page and
wish to revert to the original version. The History palette is one option
here, but provided the document has not been saved since you started
altering it there is an easier option. Simply close the document withcut
saving it. Select Close from the Edit menu and Men operate the No
button when you are asked if you wish to save changes to the docume it.
Then operate the No button when asked if you wish to Exit Dreamweaver.
The original version of the document can then be opened in the normal
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Fig.3.5 A background image that uses the tiling method. This works
best with an image that 's small relative to the page size,
rather than an image tfiet almost fits the page, as here

way. In order to close a document but save any changes that have been
made, use the same process but left -click on the Yes button when asked
if you wish to save changes to the document.

Page properties
The Properties Inspector provides control of the characteristics of
individual objects on a page, but it is also possible to set default
characteristics for an entire page. In order to bring up the Page Propert es
window (Figure 3.4) select Page Properties from the Modify menu. Most
of the options available from tiis dialogue box are fairly straighdorwad.
The Title option sets the text that will appear in the title bar of the web
page. There are colour charts that enable background, text, and I nk
colours to be selected, or you can type in the colour values. A
background image can be chosen, and the filename (with full path) can
be typed into the appropriate text box. There is a file browser available
though, and this is the easier and more reliable way of selecting the
required file.
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Fig.3.6 A tracing image added to the page. This will not be visible
when the page is viewed using a browser

If the background image is larger than the web page it will not be resized
to fit the page, but will instead be clipped. In other words, the left-hand
and (or) bottom of the picture will be cut off. Similarly, if the image is too
small to fill the web page it will be made to fit the page using the tiling
method (Figure 3.5). Ideally, where necessary the image should be
resized using a graphics program so that it is the correct size for the
web page. If you wish to use the tiling method, it works best if the
picture is small in relation to the page size so that a large number of tiles
are used. If the image is nearly as large as the page, the viewer tends to
get the impression that something has gone awry when the page loaded.
An advantage of the tiling method is that it enables a small image file to
be used. which helps to keep download times short.

Tracing image
The Tracing Image option enables an image to be placed on the page,
and its transparency can be set so that it can be reduced to a weak
background image if required (Figure 3.6). This image will be visible in
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Fig.3.7 The offset from the upper left-hand corner of the page
is adjustable

Dreamweaver, but it will not De carried through tc the final web page. Its
purpose is to aid the product on of a page that is being copied from a
paper mock-up produced using a graphics program. When viewed within
Dreamweaver the tracing image will hide any ordinary image 9- at it

overlaps, but any hidder images will appear properly when the web
page is viewed using a brcwser. To hide the tracing image go to the
View menu, then select Tracing Image and Show. This option toggles
the image on and off.

There are further options that enable the position of the in -age to be
altered, including the Adjust Position setting. This brings up a simple
dialogue box (Figure 3.7) tl-at enables the offset from the top lett-hand
corner of the screen to be altered. In the example of Figure 3.7 it has
been set to 30 pixels acro;s (X) and 25 pixels down (Y). Choosing
Reset Position results in the image being returned to its previous position.
Align With Selection aligns t -le top left-hand corner of the image with the
corresponding corner of wf-atever object is selected at the time. In the
example of Figure 3.8 the image has been aligned with a short text sting.
Of course, this option will not do anything unless something is selected
when the command is issued.
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Fig.3.8 Here the image has been aligned with the top of the text string

Web pages often have a pale image used as the background, but the
tracing image facility is obviously not usable in this fashion because the
image is not visible on the final web page. Instead, the background
image must be added using the background image facility. The image
can be faded using the brightness and contrast controls of a graphics
program prior to it being imported into Dreamweaver.

It is useful to bear in mind that you do not have to operate the OK button
and exit the Page Properties dialogue box in order to see what any
changes look like. Operating the Apply button will immediately implement
any change. Obviously the Page Properties window will often partially
obscure the image underneath, but you can usually see the page well
enough to gauge whether or not the desired effect has been achieved.
The Page Properties window can always be moved slightly if necessary.

Colour conscious
The subject of colour selection has been mentioned previously in this
book, and it is worthwhile looking at the subject in a little more detail
here. As we have already seen, the colour of objects is set using a six -
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digit hexadecimal number, tut in Dreamweaver, as with most programs,
there are colour palettes that make it easy to select the desired colour
without bothering with hexadecimal values. You simply select the cc lour
you require from a chart, or mix the colour if nothing in the preset selection
is suitable. Dreamweaver then adds the appropriate hexadecimal value
into the HTML code. If you have used any graphics software you should
be familiar with colour palettes, and should not have any difficulty in
using the colour selection 4acilities of Dreamweaver. Even if with no
experience of this type of software, the basic colour chart selection
method requires no further comment. Just left -click the "eyedropper"
on the required colour to select it. Although various parts of Dreamweaver
permit colour selection, things have been kept as simple as possible by
having the same colour picker in each case.

The "eyedropper" tool can actually be used to select a colour from
anywhere within a Dreamweaver window, but not outside the areas of
the screen used by Dreamweaver. If an image is displayed within the
document window
for example, any

image can be
gcolour used in that cFFFFFF

selected using the
"eyedropper" tool.
Also, a menu of
alternative colour
sets can be
produced by left
clicking on the
arrowhead in the

Fig.3.9 The colour sets menutop right-hand
corner of the colour
picker window (Figure 3.9). As pointed out previously, a colour -mixing
palette can be produced by operating the button with the circular con
just to the left of the arrowhead. This makes it easy to produce any
desired colour.

Suppose that a strong but 'dark blue is required, similar to navy blue.
The main part of the window on the right gives the colours of the rainbow
at the top, and the same colours diluted with and increasing amouit of
mid -grey towards the bottom of the panel. In other words, there are
saturated colours at the top and increasing unsaturated versions of these
colours towards the bottom. Nothing on this panel meets our
requirements, but a strong blue colour can be selected by left clicking

Color Cubes

Continuous Tone
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Fig.3.10 Using this colour palette it is possible to mix any desired
colour that the 24 -bit system can handle

on a mid -blue colour towards the top of the panel. The cross -hairs sight
moves to show the new colour selection. The slider to the right of the
panel shows the selected colour in the middle, with increasing amounts
of white towards the top, and black towards the bottom. In this example
we require black added to the blue to darken it, and the slider is set
towards the bottom of its range. If you try to approximate the settings
shown in Figure 3.10 you should end up with a suitably dark blue colour.

The colour chart in the left-hand section of the window can be used as
an alternative method of providing a basic colour that can then be
adjusted using the slider control. The range of colours available here is
relatively limited, but it will often provide a suitable basis for the required
colour. Simply left -click on the required colour to select it and then
adjust the slider control. In order to add a newly mixed colour to the
custom colours beneath the main colour chart, first left -click on the
rectangle you wish to contain the new colour. Then left -click on the Add
to Custom Colours button to assign the new colour to the selected
rectangle.
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Web friendly
The problem in selecting web page colours on one computer is that
they may be somewhat different when displayed on another computer.
One reason for this is simply that different monitors produce different
colours from the same colour values. In actual 'act, the same monitor
will produce different colours depending on how it is set up. A second
problem is that not all computers have the same colour capabilities.
Apart from differences between Macintosh computers and PCs, there
can be differences between ccmputers of the same general type. Some
PCs have simple graphics cards offering relatively few colcurs, while
others have graphics systems that can handle millions of different colc urs.
A further complication is that the operating system and applicat ons
software might impose limits on the colours that can be used.

There is a set of so-called "browser safe" or "web safe" colours that can
be reproduced by the popular Microsoft and Netscape browsers in both
their Windows and Macintosh versions. Using these 200 or so colours
does not guarantee that precisely the specified colour will be produced
on every computer, but it does at least keep the inevitable divergences
to a minimum. The "browser safe" colours are those that have 00 33,
66, 99, CC, or FF as the hexadecimal values for each of the primary
colours, but note that a few of the possible combinations are not
guaranteed to always be spot on. In the menu of Figure 3.9 you will
notice that there is a Web Safe option. When this is selected the
"eyedropper" tool will only produce "web safe" colours and where
necessary the chosen colours will be adjusted tc the "web safe" cclour
that produces the nearest match.

Of course, the system colours produced using the colour mixing pa ette
can be any colours within the repertoire of 16.7 million or so that this
method supports, and in most cases will not be ol the "web safe" variety.
This does not mean that system colours will not work in practice. It

simply means that the precise colours you chocse will not necessarily
be exactly matched when they are displayed or "real world" monitors
using popular browsers. As pointed out previously, even using "web
safe" colours there will be variations from one computer to another. On
the other hand, using the safe versions minimises any differences, and
as the range of 216 safe colours is adequate for most purposes, it makes
sense to use them unless there is a good reason to opt for a system
colour instead.

It has to be pointed out here that the Macintosh version of Dreamweaver
has somewhat enhanced colour selection facilities compared to the
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Windows version. These can be useful if you are experienced at using
one of these alternative methods, but it is otherwise best to use the
more straightforward methods of colour selection.

Colour choice
There is a temptation to choose bright contrasting colours that make
your web pages as lively as possible. However, when choosing colour
schemes you first need to consider whether ultra -bright colours are
appropriate to the type of site you are designing. Colours that are suitable
for a site devoted to holidays in the Caribbean mig -it not be well suited
to a site covering more sombre matters such as bereavement or legal
advice. Whether bright or subdued colours are used, the main concern
should always be readability. Pairs of colours that are normally
considered good combinations do not always work well when used as
background and text colours. Readability is generally best if there is
good contrast between the text and the background, and I mean contrast
in the light and dark sense rather than in terms of colour contrast.

Try setting the background to a well saturated yellow colour and adding
some equally well saturated green lettering to the document. With small
lettering it will probably be difficult to read the words at all. With large
letters the text will be much more easily read, but it will not exactly leap
out from the page. If the text is altered to a slightly darker green it will
stand out much more clearly from the background, and the small text
should be perfectly readable. Change the background to a paler yellow
and things should improve still further. The page should also be less
hard on the viewer's eyes as well. If the text is now changed to a pale
green it will blend back into the page again.

There is no excuse for using colours that provide poor readability,
because Dreamweaver makes it easy to change colours, and it does
not take long to experiment with various colour combinations. Obviously
each page in a site can have its own colour scheme, and in some cases
this might be the best way of doing things. However, the generally
accepted wisdom is that a site works best if a fixed colour scheme is
used.

Proof of the pudding
Dreamweaver displays a WYSIWYG view of web pages in the main
document window, but as different browsers treat web pages in slightly
different ways you can not totally rely on the docurrent window to show
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Fig.3.11 The browser preview facility used with Internet Explcrer 5

you a true representation of how pages will look in a "real world" browser.
The only way to discover exactly how web pages will look "in the flesh"
is to load them into web browsers. As most Internet users have either
Netscape or Microsoft browsers, the best way to test your new web
pages is to use recent web browsers from both companies to view the
pages. Netscape and Microsoft browsers are available as free cownlcads
and are often to be found on the "free" cover mounted discs of computer
magazines.

In order to view a page using a browser, open the page in Dreamweaver,
go to the File menu, select Preview in Browse-, and then select the
appropriate browser from the list. If the browser program is not already
running it will be launched automatically and the web page will be loaded
into it. Figure 3.11 shows a simple web page being previewed using
Microsoft's Internet Explorer 5, and Figure 3.12 shows the equivalent
when using Netscape 6. Note that changes mace in Dreamweaver will
not be carried through tc the page in the browser. In order to view
changes first close the browser and then select the browser preview
option again.
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Fig.3.12 The browser preview facility used with Ne!scape 6

A browser normally has the ability to load files from disc as well as web
pages from the Internet, so it is possible to save a page to disc and then
load it into a browser. Bear in mind though, that operating systems do
not normally allow two programs to access the same file simultaneously.
Before using a browser to open a file created using Dreamweaver. make
sure the file is closed in Dreamweaver.

Adding a browser
When Dreamweaver is installed it will detect the default browser and this
should be included in the list of browsers when the preview facility is
selected. Other browsers may not be detected and included in the list,
and any browser installed after Dreamweaver was installed will not be
included. To add a browser to the list, first go to the File menu and then
select Preview in Browser and Edit Browser List. This will bring up the
Preferences window of Figure 3.13. Next operate tie + button to bring
up the Add Browser dialogue box (Figure 3.14), and then either type the
path to the browser program file and its name or us?, the Browse option.
Operating the Browse button produces the usual f le browser.
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Fig.3.13 The Preview in Browser section of the Preferences window

The Name field in the Add Browser window is used to identify the browser
in the list that appears when the preview facility is selected. Add a suitable
name here such as
Netscape or
Explorer. Tick the
appropriate check
box if you wish the

N,Finnuon Program FinnAPOIncapfsVnewly added
browser to be used Eger sunsr efirnery Browser

by Dreamweaver as
the primary browser.
Finally, left -click the
OK button and the Fig.3.14 Adding a browser to the list
browser will be
added to the list. To

remove a browser program f -o -n the list, left -click Dn its entry to highlight
it and then operate the - button.

If you are producing straigh:forward web pages it is unlikely that there
will be any discernible difference between the Dreamweaver WYSIWYG
display and what you see using a browser. Significant differences are
only likely to occur if a web page uses some up to the minute feature, or
possibly if the browser is an o d and out of date version.
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Fig.3.15 The print preview facility of Internet Explorer 5.5

Printing
Surprisingly perhaps, Dreamweaver does not have tile usual Print option
under the File menu, or anywhere else come to that. As the output of
the program is only intended to be viewed on a monitor this is not
necessarily an important omission, but it can sometimes be handy to
have hard copy of your web design work. There is no major difficulty in
printing out pages, and it is just a matter of loading them into a suitable
browser and printing them from there. Modern Microsoft and Netscape
browsers all have facilities to print documents, but for the best printing
features use the most recent version you can find. nternet Explorer 5.5
for example, has a good print preview facility (Figure 3.15).
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Input
A lot of background information of one type or another has been provided
in the previous chapters, but there are still some topics that need to be
covered. However, having digested the first three chapters you are in a
position to start making some web pages using the text manipulation
facilities of Dreamweaver.

There are two basic methods cf getting text into Dreamweaver, and the
more obvious one is to simply type it into the document window.
Dreamweaver incorporates many of the standard facilities for entering,
formatting, and checking text, including a word processor. Therefore, if
you are building a web site "from scratch", there is probably no poirt in
entering text other than direct into Dreamweaver's document window.

However, if preferred you can import text from a word processor, ext
editor, or practically any program that can produce text. One reason for
doing things this way is that you may prefer to work using a word
processor that you are familia- with rather than using Dreamweaver's
word processing features. Another possible reason is that you already
have text that has been prepared for other purposes, and you now wish
to use it in web pages. As will be explained in more detail later in 'his
chapter, any formatting of the text may or may not be carried into
Dreamweaver, depending or the method of imputation used.

Of course, plain text can be fcrmatted once it has been imported into
Dreamweaver, but there is no point in formatting tin a word processor
and then doing the job again in Dreamweaver. If the text is ready
formatted you should try to take that formatting forward ilk)
Dreamweaver. Provided you are using modern programs this should
not be difficult to achieve.
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Fig.4.1 Text size can be changed using the Properties Inspector

Text cursor
Entering text straight into Dreamweaver and formatting it is not very
difficult, and anyone having some experience of modern word processing
should be able to work out the basic processes by using a little trial and
error. The basics of word processing using Dreamweaver will be covered
here for the benefit of those who lack experience with word processors,
but it will only be covered fairly briefly. The document window should
be set to design view, so select Design from the View menu if it is currently
in the code view mode. If the text cursor is not already present, left
clicking on the document window will produce it. The text cursor is
blinking vertical line, and initially it will be towards the top left-hand corner
of the screen. The text cursor is separate from the mouse pointer, and
the pointer will still be present when the text curso- is on the screen.

Anything typed at the keyboard will now appear in the document window
in standard word processor fashion. Dreamweaver has a word-wrap
facility, so there is no need to add carriage returns at the end of each
line. These are added automatically by the program, which will not put
any line breaks within words. The text size, font (letter style), and colour
will all adhere to whatever default settings have been set.

Text size
There is more than one way to set text size in HTML, and using style
sheets it is possible to set a point size in standard word processor or
desktop publishing fashion. Without style sheets the relative method
has to be used, where the font size is relative to the base size. The basic
font size will vary somewhat from one browser to another, but is usually
around 10 to 14 points. If you select some text in ti -e document window
and then look at the available sizes in the Properties Inspector (Figure
4.1) you will find that there is a choice of two different ways of setting the
text size. There are absolute sizes from 1 to 7, and relative sizes from --
1 to +7. The absolute sizes are still relative in that the size actually
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Fig.4.2 A useful range of text sizes are available

obtained depends on the base size, which is whatever size is set for text
size 3. Make this larger or smaller, and the other sizes shift accordincly.

On the face of it there are more text sizes available using the relative
values, but as can be seen from Figure 4.2, some cf these values simply
duplicate other sizes, and the -e are still only seven sizes availaole. Tie
point size used as the base size for various types of text can be set by
going to the Edit menu, select ng Preferences, and then selecting Fonts/
Encoding as the category in :he Preferences window (Figure 4.3).
However, there is usually no point in doing so, and (say) boosting the
text size in Dreamweaver will rot result in the text being increased in
size when the page is viewec in a browser. It is up to users to set The
base text size of their browser to something sensible for the screen
resolution they are using. This prevents (say) minute text being produced
when a high screen resolution is in use.

Try making some text larger usirg this method and then use the browser
preview facility to view the page. The text will not be larger in the browsa's
version of the page, since the oase size used by the browse,' will not
have changed. You can get a better match by alter ng the text s ze in the
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Fig.4.3 The base font size can be changed using the Preferences
window, but there is normally no point in doing so

browser. With Internet Explorer for example, the text size can be altered
by selecting Text Size from the View menu. The default size plus two
larger and two smaller sizes are available. It is definitely not advisable to
design web pages that only display correctly if the browser is adjusted
to produced abnormally large or small text, because no one will bother
to make the adjustment. They will just exit the site and go elsewhere!

Fonts
Dreamweaver enables a wide range of fonts (lettering styles) to be used,
and it is easy to change selected text from the default font to another
style. Click on the arrowhead to the right of the current font description
in the Properties Inspector and a list of fonts will appear (Figure 4.4).
Simply left -click on the desired font and the selected text will change
accordingly. Note that you do not have to specify a font. Dreamweaver
uses the Default Font setting if no font is selected, and the font used will
then depend on the default setting of the browser used to display the
page. This will usually be something fairly conservative such as Times
Roman, but will obviously vary somewhat from ore browser to another
and one user to another.
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Fig.4.4 Fonts can be changed using this drop -down menu of the
Properties Inspector

There is a major problem when specifying a font, which is simply that a
font can only be displayed by a browser if that font is actually installed
on the computer concerned. The problem is made worse by having
different names for the same tont. Swiss and HeNetica for example, is
the same font under different guises, and these are not the only names
in use for this font. There is little point in using an exotic font if it is not
installed on most computers and the majority of browsers will forced to
revert to some sort of default tont.

HTML eases the problem of d fferent names for much the same font by
allowing lists of fonts to be used. Browsers then go through the
one by one, entry by entry, until an installed font of the same name is
detected. It is still possible that no suitable font will be found, and that
some browsers will have to use the default font. However, this method
does maximise the chances 01 a suitable font beinc found if there is one
installed on the computer. It is not a major disaster if the default font is
used, because the web page should still be perfectly readable and usab e.

You can edit existing font lists or make your own by going to the Text
menu and selecting Font and then Edit Font List. Selecting Edit Fcnt
List from the list of fonts in the Properties Inspector has the same effect,
and also brings up the window of Figure 4.5. In order to edit one of the
lists, left -click on its entry in the upper part of the window and the list of
fonts will then appear in the text box in the bottom left-hand corner of the
window.

The fonts installed on your computer appear in the text box to the right
of this one. To add one of the installed fonts to the list, first left -click on
its entry to highlight it and then operate the « button to add it to the
list. To remove a font from the list, left -click on its entry and then operate
the » button. To add the name of a font that is not installed on your
PC, type its name into the text box beneath the list of installed fonts and
then operate the « button.
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To make a new list, first left -click on the (Add fonts in list below) entry in
the font list. Then add and remove fonts from the new list in the usual
fashion. To add more than one list, left -click the + button to add extra
blank entries in the font list. Fonts are then added or removed from the
additional lists in the usual way. Operate the OK button when you have
finished, and the new list or lists will then be available via the Properties
Inspector and the Text menu.

Initially you will probably prefer to use the default font lists rather than
making your own, but it is worth experimenting a little and making your
own dummy list so that you get to understand the process of creating
and editing lists. You should then have no difficu ty in making the "real
thing" when the need arises. To remove a list, you can either delete all
its entries using the » button to remove them one at a time, or select
its entry and then operate the - button. To move a list up or down one
position in the font list, select it and then operate the up or down button.

Dreamweaver does not have a font preview facility, and you can only
view a new font within Dreamweaver by adding it to the available fonts
and then using it in the document window. When choosing new fonts it
is quicker and easier to view them in a program that does have some
form of font preview facility, such as Microsoft Word. Figure 4.6 shows
the font preview facility of Word 97, and this is obtained by selecting the
Font option from the Format menu. The required font, size, etc., are
selected using the controls in the upper part of the window, and the
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Fig.4.6 The font preview facilly of Word 97

corresponding font is previewed in the lower section of the window.
Similar facilities are to be found in many other programs.

Styles/effects
Various text effects, or styles as they are also known, can be applied to
text by first selecting it and then selecting the required effect using the
Properties Inspector or the Taxt menu. Severa of the available styles
are shown in Figure 4.7. The B and I buttons in tne Properties Inspector
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Fig.4.7 Various text styles and justifications

provide the usual bold and italic text. The three buttons next to these
provide left, centre, and right justification. The centre option is very
useful for headings. There is no full justification option incidentally. The
two buttons at the right-hand end of the lower row provide indenting
and what in Dreamweaver terminology is called "outdenting". The indent
button can be operated two or more times to provide deeper indenting.
The "outdent" button reverses an indent operation and places the text
back one tabulation position to the left.

Further effects are available from the Text menu under the Styles option.
These include underlining, strikethrough, and emphasis effects. Note
that it is possible to combine two or more effects, and you can have
something like a bold and underlined heading that is centre justified.
However, it is best not to get carried away and start adding effects just
because they are there. Effects should be used in a manner that will
enhance your web pages and not just for the sake of it.
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Fig.4.8 Many features of Dreamweaver are accessed via subment.s.
This one gives access to special characters

Getting physical
With HTML there are two style categories called physical and logical
styles. The physical variety are the familiar ones such as bold, italic,
and underline, which are used in most computer programs that can
handle text. If an effect of this type is selected, the text dIsplayed in
browsers will include that effect. The logical effects such as emphasis
and strong work in a slightly different fashion. In most browsers tiese
two effects will be displayed the same way as talic and bold text, but
they can also be interpreted in other ways in order to make something
clever happen. For example, the intonation of the voice could be altered
in a browser that provides text to speech conversion. In most cases you
will only require the physical effects, and it is best to stick to these

Special characters
Special characters such as copyright and trademark symbols are easily
added using Dreamweaver. To add a special character using the
document window's menu system, select Special Characters from the
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Insert menu, and then left -click on the required character to select it
from the list that appears (Figure 4.8). Alternatively, go to the Windows
menu and launch the Objects palette if it is not already on the screen.
Next, left -click on the arrowhead towards the top right-hand corner of
the palette and then select Characters from the pop -out menu. Finally,
select the required character by left clicking on its icon in the palette.
The character will be placed at the current position cf the text cursor, so
make sure that the cursor is in the correct place before issuing this
command.

Spelling check
Dreamweaver incorporates a spelling checker that operates in much
the same way as the equivalent facility in a word processor program.
What it actually does is compare each word in the document with the
words listed in its reference dictionary. If no match for a word in the
document can be found, the spelling checker points out the offending
word. Of course, the word in question might be perfectly all right, but
not in the reference dictionary for some reason. Names, technical terms,
new words, slang words or anything out of the ordinary is likely to be
pointed out by the spelling checker.

Some words of these types are included in the reference dictionary, but
it would be unrealistic to expect everything to be included. Once a
suspect word has been pointed out it is up to you tc decide whether or
not to correct the word or leave it unaltered. The spelling checker will
suggest some alternative words to use. All it is dcing here is to look
through its dictionary for words that are similar to the suspect word.
Provided the first one or two letters in the word are correct, this method
will often produce the correct word.

In order to start the spelling checker go to the Text menu of the main
document window and then select the Spelling Checker option. The
checker will start immediately and will point out the first error if it finds
one (Figure 4.9). The offending word will also be highlighted in the
main document window. In this example an extra "o" character has
found its way onto the end of the word "two". Using the scrollbar to
scroll down through the list of suggested alternatives unearthed the
correct word. To change the incorrect word to one of the suggested
alternatives simply left -click on the alternative and then operate the
Change button.

Using the Change All button has the same effect, but it will also result in
any further instances of the misspelled word being automatically
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Fig.4.9 The Dreamweaver spelling checker in action

corrected. If the right word is not listed, manually correct the text in the
Change To text box and then operate the Change or Change All button.
If the word is actually all right, operate the Ignore button to lease it
unchanged and continue checking the document. Using the Ignore All
button instead has the same effect, but any other instances cf the word
will also be ignored.

If a correct word is pointed opt by the checker it is possible to add it to
the reference dictionary so tnat it will not be pointed out again if it cops
up in future documents. Just operate the Add to Personal buttcn in
order to add the word to the dictionary. Note though, that only the word
in your text will be added to the
dictionary. Where appropriate,
plurals and other possible

0141,1,1WINIVIN toftshad rfpriktrg no 
Do you -tero Lunen. tAud. ng the re! ol ft.e Jou,.

variations on the word must be I
added separately. Once the
spelling checker has completed Fig.4.10 The rest of the document
its task it will provide an onscreen
message to that effect. Operate
the OK button to exit the checker and return to the document. Operate
the Close button at any time to exit the spelling checker immediately
and return to the document.

Incidentally, the spelling checker can be used to check a single word or
a section of text by selecting the word or text and then starting the spelling
checker. Once the words or words in question have been checked,

can be checked if desired
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Dreamweaver will ask if you wish to check the rest of the document
(Figure 4.10). Operate the No button to exit to the document window or
Yes to check the rest of the document.

Find
This is another standard word processing feature that is incorporated in
the Dreamweaver document editor. The Find facility simply finds a
specified text string, and once found the string can optionally be replaced
with another text string. This is useful if you realise that (say) a name
has been repeatedly misspelled. For example, if you find that you have
repeatedly used "Windows ME" instead of "Windows Me", the Find and
Replace facility makes it easy to replace all the instances of "ME" with
"Me"

On its own, the Find facility provides an easy way to jump to a particular
point in a long document if you know a certain word appears at or near
that point. For example, you might wish to go to the part of a document
that mentions free beer, and by using "free beer" as the search string
the Find facility should home straight in on the appropriate part of the
document. Clearly the Find facility will work best using search words
that are unusual, and there is little point in using common words that
crop up throughout a document.

To search the current document for a string of characters, load the
document into the document window if you have not already done so.
Then select Find and Replace from the Edit menu, which will bring up a
window like the one in Figure 4.11. The text you wish to search for is
typed into the larger Search For text box. The smaller text box enables
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Fig.4.12 The search string has been found and is shown highlighted in
the document window

you to search for something other than simple text, but we will settle for
the default text option. If you 'Nish to find some text but do not wish the
automatically change it, do not put anything in the Replace With text
box. Having entered a suitable search string, operate the Find 'lext
button to find the first occurrence of the text in the document. Assuming
that a suitable text string is p-esent in the document, it will be t-ighlignted
in the document window, but the Find and Replace window will still be
present on the screen (Figure 4.12).

You can edit the document and return to the Find and Replace window
when you have finished. Operate the Find Next button to find the next
occurrence of the string in the document, or operate the Close button if
you have finished. An alternative way of exiting this facility s to close
the Find and Replace window once the first occu-rence of the string has
been found. To find further occurrences select the Find Next option
from the Edit menu. Note t -at any occurrences of the specified Bring
will be found, even if the string is found within a word. For example,
using "put" as the search string would find "put" in the word "putty".
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The search facility of Dreamweaver is quite comprehensive, and there
are several variations available on the basic search 'unction. Operating
the Find All button instead of the Find button causes the lower part of
the Find and Replace window to expand, and a list of the occurrences
of the text string is provided. Also, a small window Do ps up and shows
the number of occurrences that were found (Figure 4.13). Left -click on
the OK button to remove this window.

The list shows where the text string was found, which will be the current
document in every case if that is all that was searched. However, there
are other options available in the Find In menu towards the top of the
Find and Replace window (Figure 4.14). A folder on a disc can be
searched, as can an entire site or selected files in a site. Double clicking
on an entry in the list of occurrences will open the source of that entry, if
it is not already open.

Normally the search is not case sensitive. If you specify (say) "help" as
the search string, the Find function will also locate strings such as "Help"
and "HELP". Tick the Match Case checkbox to make the search case
sensitive. A match will then occur only if the search sting exactly matches
every character in a text string in the document.
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Fig.4.14 Various sources can be used for Find and Replace operations

Replace
The Replace function is used much like the Find facility, but some text
must be placed in the Replace With text box. For Example, to replace
"Dreamweaver" with "Dreamweaver 4", "Dreamweaver" would be typed
into the Search For text box, anc "Dreamweaver 4" would be ertered in
the Replace With text box. Operating the Replace button would then
result in the first instance of 'Dreamweaver" being replaced wish
"Dreamweaver 4". To replace all instances of "Dreamweaver" with
"Dreamweaver 4", operate the Replace All button. A window will then
pop up and it will indicate the number of items that were found and
replaced. The bottom section of the Find and Replace window will also
be expanded to list the individual items that have been replaced (Figu-e
4.15). Left -click on the OK button to return to the Find and Replace
window.

Note that a certain amount of care has to be exercised when using the
Replace function. If no text is used in the Replace With text box, the
matched text strings will be replaced with nothing. This could be useful
if you genuinely wish to erase text strings rather than replace them with
something. It can cause a lot of accidental damage if you simply forget
to add some text into the Rep'ace with text box. FDrtunately, the Undo
option of the Edit menu will reve-se a search and replace operation that
goes wrong. The Find and Replace function is available in both the
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Fig.4. 15 The number of items replaced is given in a message box, and
the Find and Replace window expands to list the items that
have been changed

Find and Replace

Find Nert

Reference
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Shitt.F1

Fig.4.16 This pop-up menu
gives acess to the Find
and Replace facility

Code and Document views
incidentally. In the Code view it
can be used via the normal route,
or right clicking anywhere in the
actual code part of the window
(but not on the title bar, menu bar.
etc.) will bring up a small menu
that gives access to this function
(Figure 4.16).

It is worthwhile putting some text
into the document window and
then experimenting a little with the
find and replace functions. The
basics of these functions are
easily mastered with a little
experimentation.
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Importing
As already pointed out, the facilities of Dreamweaver are such That it is
not essential to import text from other programs. In fact there is not
normally any point in doing so when producing simple web sites that co
not have large amounts of text. However, if the need should arise, it is
not usually too difficult to import text into Dreamweaver. The obvious
route is to use the standard Cut and Paste facilities. Normally this methcd
preserves any formatting of the original text, including fonts, text sizes
and colours, left and right justification, etc.

Unfortunately, text imported into Dreamweaver using the Paste iuncticn
does not retain any formatting information, and it is converted irto pla n
text. This might seem to be rater weak compared to most programs,
but bear in mind that Dreamweaver operates in HTML, and it wou d
have to convert the pasted text into HTML code in order to retain the
formatting. It is unrealistic to expect this sort of Thing from a simp.e
paste facility. Figure 4.17 shows some formatted text in the Windows
Me Wordpad program. Figure 4.18 shows the same text when pasted
into Dreamweaver, and a number of changes are apparent. n

Dreamweaver the text is all in the default font at the basic text sie, ard
it is all left justified.

Most programs that can handle text can save files as simple ASCII files,
which have a "txt" extension. These can be loaded into Dreamweaver
using the Open command, but this method also results in the loss of
formatting information. In this case the formatting disappears because
it is not included in the file, and not because of any shortcoming
Dreamweaver. Of course, havino loaded the text into Dreamweaver, any
formatting that has been lost can be reapplied using the program's
formatting commands.

Where possible it makes sense to retain any formatting of the original
text, and there is usually a way around the problem if you use an up-
market word processor that has good export facilities. Such is the
importance of the Internet that many word processors now have the
ability to save documents in HTML format. These files can then be opened
in Dreamweaver in the usual way. and the formatting should be retained.
Being realistic about matters, it is likely that there will be some changes
in the formatting, but these will mostly be relatively minor. A small amou-it
of editing should be sufficient to take care of any problems that do occur.
Figure 4.19 shows the same text as Figures 4.17 and 4.18, but this time
it has been exported from a word processor as ai HTML file and the
opened in Dreamweaver. This t me the text is about the right size ard
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This is a large heading

This is some normal 12 point text in Arial font, which is a fairly plain but very
readable type face. The heading above is centre justified This paragraph is left
justified

This is some normal 12 point text in Arial font, which is a fairly plain but very
readable type face. This paragraph is right justified.

rot Hee" r -

Fig.4.17 This is a small sample of text that has been formatted in the
Windows Wordpad text processor

, Untitled Document (Untitled -11- Dreamweever
Fo, in, ert Moor. -Levi CommendS Site

411.1I{I: Tee: ,,Inteled Document (V.

This is a large heading

This is some normal 12 point text in Arial font, which is a fairly plain but very readable
type face. The heading above is centre justified. This paragraph is left justified

This is some normal 12 point text in Arial font, which is a fai-ly plain but very readable
type face. This paragaph is right justified.

.entfv) isi I see dia, 4) 0 Ly 0 /

Fig.4.18 All formatting of the text is lost when it is imported into
Dreamweaver
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,ie ode View ,niert Maddy TeX, Commends $its Window Help

' Title T". - . 45t. J. <? 471

This is a large heading

JJxJ

This is some normal 12 point text in Anal font, which is a fairly plain but very
readable type face The heading above is centre justified. This paragraph is left
justified.

This is some normal 12 point text in Arial font. which is a fairly plain but very
readable type face. This paragraph is right justified.

1

DOI:0> ,{ao rp> 7', 192. rr el j] D <>

Fig.4.19 Importing this text into Dreamweaver as an HTML file has
largely retained the original formatting

has the correct justifications. The grey background colour is the one
that was used in Word, and it has been correctly carried through to
Dreamweaver. The only slight problem is that tie font used for tie
heading has changed, but this is easily corrected in Dreamweaver.

Word cleanup
If you produce text on a word processor and then load it into
Dreamweaver it is quite likely that the word processor in question will De
Microsoft Word. This has the ability to save documents in HTML format,
so transferring your documents into Dreamweaver, complete w th
formatting, should be perfectly straightforward. Unfortunately, in practise
the HTML documents produced using Word might be a bit app-oximate
when transferred to another program. There will not be problems in
every case, but they can and do occur. Fortunately, Dreamweaver has a
facility to clean up HTML code produced using Wcrd, and this could De
very useful if you have problems using documents originated in Word.

To use the Word cleanup feature start by loading the HTML file ir to
Dreamweaver in the usual way. The go to the Commands menu aid
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Dreernweevng select the Cleanup

dooms,* You may rntInlie,,, seed von Irc -n ke thoptiam mom 1,orn,e.
Deuvrownwer awns.w 0.0.,0  Ow Word osit, genre* 11, Word HTML option.

,ec mec,.1- rs ',sieved Me rnpor At, may ',V.:, - If the document you
loaded was not
originated in Word,

Fig.4.20 This error message appears if the or was produced
Word version can not be determined using an old version,

the error message of
Figure 4.20 will appear. You may continue by manually selecting the
version of Word, but it is probably not worthwhile continuing unless the
document was produced in a suitable version of Word. There is a
command for cleaning up HTML from any source, and it would be
sensible to try this instead.

Assuming that Dreamweaver detects the version of Word in use, the
window of Figure 4.21 or something very similar will appear. The windows
for Word 97/98 and Word 2000 are slightly different. In both cases there
are checkboxes that are used to select the types of correction that will
be made. Operating the Detailed tab brings up further options, and
these are again different for Word 97/98 and Word 2000. Figure 4.22

Clean Up HTML from TA/Ord97M j

Remove all Word specific markup
 Clean up CSS
 Clean up <font, tags
 Fix invalidly nested tags

 Set background color IttFFFFFF

 Apply source formatting

ri7 Show log on completion

OK

Cancel

Help

Fig.4.21 This dialogue box enables the user to select the types of
correction that will be implemented
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Clean Up Word HTML

Basic I Detailed

Clean Up HTML from 'Word 97t%

l Remove Word specific markup

[ Word meta and link tags from <head)

Clean up <font' tags

.17 Convert size 7 to

l Convert size 6 to

r; Convert size 5 lo

P. Convert size 4 to

1.7 Convert size 3 to

 Convert size 2 to

f Convert size 1 to

hl

h2

h3

h4

size 2

size

OK

Help

Cancel

Fig.4.22 Further options are avalable from this dialogue box

shows the Word 97/98 versior. . If you know the scurce of the problem
or problems you can be selective, or you can simply let Dreamweaver
sort out any errors that it thinks it finds. Even if you let Dreamweaver "do
its own thing", you might pre'er to deselect the option to change the
background colour. Whatever background colour was in use when the
document was saved will be used as the backgrouni colour of the HTML
version. If you deliberately set the required colour before saving the
document, you will not require Dreamweaver to change the colour. It is
set to white by default, but you can set the hexadecimal code for another
colour.

Once everything has been set as
required, operate the OK button
A message like the one in Figi. re
4.23 will then give details of t-ie
changes that have been made
Operate the OK button to retur
to the document, which shoulc
reflect the changes made py
Dreamweaver.

Dreamweever

Clean Up Word HTML Fee ults
1 Meta Tags Removed
Bed(ground Color Set to 4.---FFFFF
Source Formatting Apphec

Of

Fig.4.23 A summary of the
corrections is provided
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Paragraphs
and lists

Paragraphs
When dealing with HTML paragraphs you have to forget the basic rules
of grammar. In HTML a paragraph is whatever text appears betweer the
paragraph tags, and this could be as little as a single character.
Paragraphs are easy to understand if you are used to a desktop
publishing program such as Adobe PageMaker. Programs such as this
use a similar system whereby anything between two carriage 'eturn:3, or
the top and bottom of the document and a carriace return, is considered
to be a paragraph.

A number of predefined paragraph styles are available, with each one
having its own font and sze settings, and effects (bold, italic, etc.). In

fact there is also very precise control over things like line and character
spacing, justification, and so on. To set a paragraph to the required
style it is just a matter of placing the text cursor somewhere in the
paragraph and then left clicking on the appropriate entry in the paragraph
palette.

Dreamweaver handles things in a similar fashion when formatting text in
the main document window, but in a greatly simp ified fashion. If you go
to the Text menu of the docu-nent window and select Paragraph Format,
a menu of available paragraph types is produced (Figure 5.1). The
same options are available from the Format menu of the Properties
Inspector incidentally.

Most of the paragraph formats are heading styles, and as one would
expect for headings, the tex-. sizes are mostly qu to large and the text is
in a bold font. There are six heading sizes, with 1 as the largest and 3 as
the smallest (Figure 5.2). Size 5 is actually about the size of normal -.ext,
and size 6 is somewhat smaller, and it is the four largest sizes that are of
most use for headings and subheadings.
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site Window

CirlAlt.)
CtrI4Alt«[

Help

0-

ed-li - Dreamweaver
.clity Text commands

Indent

Outdent

w None Cir1+0Paragraph Format

Align Paragraph Ctrl.Shitt.ID

List Heading 1 Ctr1.1

Heading Z' CtrI2
Font

style

HIML Styles

Headings
Heading 4

Heading 5

Ctr1+4

CtrI.5
GSS Styles

Heading 6 C1r1.6
Size

Prelormatted Tel
Size Change

Color

Check Spelling Shitt+F7

Fig.5.1 Several paragraph formats are available from the Text menu

Untitled Document (Untitled -11 - Drea _ 1 DLL( J
File edit View Insert Modify Iext commands Site Window Help

. .

16) .14 I Title: ntitled Document <'>

Heading 1
Heading 2

Heading 3

Heading 4

Heading 5

Heading 6

body, h4;

Fig.5.2 The six heading paragraph styles

539 ,( 323. 110 I sec 5y'j & j
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This text ts in the Pa agraph style paragraph. raid is meant lot normal tea. In other words. d is equivalent to Body Tess in
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words. it is colon dent to Body Text in normal deslsot publishing teneranology This rest to to die Par agraph stile paragraph.
aid to mean tor normal text In other words. it is egas alem to Body Text m moral desktop publishing tenntanology This text
in in the Paragraph style paragraph. and is mart try normal tow In other words. d is equivalent to Body 'text in normal
desktop Pulsitshtha lumtthtthloP This ts in the P.,404th ace p.notrepli..ind w mead for normal text to other word a

is equivalent to Both Text in normal desktop 1141i/slur e ternannolmw This toot is in die Paragraph st)le paragraph. and is
meant for normal text. In other VVIN do, II Is organnthm Cl Body Feet in normal desktop publithing tertnnmolog. This few is in
the Paragraph style paragraph. and tot not std tent In other words. 1tie ems alum to Roily "rest in nor.] desktop
publishing lertmoulo0 This text is in the Parass mph :isle parag-thh, and re meant to tom.' few other scowls, a is
equivalent to 11(Nt). Tea in normal desktop publish,na -errnmolog

Subheading

This ?CT! IN in the Paragraph style perm NM, and is noun lot mammal text In other uteri,. it is equivalent to Body text in
annul desktop publishing temninulnKn This text s II. the heap ash style paragraph. aoul is wait for normal not 11111AIICI

words. it it equivalent to Body Text in normal desktop publishing terneanology This let ism die Paragraph tale paragra.k.
and Is meant for normal text In other scotch. a is e pas alent to Body Few in normal desktop r11111,114ing temintriology rht. lest
to In the Paragraph style paragraph. aid is meted I, ornaull ten In other words. it is equivalent to Body Text to normal
desktop publishing tenatimoloth Thu text is in the P anwy :mph style paragraphx and is mesa to normal text In ether words. a
is equivalent to Body Text in normal desktop pub lishirg termninolov 'then few in in the Paragraph style paragraph. and is.

Man tof 'tonna) lent kt otter out its it is slain ids ra to Body Text in normal de,ktop 1,41,11+htrig, teniannolog This text i  in
die Paragraph style paragraph. and is meant tot norms, text to other words. a w emus Ana to Both, Text in normal desktop
publishing terminology This text ism die Parks:rev', style paragraph nut is meant tor nurnial test In other words, a is
equivalent to Bialy Tea in mama) desktop publishing intrannolm,

0104.

Fig.5.3 This page uses three paragraph styles

al thC ;r. 0

The Paragraph paragraph style is intended for normal text, and it is the
equivalent of body text in des<top publishing terminology. Figure 5.3
shows a page containing foLr Darag rap hs, one o' which is a heading in
the Heading 1 format. Twc oi the other paragraphs are in the paragraph
format and the remaining one is a subheading in Heading 2 format. The
paragraph styles provide an easy way of applying some basic formating
to text, but you have to resort to the Properties Inspector and (or) the
menu system in order to do more sophisticated formatting.

Try typing some headings a -id a couple of blocks of tex-. into the
document window, and then experiment with the paragraph styles. To
set a paragraph to Heading 1 style for example left -click somewhere
within the paragraph so that the text cursor (the flashing vertical line and
not the mouse pointer) is positioned within the paragraph. Then seect
Paragraph Format and Head ng 1 from the text menu. Note that usir g a
paragraph style does not p -event further formatting using Properties
Inspector or the menu system, or by editing the HTML code come to
that.
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and is meant for normal ter In other words it n equivalent to hod!. I ea to nomad desktop pithlwhing ternannology line text
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desktop publishing ientannolog This text i in the Pristraph sts le paragraph. rid is meant to nomad text In other words, it
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morn tom normal tea In other word,. it is equivalent to Body Ter in normal 2k skinp publithing terminnolocy lhis text is in
the Psauaph style paragraph. and is meant for nornial text In other worts. nt is equi, &lent 20 Bori Text in nonnal desktop
publisiung terntrunoloKv. This text is in the Pargraph style paragraph. and is meant tor normal text In other writ -eke. it Is
eq., gent to Roth Text in normal desktop imblishing teritioiolos*
Subheading
This text is in die Pasta Nth style paragraph, and is meant for nomial test In other words, it Is equivaletn to Rod) Text in
normal deslqop pablishing termninolmq This test is in the Paragraph style paragraph. and I. meant for normal test In other
words, it is Cl1111, alt.. to Rods Test in 111,111/11 fiViktOp publwhing !et -n.2222122* This text 2, in die Paragraph style paragraph,
and Is meant for nominal text In other words. ii is equivalent to Bodx Text in normal desktop publishing ternmmology This text
is on the Paragraph style paragraph. and is meant for normal ten In other %Nord, it is equivalent to Bosh Text in normal
desktop puhh Jung terinninolisg/ liu- test is in the Pgagrapb style paragraph. aid in merit for mortal text In other cards.
ty equis alga to Rods Text us normal de-Ltop publisluir tertuninolog Tin. test t in the Prat -42h Axle parr's-twit, aid is
near for normal test In other words. it is equi, gent to Boils Ter in normal desktop publu hing tenuninoloc Th.s text is in
the Pararaph style paragraph and is meant for normal text In other words. it is tquwaler .o Rosh ltxt in normal desktop
publishing tertimmolo* This iesi is in the No 420.4211 its le mama aph. and is merit tor normal text In other words, n is
equw gent to Bah Teri in normal desktop publ plug/ tenrminolog
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Fig.5.4 This version of the page uses line breaks instead of
carriage returns

Line breaks
You will probably have noticed that adding a carriage return does not
take the text cursor to the beginning of the next line, but moves it two
lines further down the screen. A blank line is inserted between one
paragraph and the next, but this is a sort of "no go" area for the text
cursor, which can not be positioned within this part of the document.
This is the standard HTML way of handling things, but you might not
always wish to have this blank line between blocks of text. The blank
line can be avoided by using a line break rather than a carriage return.
To insert a line break, or soft return, as it is also kr own, hold down the
Shift key and then press Enter. Incidentally, a soft return is the character
that is automatically inserted at the end of a line when the word wrap
facility wraps text around onto the next line.

Figure 5.4 shows the same page of text that was used in Figure 5.3, but
with line breaks rather than carriage returns. The lack of blank lines
between paragraphs is readily apparent, as is the fact that the same
paragraph style is used for all four paragraphs. The problem here is
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Fig.5.5 Variations in text size, etc., can be accommodated within
a paragraph

that the lack of carriage returns means that the text becomes one IDng
paragraph, and as such it has just the one paragraph style. However,
you can use the Properties Inspector or the Text menu to put the headings
in bold print and a larger text size, as in Figure 5.5, and the closet up
style will be retained.

Remember that a number of special characters are available from the
Characters page of the Objects palette, which is useful if you forget the
keyboard codes. The line oreak icon is the ore in the top left-hand
corner (Figure 5.6). Just position the text cursor where you require the
line break and then left -click on the line break icon. Alternatively, Crag
the icon to the position in the d Dcument where the line break is requi-ed.

Spaced out
When typing text into the document window you may have noticed :hat
hitting the spacebar once has the usual effect, but two or more operations
do not insert any more spaces. You can press the spacebar all day, but
only one space character will be produced. The Tab key does not ope-ate
in the usual fashion either. Operating the Tab key once produces a
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single space character, and
further operations have no further
effect. In other words, it has the
same effect as the spacebar.

There is a way around this in the
form of the non -breaking space
character. This can be added
using the Characters page of the
Objects palette, and its icon is at
the top right-hand corner (Figure
5.6). The simple list of Figure 5.7
was produced with the aid of line
breaks arid non -breaking
spaces. Dc not forget that the
indent facility available from the
Properties Inspector or the Text
menu can be used to shift
paragraphs to the right. as in the
version of the list shown in Figure

Fig.5.6 Selecting the line break

Untitled Document (Untitled -2n - Dreamweevii.
r de Edit

vi_J. 
view Insert Modify lest

TAW: Untitled Document

Lommonds ode Window dere

tfe. kit4 t7> C.

Quantity Description
200 M3 25mm steel bolt
100 M3 full nut
100 M3 half nut
100 M5 50mm steel bolt
200 M5 full nut
50 M6 100mm brass bolt
50 M6 full nut
50 M6 steel washer

opt Lc.
Characr...4

L.I

2_1

LJ

Le oul~

_125j

<body> <p> dont 621 x CI . 2K 1 I sec $12, Q ct) it) Le 49

Fig.5.7 A simple list produced with the aid of line breaks
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Untitled Document (Untitled -21- Oreemweetver

Ede Edit View Insen Modify Ten 4ommends Site J:*

11.,* I Title Untitled Document trt. c4r)ir

p> <font

Quantity Description

200 M3 25mm steel bolt
100 M3 full nut
100 M3 half nut
100 M5 50mm steel bolt
200 M5 full nut
50 M6 100mm brass bolt
50 M6 full nut
50 M6 steel washer

621TO . 21( 1 1 sec v311 J D

Fig.5.8 In this version the list has been moved to he right using the
indent facility of the Properties Inspector

Preformatted
There is a Preformatted option in the list of paragraph styles, and this is
intended to retain the formatting of simple text that is pasted into the
document window, or loaded as a text ("txt") file. The type of formatting
in question here is just the pDsitioning of characters, and not anyth.ng
remotely clever such as fonts, text sizes, colours, etc. Spacing in'ormation
tends to be lost when simple text is loaded into Dreamweaver, because
tabs and several spaces in succession are reduced to single spaces.
The table of values shown in Figure 5.9 was loaded into Dreamweaver
without selecting the Preformatted option first, and the columns of :he
original text have been lost completely.

Figure 5.10 shows the same table of values, but this time loaded a'ter
selecting the Preformatted option. Unfortunately, although it is close- to
the original than the version cf Figure 5.9, it is still not perfect. The
columns are not aligned prope-ly, and this is a common problem when
transferring simple text files from one program to another. The problem
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Untitled Document (Untitled - Dreemweaver
File edit View Insert Modify Ted Commends fiiie Window help

-L1 xJ

9321 Title Untitled tt It c ta,

RI 1 off 27k 5% 0.25W
R2,4,7 3 off 10k 5D/o 0.25W
R3,5 2 off 100k 1% 0.5W
R6 1 off lk 5')/0 0.25W
R7,8,9 3 off 47k 5% 0.25W
R10 1 off 2M2 5% 0.25 WI
R11,15 2 off 4k7 5% 0.5W
R12,13,14 3 off 220k 5% 0.25W
R16 1 off 380R 5%0.25W
R17 1 off 22k 5% 0.25W
R18,19,20 3 off 68k 1% 0.5W

621.0. IK ) I sec. si V j .4>

Fig.5.9 The formatting of this list has been lost completely

Untitled Document (Untitled -31- Drecunweetver

File Edit \Ile,. Insert modify Ten

' Title untitled Document

Qommands site yjrr,doe. Help

Lt. 14 e.9.>

R1 1 off 27k 5% 0.25W
R2,4,7 3 off 10k 5% 0.25W
P.3,5 2 off 100k 1% 0.5W
R6 1 off 1k 5% 0.25W
R7,8,9 3 off 47k 5% 0.25W
R10 1 off 2M2 5% 0.25W
P.11,15 2 off 4k7 5% 0.5W
R12,13,14 3 off 220k 5% 0.25W
R16 1 off 380R 5% 0.25W
R17 1 off 22k 5% 0.25W
8.18,19,20 3 off 68k 1% 0.5W

bodu><pre> 621.0. IktIsec J

Fig.5.10 Pre formatting has retained some of the fcrmatting
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0.25W
0.25W
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0.25W
0.25W
0.25W
0.5W
0.25W
0.25W
0.25W
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JA
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JJ
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Fig.5.11 Some non -breaking spaces have been added to fix the
formatting of the list

usually stems from discrepaicies in the amount of space used to
represent the tab character. Ii order to maximise the chances of success
it is better to use multiple space characters rather than tabs. This takes
longer, but should ensure that the basic formattir g remains intact if the
text is exported to another p-ogram. Where things do go wrcng, some
added non -breaking spaces siould soon sort th ngs out again (Fic ure
5.11).

Preformatted text is in a simple monospaced font, like the text produ2ed
by simple text editors. If the text is pasted into Dreamweaver there should
be no difficulty in changing :he font, text size, etc., but doing so m.ght
alter the basic formatting of the text. In order to retain accurate formatting
the text should all be the same size and in a monospaced font.

Lists
Dreamweaver has some useful facilities for prodLcing lists. The easiest
way to understand these is to make a simple list and then try formatting
it in various ways. Make a list of something like the months in the year
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Untitled Document (Lesson tles/UnntJed-3 Dreamweewer
_ 2

File Edo yew Insert Modify Iext Ccorninands Sae MOM -OM

j) Tao: intrtled Document ?, te, b (7, I I, CB.

Sunday

Monday

Tuesday

Wednesday

Thursday

Friday

Saturday

621 O. 1101sec 1 .L1;, 4)

Fig.5.12 The raw list ready for processing by Dreamweaver

Untitled Document (Lesson Files/List

Ede Edit ytew Insert Modify Iext

Title: Untitled DocumentJ
1. Sunday
2. Monday
3. Tuesday
4. Wednesday
5. Thursday
6. Friday
7. Saturday
8.

Fig.5.13 The ordered list

or the days of the week (Figure
5.12). Dreamweaver supports
two normal types of list called
ordered or numbered lists, and
bulleted or unordered lists. We
will start with the ordered variety.
To convert the basic list to an
ordered list, first select all the text
in the list. -hen select List and
Ordered List from the Text menu.
Alternatively, if the Properties
Inspector is active operate the
Ordered Lis-. button. This is the
button bereath the italic "I"
button. This should produce
something like Figure 5.13,
where things have not entirely
gone to plan.
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Untitled Document (Lesson Files!Listl.

Elle Edit View Insert Modify Teo cc

Title Untitled pc cur,. 

1. Sunday
2. Monday
3. Tuesday
4. Tuesday evening
5. Wednesday
6. Thursday
7. Thursday night'
8. Friday
9. Saturday

The seven entries have been
numbered properly, but an empty
eighth entry has been adced.
This is due to a carriage return at
the end of the list being selec:ed,
and Drearnweaver has correctly
numbered this additional I ne.
The unwanted "8." can be
deleted manually. just like any
other text. To a large extent it is
possible to edit the list like normal
text, but note that any lines that
are added will produce automatic
renumbering of the list. This can
be clearly seen in the version of
Figure 5.14, which has had the
spurious '8." removed and two
more lines added. The list has
been autcmatically acjustec so

Fig.5.14 The edited list that the entries are now
numbered from 1 to 9.

Try adding items to your list. Place the text curscr at the end of the line
immediately before the position where the new line is required. Press
the Return key to add the new line and move the cursor onto that line.
The list will be renumbered and a number will be added for the new
line. Finally, type in the text fo- the new entry. To remove an item f-om
the list, first select the text for the item and press the Delete key to erase
the text. Then press the Backspace key to delete the number for that
entry. The number and its full stop can not be se ected like normal 'ext,
but it can be deleted using the Backspace key. The list will then close
up to remove the blank line and the entries will be automatically
renumbered.

Unordered list
An unordered list is produced in much the same way as al ordered
type, with the text for the list 'first being selected. However, List and then
Unordered List are selected from the Text menu, or the Unordered Text
button is operated on the Roperties Inspectcr. This is the button
immediately on the left of tie Ordered Text button. Try this on your
ordered list, and it will charge to a bulleted list like the one in Figure
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Untitled Document (Lesson Files/Lis

File Lao yuew Insert Muddy Ie0

Title Untitled Eic:ument

. Sunday

. Monday

. Tuesday

. Wednesday

. Thursday

. Friday

. Saturdasi

Fig.5.15 The bulleted list

I

Untitled Document (Lesson Files/Usti h

File Edit Yiew !risen Modify Iext Com

Title. Untitled Document

. Sunday

. Monday

. Tuesday

. Wednesday

. Thursday

. Friday

. Saturday

Fig.5.16 The line spacing can
be increased

5.15. This demonstrates the
point that a list can be ordered
or bulleted, but it can not have
bullets and numbers.

To change a list back to normal
text, first select the text in the list
and then operate the appropriate
List button of the Properties
Inspector. Alternatively, select the
text, go to the Text menu and
select List and then the
appropriate type of list from the
submenu. A third alternative is
to select the text, go to the Text
menu, select List, and then None
from the submenu.

If you accidentally end up with
text in a list that should not be
included, the same basic method
can be used to remove that text
from the list. Note that a list can
be ended with two carriage
returns. This avoids the situation
whereby everything you add after
a list is merged into the list by
Dreamweaver. By default one
soft return is used at the end of
each line in a list. To add a blank
line between each entry in a list,
first format it as a list of the
required type and then add two
soft returns at the end of each line
(Figure 5.16).

Definition list
A third form of list is available in
Dreamweaver, and this is the
definition list. This operates
using pairs of lines, with the first
line of each pair containing a term
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,t Untitled Document (Untitled -7') - Dreanniesivor

Es. Edit Mew Ono Modify Bed Commends live window

AjijILL ..7). I Tido: Unilled Document tkr. O. j C (?) 1 G.

Song Thrush

Medium brown, speckled, sings a lot from mid -winter onwards

Black Bird

Black (male) or brown (female), sings in mid -summer

Robin

Red front with brown and green, sings all the time

Redwing

Song thrush with red wings (migratory)

Nightingale

Brown (like a dumpy sparrow), sings in summer

Mistle Thrush

Like a large song thrush with a sore du 9at

4 I

dma <o)
Ltr.

7013.0. IV/lac st

Fig.5.17 The definition list prior to formatting

, I lnhlied Document plotidod-r)- rifroamPooffoir

Ede Edit y.aw m;,11 "

J

'Lk! I Title ummed Document Li.

Song Thrush
Medium brown, speckled, sings a lot from mid -winter onwards

Black Bird
Black (male) or brown (female), sings in mid -summer

Robin
Red front with brown and green, sings all the time

Redwing
Song thrush with red wings (migratory)

Nightingale
Brown (like a dumpy sparrow), sings in summer

Mistle Thrush
Like a large song thrush with a sore throat

Fig.5.18 The formatted definition list
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into11,1 I ,m 111,11.n1 P) Drenmsreaver
File Edit View Insert Mode/ IPA Commends 55tv Winder*, 111,1P

tit I.. I <r> Q.

Song Thrush

Medium brown, speckled
sings a lot from mid -winter onwards

Black Bird

Black (male) or brown (female)
sings in mid -summer

Robin

Red front with brown and green
sings all the time

Redwing

Song thrush with red wings
migratory

Nightingale

Brown (like a dumpy sparrow)
sings in summer

Mistle 'Thrush

Like a large song thrush with a sore throat

*mho <P> 708 z 0. 'Kt I s.c ;.

Fig.5.19 Entries can occupy more than one line

and the second containing a definition for the term. The term can actually
be anything that you need to define, such as a name. To try out a
definition list, type some pairs of lines containing terms and definitions
into the document window, as in Figure 5.17. To turn the completed text
into a definition list it must first be selected. Then select List from the
Text menu, and Definition from the submenu that appears. The list should
then be formatted like the one in Figure 5.18, with odd numbered lines
left unaltered and the even numbered lines indented. There is no button
for definition lists on the Properties Inspector incidentally.

Both terms and definitions can occupy more than one line if they are
word wrapped onto additional lines, or you split them across two or
more lines using soft carriage returns. For example, the original text of
Figure 5.19 is formatted as in Figure 5.20 when it is turned into a definition
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Untitled Document (Untodod-r)- Diesameaver

Ede La lite* Insert Modify Iexi c.'oinnicinds 5de Window 1:1Ip

Untttled Document tt; 13.

Song Thrush
Medium brown, speckled
sings a lot from mid -winter onwards

Black Bird
Black (male) or brown (female)
sings in mid -summer

Robin
Red front with brown and green
sings all the lime

Redwing
Song thrush with red wings
migratory

Nightingale
Brown (like a dumpy sparrow)
sings in summer

Mistle Thrush
Like a large song thrush with a sore throat

doom> <chalet, D. 1K .7.1 L. <,

Fig.5.20 The formatted version of Fig.5.19

===111111011111111%;_ -121211
Eft Edit Yiew loses Modify Ted (;anmands See window Nein

Tole D,UIT.t, tik C <r)

Sow/ thrush
. brown, speckled

. lot from mid -winter onwards
WA, I. Iii d

k stale) or brown (female)
sings in mid -summer

Robin
Red front with brown and green
sings all the time

Redwing
Song thrush with red wings
migratory

Nightingale
brown (like a dumpy sparrow)
sings in summer

Mistle Thrush
Like a large song thrush with a sore throat

ctoT, ,11t,

Fig.5.21 Definition lists can be edited, much like ordinary text
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11.1led 11 111 11) PIPOITWNOVOI

Fpe Ede Ylew Immo !toddy Ise commends alle Amboy/ 1:180

Toe omeo um,' ft.
' CL

_1(31X1

The default rule

<bed th,

Henzoreal RJe skr.

ShacIna

775,13. 110I see Si 51 J

Fig.5.22 Rules with default settings added to a page

Insert Horizonte! Rule

Fig.5.23 The horizontal
rules button

list. The completed list can be edited much
like ordinary text. In Figure 5.21 for example,
the terms are in bold print and the definitions
are in Italics.

Rules
Dreamweaver has a facility to place horizontal
rules on the page, and these pairs of lines
can be used to break up a page into definite
sections. Obviously tt.e same effect can be
obtained by adding extra line spacing
between parts of a page, but some designers
prefer to use rules. To experiment with rules
first make sure that the text cursor is on a
blank line. Then select Horizontal Rules from
the Insert menu, which will insert a pair of
default rules on the line currently occupied
by the text cursor. The new rules will be
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UmiNeld Onaeowne IIM,tten sy 1)ti.ftenwrrmop,

-n blocky San rpernierxis Son Windom tielp

I , rtleC IC S. a)

The default rule

50°6 width, 10 pixels high, centre uligimen:

7Q% width, 5 pixels high. left alignment

300 pixels wide, 10 pixels MO. right al igen-nein

100% width. 20 pixel high. shading box -lot ticked

<tod

Fig.5.24 Various examples of rules added to a page

selected, and will therefore be shown highlightec on the screen. If it is
not already running, launch the Properties Inspector, which will show
the characteristics of the rules (Figure 5.22). Note that horizontal rules
are also available from the Common page of the Objects palette (Ficure
5.23).

By default the rules occupy the full width of the page, excluding the
narrow margins outside the text area of course. The width and height of
the rules can be specified in the W and H text boxes. The little pop
down menu to the right of the width text box enables the width dimension
to be specified in screen pixels or as a percentage of the default va:ue.
The height setting is always in pixels. The Alignment menu provides the
usual left, right, and centre alignment, although this is only of relevance
if the rules are set at something less than the full page width.

Operation of the Shading text box is perhaps the opposite of what Dne
might expect. There is nothing between the two lines when this Dox
ticked, but shading is added when the box is not ticked. With a little
experimentation you should soon master the use of rules. Figure 5.24
shows some example rules together with the settings used for each
one.
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Images

Getting the picture
Images are not an essential part of a web site, and it is possible to proc uce
attractive and functional sites without them. In the early days of the
Internet images were in fact something of a rariy, and they had to be
downloaded and displayed using a suitable program. Being reaistic

about it though, images will significantly improve
the lock of most web sites, and in some cases
can improve functionality as well. These cays
small :o medium size images can be downloaded
quite qu ckly, and they can be included as a normal
part of a page that will be displayed in brow 3ers
correctly.

Loadi-ig an image into Dreamweaver is fairly
stra ghtfcrward provided it is in one of the standard
formats for web use. The image is inserted at the
current cursor position. Tc load an image via the
menu system go to the Insert menu and select
the Image option. Alternatively, left -click on the
Insert Image button in the Common page at the
Objects palette (Figure 6.1) Either way, this br ngs
up a slightly enhanced version of the usual image
browser (Figure 6.2). It has the usual contras to
let you locate and select tle required file, wlich
can be on your computer or on the Internet.
Obviously your PC must have an Internet
connection if a URL is used instead of the path
and filename of an image file on disc.

The file Drowser has a couple of extra features in
the right-hand section of the window. If you left -

entry for an image file, a small prey ew image is shown in
of the window. 3eneath the image its file size is given,

Insert Image

E2

 O
D rj 4
16 'A

Fig.6.1 The image
button

click on the
this section
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noes -I meg. s
01 Irnegorcep .1,11..t. *try
02 New anwser Welch. .2,11wos

03 D.sporded121o11.../ Og.
04 Insert TebuIer Date
05 Frames ,Prt

06 Casuaing Sivle Shane 1111Clerny4
r 7Fl, h tvrna

.1 ,tn
1,-cmow rt ages

1f x
image %PAM

62B x 451 JPEIS 72K / 20 sec

Fig.6.2 The file browser used erhen loading an image

together with the approximate download time using the default modem
speed. For bitmaps, the dimensions of the image in pixels are also
provided. It Days to keep an eye on the file sizes and download times,
especia y when dealing with colour photographs. There is usually no

Fig.6.3 The image !oaded into the document
0
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Drenmweaver

`14)
This file is outside of the root folder of site 'Lessors - Dreamweaver'
and may not be accessible when you publish the site

Your root folder is
C \ Program Files \ Macrorredia \ Dreamweaver ALessons \ Lesson Files\

Would you like to copy tie file there now'?

No

Fig.6.4 This warning message will appear if the image is not stored on
the local site

point in using images that will take minutes to download and have
resolutions that are too high fcr most monitors to display properly anymay.
Small images will usually do the job just as well and will download much
more quickly.

Having found the required image file, select it, operate the Select button,
and it will be loaded into the document (Figure 6.3). There might be a
warning message displayed on the screen first, such as the one of Figure
6.4. This is pointing out that the image being loaded is not stored on the
root folder of the site, and it is asking if the file should be copied there.
Root folders and local sites are covered in the next chapter, but in general
all files for a site must be stored within the loca site so that they are
available when the site is published. Therefore, you should answer Yes
and have the file copied to your local site. Another warning message is
produced if you have not savec the document prior to loading an image.
In this case just click on the DK button to continue.

With the image loaded into the document, left clicking anywhere on the
image will select it. If the Prope-ties Inspector is active it will then change
to show the characteristics of the image (Figure 6.5). It will also show a
thumbnail version of the image in the panel at the left-hand end of the
window. Also, three handles (the small rectangles) will appear on the
image itself. These are on the right and bottom edges of the image, and
the bottom right-hand corner. If you are familiar with image -editing
software you should have no difficulty in using the handles, which operate
in the standard way. If not, load an image into a blank page and
experiment with the handles. Their purpose is to enable the image to be
resized by dragging the handles.
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Op Image 80. 153

psi

1Ahtln 113rarsof Detail J;7,1
fJJ al

Fig.6.5 The version of the Properties Inspector for editing images

The handle at the bottom enables the image to be stretched or
compressed vertically, and the handle on the right provides the same
function horizontally. The handle at the corner of tI-e image enables it to
be resized in both planes. When resizing an image you need to be
aware that changes in the aspect ratio of the image are likely to occur,
and these can give some very funny looking resLIts. It is tempting to
alter the shape of an image so that it is a perfect fit for the available
space, but this will often produce odd looking results. It is generally
better to fit text around an image rather than trying to fit the image into a
likely looking gap in the text.

Note that you can resize an image without producing a change in its
aspect ratio. Hold down the Shift key and then resize the image using
the handle at the corner. Instead of the horizontal and vertical sizes
being independently adjustable, they will then change together, retaining
the original aspect ratio of the image. The size of a bitmap image can
be altered by editing the pixel W (width) and H (height) text boxes in the
Properties Inspector. This provides an easy way of setting a precise
size in pixels, but you again have to be careful to avoid significant changes
in the aspect ratio of the image. The thumbnail picture of the image
operates as the Apply button, so left -click on this to apply any changes
that are made using the Properties Inspector. Left clicking on the W or H
label returns the image to its original width and height respectively.

Size matters
If you resize an image you will notice that the file size given in the
Properties Inspector does not change. This is because Dreamweaver is
using the image file as the basis of the onscreen image, and it manipulates
that file to produce an image of the correct size and shape on the screen.
It does not alter the file when changes are made to the image in
Dreamweaver's design view. Instead, it alters the way the file is processed
to produce the onscreen image. The same is true when a browser
downloads the web page. The raw image file is downloaded, and then
the HTML code tells the browser how to get the image to display properly.

Clearly it is not a good idea to use a large bitmap image file for what will
be only a tiny image on the web page. This gives a long download time
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Fig.6.6 More than one image at a time

for a small image. It is better to reduce the image size using an image
editor so that it is imported into Dreamweaver at something reasonably
close to the correct size. On :he face of it, a small image file can be used
to produce a large picture on the screen, giving a short download time.
This will work, but stretching a small image in this fashion will inevitably
compromise the quality of the displayed image. Note that with any
stretching or compressing of a bitmap image, there is the possibility
that the image may not look as good when displayed using a browser
as it did when viewed using Dreamweaver. Each program has its own
method of resizing images, and some work better than others do. The
only way to ensure that a bitmap image is reproduced correctly is to
leave it at its original size.

The same considerations do not apply to line art such as a GIF image.
The file size is determined by the complexity of the image rather tian
any size considerations. A file of this type will be displayed al a cerain
size when it is brought into Dreamweaver, and it can be manipulated in
the same basic fashion as a bit -nap. However, it does not have a natJral
size in pixels like a bitmap. A line art image is always displayed in the
highest quality available from the screen, printer, or whatever.
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Consequently, a line art image can be made as large as you like, and it
should be free from the rough edges that can occur when bitmaps are
scaled up.

Multiple selection
To select an image you left -click somewhere within an image, and to
deselect it you left -click somewhere outside the image. It is possible to
select two or more images by selecting the first one in the usual way,
and then holding down the Shift key while left clicking on an additional
image or images. The selected images will be shown highlighted, or
perhaps low -lighted would be a better term as they will be quite dark
(Figure 6.6). As the two images will usually have different characteristics,
the Properties Inspector can not meaningfully show the parameters for
two or more images. Consequently, the normal version will be obtained
if the Properties Inspector is active, and it will not be usable with the
images. However, the Cut, Copy, Paste, and Clear (delete) functions
available from the Edit menu will work when multiple images are selected.

Naming
It can be useful to select multiple images, but in order to do most image
manipulation the images must be selected one at a time and controlled
via the Properties Inspector. An image can be namBd using the text box
just to the right of the thumbnail image. There is not necessarily any
need to do this, but it makes life easier if you will be directly editing the
HTML code and it is essential when using images with JavaScript. If

you do add a name, it is best to use only lower case letters and avoid
other characters including spaces.

Ott Eirdvser Default ml 3.

All Basehnill
Top
Mddie
Bottom
TettTop
Absolute Kiddie
Absolute Bottom
Left
Right

Fig.6.7 Ten image alignment
options are available

Image alignment
The Properties Inspector has
various alignment options
available from the Align menu
towards the top right-hand corner
of the windjw. Alignment with
images is more complicated than
text alignment. There are some
10 alignment options to choose
from (Figure 6.7). The Browser
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Default simply
duplicates one of the
other nine options,
and this is normally
Baseline alignment.
However, the
alignment this
provides depends on
the default setting of
each browser used to Absolute Middle
view the page.

In order to change the
image alignment, first
select the image, and I ext Top 40

then select the
required option from
the Align menu of the
Properties Inspector.
If you place an image
in a blank document Fig.6.8 Three types of alignment

and then try various
alignment options you will prcbably be surprised by the results, or rather
the lack of them. The image is aligned relative to other objects, so you
can only see the effect of each alignment option if there is someth ng
else on the screen for the image to be aligned with. These brief
explanations plus the accompanying illustrations should help to clarify
matters.

Middle

Middle

This aligns the middle of the rrage with the baseline of the text (Fig ire
6.8 top).

Absolute Middle
Similar to the Middle option, but the middle of the image is aligned with
the middle of the text (Figure 6.8 middle).

Text Top

The top of the image is aligned with the top of the text (Figure 6.8 bottom).
To be more precise, the top of the image is aligned with the top of :he
highest text character.
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Top

Fig.6.9 An e>ample of top akonment

Top

This differs frorr Text Top in that tt-e top of the image is aligned with the
top of the tallest object in the ling, not the tallest text character. In the
example of Figure 6.9 tie picture of the boat is therefore aligned with
the top of the Diure of the cat, and not with the top of the text. Figure
6.10 shows the effect of changiig the alignment of the boat to Text Top.

Top

Fig.5.10 The effect of switching to text top alignment
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Top

Fig.6.11 Ar example of abso.'ute bottom alignment

Absolute Bottom
This aligns :he bottom of the image to the lowest point on the line. The
example of Figure 6.11 uses the same line that was used for Figures 3.9
and 6.10, but with alignment of the boat image set to Absolute Bottom.
The important point to note here is that the bottom of the boat picture is
aligned with the lowest point n the letter "p", and not with the bottom of
the cat picture.

Bottom

riiii, .,,1

Fig.6.12 The bottom adgnment option is used in tnis version
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Fig.6.13 The text has wrapped properly around this right aligned
image

Bottom

With this option the bottom of the image is aligned with the bottom of
other elements in the line, but unlike Absolute Bottom alignment, the
image is not taken below the text baseline (Figure 6.12).

Baseline

Has the same effect as the Bottom option.

\lain Heading
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Fig.6.14 An image that uses left alignment
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Fig.6.15 The text wrapping does not always give the desired effect

Right

This option places the image on the right-hand margin. Assuming left -
justified text is used, it will wrep around the image quite well, as in Figure
6.13.

Left

The image is placed on the left-hand margin when this option is selected.
With luck, text will wrap arou-id the image, as in Figure 6.14.

Wrapping

Unfortunately, when an image is applied to existing text that is left justified,
the text can be forced away f-om the space to the right of the image. as
in Figure 6.15. The same thing can happen when using right alignment
with right justified text, although this is a less likely combinatijn.
Fortunately, in practice the text will usually wrap around the side of the
image, but this is not guaranteed. If text fails to flow around an image
correctly, make sure that the correct type alignment has been set.

Note that text will not flow around an image if you place the image on
the page first, and then use the Paste function to add a block of text
above the image. Instead, the image will be moved down the page to
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Fig.6.16 The Properties Inspector has a drop down panel that
gives access to more settings

make room for the text. Images tend to be treated as if they were outsize
text characters. and it is usually best to think of -hem in that way. In

some ways the facilities offered by Dreamweaver seem crude compared
to desktop publishing and up-market word processor programs, but
bear in mind the Dreamweaver, unlike desktop publishing and word
processor programs, deals in roundtrip HTML. This places some definite
restrictions on what can be done.

H and V Space
When dealing with images the Properties Inspector offers additional
features that can be accessed via the drop down panel. Left -click on the
downward pointing arrowhead in the bottom right-hand corner of the
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Fig.6.17 A blank area can be placed around images
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Untitled Document (Untitled -4)- Dreamweever
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Fig.6.18 The spacing of these images does not look right due to
the blank line placed between the upper and lower pairs

Properties Inspector to access the drop down panel (Figure 6.16). In

order to remove the panel, left -click on the (now) upward poinling
arrowhead. The V (vertical) Space and H (horizontal) Space text boxes
can be used to place an exclusion zone around the image, as in Figure
6.17. Here respective horizontal and vertical values of 30 and 20 have
been used. This places the image 30 pixels out from the left margin and
also keeps the text from encroaching within 30 pixels of the r ght-hand
edge of the image. The text is also prevented from coming within 20
pixels of the top or bottom edges of the picture.

Note that if two images are positioned side by side, and they each have
a horizontal space setting of 20, the two images will be placed 40 pixels
apart (Figure 6.18). In fact there are four images i i Figure 6.18, with the
horizontal and vertical spacing both set at 20 for each image. However,
the vertical spacing is clearly larger than the horizontal spacing. This is
due to a blank line being added between the upper and lower pairs of
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Fig.6.19 A soft return cures the problem of unequal spacing

images, giving greater vertical spacing than the 40 pixels. This will not
necessarily matter, but using a soft return (Shift and Return) after the top
right-hand image in place of an ordinary hard carriage return will correct
the problem (Figure 6.19).-

J A1iyn IBrowr,er Default

[;\ Al!

ri
Rrse Size -I

Fig.6.20 The Properties Inspector
enables a border to be
placed around images

I5order 10

Edit )

Border
By default, no border is used
around images. Obviously an
image -editing program can be
used to add a border to an image
before it is brought into
Dreamweaver. If anything fancy
is required, this is the method that
must be used. A simple border

106



Images 6

Untitled Document (Lesson Ftles/Unhtled 8 html - Dreamwenver
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Fig.6.21 A 10 pixel wide border has been added to this image

can be added by typing a suitable figure into the Border textbox in the
Properties Inspector. This box is in the right-hanc section of the window
(Figure 6.20). The width of The border (in screer pixels) is equal tc the
value entered in the textbox. Figure 6.21 shows a photograph that has a
border 10 pixels wide.

The default border colour is black, but for a linked image the border will
assume the link colour. With a non -linked image it is possible to select
the image and some text, and then set a colour for them all. However,
the text can then be selectec in isolation and set to any colour, including
the original one. Therefore, it is effectively poss ble to set any desired
colour for the border of a non -linked image.

Also in this part of Properties Inspector you will find the usual three
alignment buttons, which operate like the alignment buttons for -.ext.
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Fig.6.22 Corel Photo -Paint 8 operating within Dreamweaver

There is also a Reset Size button, which sets the image back to its original
size if it has been resized in Dreamweaver.

Image editing
Dreamweaver does not have any built-in image editing capability, but it
is possible to edit an image from within Dreamweaver using an external
image -editing program. To do this, operate the Edit button, and the
appropriate program will then be launched. Figuie 6.22 shows Corel
Photo -Paint 8 being used from within Dreamweaver, but any graphics
program that can handle the appropriate image format should work just
as well. You do not have to use Fireworks, which is Macromedia's own
image editing software. The image should be opeied and loaded into
the graphics program automatically, but if anything goes wrong it should
be possible to open it manually.

Having made your changes, exit the program and elect to save the
changes when asked if you wish to do so. Figure 6.23 shows a simple
page -curl effect added to an image using Photo -Paint 8, without exiting

108



Images 6
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Fig.6.23 A simple page curltna effect added using Photo -Paint 8 from
within Dreamweave-

Dreamweayer. If the changes fail to appear on returning to Dreamweaver,
left clicking on the apply button (the thumbnail image in the Properties
Inspector) should update the page to show the changes.

By default, the image editor used will be the one that the operating system
associates with the file type concerned. In order to select a diffe-ent
image editing program go to the Edit menu and choose the Preferences
option. Then left -click File Types/Editors in the Category column :hat
occupies the left-hand section of the window. This will prod J ce
something like the window of Figure 6.24. In the lower part of the window
there is a list of file types on the left-hand side. Left clicking on on of
these shows the program associated with that file type on the lower
right-hand side of the window. To add a new Drogram to the list of
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Fig.6.24 Using the Preferences window to control file associations

available editors, operate the + button on the right-hand side of the
window. Do not use the one on the left side, which is used to add new
file types. A standard file browser will appear, and This is used to locate
the appropriate program file. Operate the Open button to add the
selected program file to the list.

The original program will remain in the list, and wi I still be the primary
editor. In other words, it is the one that will be used by default. To make
the new addition the default editor, select it and then operate the button.
To make the new addition the primary editor and leave the original editor
in the list, select the newly added entry and then operate the Make Primary
button.

Image free
These days most Internet users have browsers that can handle images.
However, there are probably still some users with. text -only browsers,
and others turn off image loading in order to speed things up. It is likely
that there will be increasing numbers of portable Internet devices to
contend with. These mostly have small screens that do not support
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Fig.6.25 The Alt tag is displayed when the pointer is placed over
an image

proper graphics. The lack of i-nages will not necessarily be of importance,
but in some cases it could leave users of the site rather puzzled. There
is a way around this problem in the form of an Alt tag. This is a piece of
text that will be used in place cf an image if the page is used with a text
only browser. Where the browser supports images, this text will alsc be
displayed beneath the pointer if it placed over the image.

Adding an Alt tag is very simple. Select the image and then type the text
into Alt textbox in the main secTion of the Properties Inspector. If yot_ try
out this feature, the Alt tag siould be displayed if the pointer is pla:ed
over the image, as in Figure 6.25. The same page is shown in Figure
6.26, but image downloading t -as been switched off in the browser. The
photograph has been replacac with a frame that is empty apart from the
Alt tag, which is displayed in the top left-hand corner. Clearly this type
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Fig.6.26 The text only version of the page. The Alt tag is displayed in a
frame where the image would normally appear

of thing ruins the impact of web pages, but it does at least give text only
users a clear indication of what would happen if they were using graphics
enabled browsers.

Low source
A low source image is a low -resolution image that is downloaded quickly
and then displayed while the main picture is down oaded. The point of
this is that it can provide a complete if rather crude version of a web
page almost immediately, even though the final version of the page will
take some time to download. For this to work properly the low source
image must have a small file size, otherwise it will not appear quickly
enough to be worthwhile, and it would significantly extend the download
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time for the full page. Ideally the file should only be about 1k or so. This
usually means using something like a highly compressed greyscale
version of a colour photograph, a greatly simplified version of a piece of
line art, or something of this nature. It should not be too difficult to
produce something suitable using your graphics software.

To use a low source image first select the main image. Then ether type
the location of the image into the Low Src. textbox, or operate the Browse
to File button to the right of the textbox. This brings up the usual file
browser, which is used to locate and select the required file Hav ng
pointed the browser to the reqLired file, operate the Select button. Note
that only the main image will be displayed in D-eamweaver's design
view. You can try loading the page into a browser to test this featt re,
but the page will probably load so quickly from the hard disc that :he
low source image will not be seen. Copying the page to a floppy cisc
and loading it from there might slow things down enough for the low
source image to be briefly visiole, particularly if the main image has a
large file size.

Image rollovers
An image rollover is where th ere is an image on the page, but a different
image is produced when the pcinter is placed on that area of the screen.
This is achieved using JavaScript, but you do not have to be a JavaSc-ipt
programmer in order to use rollovers with Dreamweaver. Dreamweaver
will generate the program fo- you. In order to obtain good results :he
two images should be the same size. To add an image rollover, gc to
the Insert menu and select Interactive Images and then choose Rollover
Image from the submenu. This produces a window like the one in Fig J re
6.27. A name for the rollover rrage can be typed into the upper textbox,

=1111N111111111111111111111V

Image Name

Original Image

Rollover Image

When Clicked. Go To URL

17 Preload Rollover Image

Browse

BrowseBrowse I

01,

Help

Fig.6.27 The image rollover dialogue box
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Fig.6.28 This is the "before" image of the rollover

or you can just settle for the default. The code is easier to deal with if
everything has a meaningful name, but it is not otierwise important.

The Original Image textbox is used to enter the name of the image you
wish to use as the one that is normally displayed on the screen.
Alternatively, left -click the Browse button to the left of the textbox and
use the file browser to locate and select the image The Rollover Image
textbox and Browse button are used in the same way to select the image
that will appear when the pointer is positioned over the rollover. By
default the Preload Rollover Image checkbox is ticked, and the rollover
image will therefore be loaded at the same time as the rest of the page.
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Fig.6.29 This is the "after" image of the rollover. The previous
image is restored when the pointer is moved away
from the rollover

The point of this is that the rollover image will appear immediately wien
the pointer is placed over the image. If the rollover image is only loaded
when it is first needed, the changeover may be too slow and the efect
could be lost. Therefore, even if the file size of the rollover is quite small,
leave this box ticked. If the image must be linked to another web page,
its URL is entered in the textbox at the bottom of the window. Note That
the rollover action will occur when the pointer is positioned over the
image, but the link will not. The image must be let clicked, as normal in
order to activate the link.
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Fig.6.30 If you examine the code for an image rollover, you will
find that it is written in JavaScript

When all the necessary information has been added, left -click the OK
button to add the rollover to the page. The original image will be visible

Dreamweaver's design view, but the rollover image will not replace it
when the pointer is placed over the image. In order to test this feature
you must add a rollover to a page, save the page tc disc, close the page
in Dreamweaver, and then load it into a browser that can handle
JavaScript. Any two images of about the same size will do to try out a
rollover.

Their main use is in buttons that alter when the pointer is placed over
them, with some sort of inverse video effect being Jsed. They can also
be used for simple visual jokes. The alert fox of Figure 6.28 changes to
the yawning fox of Figure 6.29 if someone is enticed into placing the
pointer over the rollover.

If you experiment with a rollover, try switching Dreamweaver from design
view to code view (go to the View menu and select Code). Much of the
code will look nothing like normal HTML (Figure 6.30), and that is because
it is not HTML but JavaScript. The section between "<script
language="JavaScript">" and "</script>" is the JavaScript program
that Dreamweaver has written for you.
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Fig.6.31 Precise positioning of text and graphics in this sort of layout
requires the techniques described later in this book

Complex layouts
If you only wish to use simple page layouts having a mixture of text and
graphics, simply adding the images into the text will probably give
satisfactory results. However, for anything that requires desktop
publishing facilities it is better to use tables and the other methods
described in later chapters of This book. These methods provide more
precise control over the positioning of both the text and the images,
making layouts like the mockup of Figure 6.31 reasonably easy. This
type of thing is not possible by simply dropping text and images direct
onto a page.

117



6 Images

118



7

Local sites

What is it?
Armed with the knowledge in the previous six chapters you should be
well on the way to building web sites using Dreamweaver. Making sone
web pages using text or a mixture of text and graphics should now 'oe
reasonably easy, but making some basic web pages and building a
web site are not quite the same thing. Anything more than the most
simple of single page web sites will need links. These have been touched
upon in previous chapters, but they are sufficiently important tc warrant
their own chapter. The subject of links is covered separately in chaver
8. In order to build a web site tne various files that are used in the site
must be organised properly. Before you publish a site on the Internet it
must be assembled on the ha -d disc of your computer. A local site only
differs from an ordinary site in that it is on your computer rather than on
a server somewhere on the Internet.

If you have experience at producing paper documents using a computer,
you may wonder why file management of a web site is difficult. If you
are used to producing large documents such as books and catalogues,
a web site might seem to be easy by comparison. I suppose one
important difference is that paper publications are normally reduced to
a single file for the printers. I: could take hundrecs of files to generate
the document, but these are eventually combined into one large file.

For example, initially this book will probably consist of around 300 or so
files on my computer, but it w II be sent to the printer as a single Adobe
PDF file. The source files are not needed once the PDF file has been
produced, because the PDF 'ile contains all the information needed to
produce the printed version of the book.

The situation is very different with a web site, which is not reduced to a
single file. It remains as a set of files, with matters complicated by the
numerous links needed to enable users to navigate around the site.
These links must lead the browser to the right file, and must continue to
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do so once the site is published. If a file is moved, the link must be
updated accordingly. Another complication is that the HTML code for a
web page does not necessarily represent the complete page. Any
graphics for instance, are kept as separate files and are not incorporated
into the HTML file. The page will only display properly if the browser
can find the image file pointed to by the HTML code.

Absolutely relative
When building a web site it is important to understand the difference
between absolute and relative URLs. URL stands for Uniform Resource
Locator, but it is what most Internet users would simply term a web
address. On the face of it, there is no problem in using absolute links at
all times. With a link of this type the full name and path to the file is
provided. This works fine when providing a link from your web site to
another site. You simply provide the full URL such as:

www.babanibooks.com/dreamweaver/contents.html

Any browser can then use that web address to ind the correct page,
provided it exists. The example web addresses in this book are purely
fictitious incidentally, so do not bother trying to find them on the Internet.

The situation is different when dealing with addresses within your newly
constructed web site. Your site is assembled on your hard disc drive,
and the location of a file would be something aloig these lines:

C: \ mywebsite \ images \foxphoto.jpg

Here "C:\" is the root directory of the hard disc on which the local site is
stored, and "mywebsite" is the folder used to hold the files for that site.
Some of the files are stored in subfolders of the "mywebsite" directory,
and the image files are stored in a subfolder called appropriately enough,
"images". The file in question here is one called "foxphoto.jpg" that is
stored in the "images" subfolder.

Using an absolute address for this file is fine while the site is on your
computer, but it will not work once the site has been placed on the
Internet. The browser of anyone accessing the s to will look for the file
on drive C: of the hard disc on which the browser is running, and it will
obviously draw a blank. Once the site has been published on the Internet,
all the addresses change. The absolute address of our example image
file would change to something more like:

www.babanibooks/images/foxphoto.jpg
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In order to avoid this problem it is essential to use -elative addresses for
all files within your web sites. With relative addressing, this would be
the address of the example image file.

\images\foxphoto.jpg

In order to use relative addressing, there must be a root folder for the
site, and all addresses are then relative to this folder. In this example the
root site is the "mywebsite" folder, since all the files are stored in tiis
folder and its subfolders. The root folder is whichever one you :ell
Dreamweaver to use as the roct folder, but in practice you do not have
any choice over which one to use. For this system to work properly and
remain manageable, all the files for a site must be n the root folder itself
or a subfolder of the root folder. There must be no files in folders higher
up the folder structure, or in a totally different part of this structure.

The reason that relative addressing works, is that the browser knows
where it has found the root older, and it can easily locate any files in t not
folder or in its subfolders. If a file is called "home.html", there is no path
given, just the filename. The browser therefore knows that the file lE in
the root folder. It does not matter whether the root folder is at
"www.babanibooks.com\dreamweaver" or CAdreamweaver", or anyth ng
else. The user will have directed the browser to the correct location,
and it will find the file there, wherever that location happens tc be.

Similarly, if a file is in a subfolder of the root folder, the browser knows
where the root folder is located, and it can find files in subfolders by
moving down the directory structure from the root folder. If you move
your site from one disc to another, or from a disc to an Internet server,
once users' browsers have been directed to the root folder they can f'nd
everything in the site from there.

Making roots
It is possible to have a system teat permitted the browser to be directed
to relative addresses up and across the folder structure, but this would
be doing things the hard way. In practice it is easier to make and
designate a root folder and then have everything in or below that folder.
If you will only be producing one web site, the rcot directory can ba a
folder of the root directory of the hard disc. In other words, someth ng
like:

C: \ booksite

Where it is likely that more than one site will eventually be produced it
might be better to produce 3 folder off the root directory of the hard

121



7 Local sites

disc, and then have separate subfolders beneath this to act as the root
folders for your sites. An example root folder would then be something
like this:

C:\websites\booksite

The point of this second method is that it helps avoid having huge
numbers of folders branching directly from the hard disc's root folder,
which would tend to complicate file management.

The first step in setting up a new site is to use the operating system or
Dreamweaver to generate the folder that will be used as the root directory
for the new site. In this case it does not really matter too much which
method is used, but in general it is better to handle file management
from within Dreamweaver wherever possible. This enables Dreamweaver
to keep track of the files in a site, avoiding error messages and blank
areas on pages. Here we will assume that the new folder is to be
generated using Dreamweaver and that it will also be designated as the
site's root directory at the same time.

Site Window
The Design Sites window is used to designate a folder as the local site,
or the root folder for the site in other words. To launch this window
select Design Sites from the Site menu. This will bring up a small window
like the one in Figure 7.1. As no sites have yet been defined there may
be no sites listed in the left-hand section of the window. However, there
will probably be one or two demonstration sites added as part of the
Dreamweaver installation process, as in Figure 7.1. The buttons in the
upper part of the right-hand side of the window provide four options:

New

This is used when you wish to build a new site "from scratch".

Edit

Use this option to make changes to the settings for an existing local site.

Duplicate

This option clones the settings for an existing site.

Remove

A site can be deleted using this button.
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Initially there will presumably be Defr.esdev 10
no sites to edit, duplicate, or
remove, and you will have to build
one "from scratch.' using the New
option. This button produces :ha
Site Definition window, as ii
Figure 7.2. Type a name for the
new site in the Site Name textbox.
This name is for internal use by T''111 4 Help

Dreamweaver, and you can
therefore use spacas, Fig.7.1 The Define Sites window

punctuation marks, upper and
lower case characters, etc. The name and path to an existing folder can
be typed into the Local Root Folder textbox, but it is easier to operate
the folder icon to the right of this. The Choose Local Folder window will
then appear (Figure 7.3). This operates much like an ordinary file browser,
but it is used to locate a folder rather than a file.

Edo

Dupiicare

Fueruye

If the directory that will be used as the root folder does not already exist,
first navigate to the folder that the new folder wil branch from. Then

Site Definition for Unnamed Site 1

Category

Remote Into
Design Notes
Site Mop Layout
File View Columns

Local Into

Site Ye me

Local Poor fold, Mm rernedi,' Dren,wen,..e

C.; Refresh Local File Lis' Automatically

HTTPACdress

This address enables the Link Chect er to
detect HTTP links that re er to your okm see

Cectie rr Enable Cache

The cache maintains file end asset information
in the site This speeds r p the Asset panel. Ink
management and Site Nap features

f. OF: 1 ..:mnoe, 1 fjelp I

Fig 7.2 The Site Definition winnow
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Choose Local Folder

Select I_A Fdes 4- M3 tit El-

j_notes J images
Ll 01 Imagemap
L102 New Browser Window Li swits
2_103 Disiointed Rollover

0.1 Insert Tabular Data
2_105 Frames
LI 06 Cascading Style Sheets
2_107 Flash Obtects

Select Lessons

aeled

Cancel I

Fig.7.3 This window is used to choose the local (root) folder

operate the New Folder button, which is the third one from the left in the
row of four icons. These are near the top of the window on the right-
hand side. A new folder appropriately called "New Folder" will then
appear in the main part of the window. Type in a new name for the
folder and then left -click in the blank part of the window to make the new
name take effect. Next operate the Open button, and you should then
have a new but empty site. Operate the Select button to return to the
Site Definition window. The Local Root Folder should now contain the
name of your newly created folder, complete with its full path.

Auto refresh
There are three parts of the Site Definition window we have not yet
considered. The Refresh Local File List checkbox is ticked by default.
With this option selected Dreamweaver will automatically refresh the
local file list whenever changes are made, such as moving or deleting
files. The Local panel of the Site window will not automatically refresh if
the tick is removed from this box, which will speed up operation of the
program in some respects. The file list can be refreshed manually by
operating the refresh button (the one having a circular line with an
arrowhead).

The HTTP Address textbox is used to enter the absolute address that
the new site will eventually occupy. In other words, something like
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"www.robertpenfold.co.uk". It is not essential to use anything hare
initially, and when you are just making some initial experiments with
Dreamweaver there is not much point in doing sc. On the other hard,
there is no harm in adding a web address here.

The Cache checkbox is ticked by default, and a cache to help speed up
link and other file manageme -it tasks will be produced. It is a good idea
to use this option since the Assets
panel will not work unless i: is. =.11.....ww -
Assuming the cache option is

v,

'a `ft
trn..1WrIOunim as you .mr go new

used, the message window of
Figure 7.4 will be produced when
the OK button is operated. I

would suggest ticking the
checkbox so that this message is Fig.7.4 This message appears if the

r 00r, 0100 00 1114 m eoVr

not produced in the future. Then
operate the OK button to remove
this window.

cache option is used

Editing
You should now be back at the Define Sites window, but it should now
list the new site that you have just created (Figure 7.5). Operate the
Done button to move to the Site
window (Figure 7.6). This will
show the name of the new site in
the title bar, and the new root Lessons  Deemmeeseet

folder will be shown in the left-
hand section of the window It will
actually be listed as the "Local
Folder", but this is just an
alternative term for a root folder.
The root folder is now in position_one Help

and assigned to the new site, but
it is still an empty site. Next the Fig. 7.5 The new site listed in
Site window, which has its own the Define Sites window
menu system, must be used to
add the files and folders that are needed for the site. First make sure
that the Site Files button is active. This is the one under the menu bar
immediately beneath the wo'd "File".

Suppose that we wish to add a folder called "images", and place scme
image files into it. First the folcer must be created, and this is achieved

11=11211111.1111111111116k: K
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File Ede Yiew ete Window delp

! Site IFqst S!e _7j
Remote Srte I No 1 Sae! Type

41 hi

Fig.7.6 The Site window now shows the root folder for the new site

1111=111111=11111111r
File Echt yieve 2de Window deli,

New Window CelN
New from Template

'Yew File ClrlShdt4h1
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Rename F2
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Preview in Browser

Check Links

Check Target browsers

Denn Notes

1 FoxJoke him
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4 Untitled -8 him

Sluh4F8

Exit 0;140

Fig.7.7 The Site window has its own menu system
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126



Local sites 7

9131211311:3111111111111111111111111111111111111114-
F le Leto 5ote W ndovr zielp

sne

2cj

Remote S

4 I I

mageL
Red jpg

 Fo.-2 ipg
 Fig6-126 opg
I aernY5

Clerny4ipg
 Clerny3 ipg
le C1ernY21P9
 Clernyl ipg
37 05050006 mg

Folde; Jji!',,001 1 9

1 1 2 Core! P 02/02,2001 16
115 Corsi P 02/02,2001 16
434 Core! P 18/06/2000 09
5KB Core! P 31/01/2001 22

74KB Corel P 31/01/200121
81KB Coral P 28/01/2001 20
72KB Corel P 28/01/2001 20
80KB Corel P 28/01/2001 20
11KB Core! P 29/01/2001 16

Fig.7.8 Files added to a site using the operating system or
applications programs will be shown in the Site window

by selecting New Folder from the File menu. Note that it is the File menu
of the Site window that must be used (Figure 7.7) and not the F le menu
of the main document window. A new folder off the site's root directc ry
will appear, and it will initially be called "untitled". Type "images" to
rename the subfolder and then left -click in a blank area of the wndow to
make the name change take effect. Alternatively, cress the Return key
to make the change take effect.

Now we need to add some files to the new folder. This can not be done
using the Site window, because the files will be in folders outside tie
site at this stage. Therefore, use the operating system to copy files to
the appropriate directory, and they should then appear in the appropriate
folder if it is examined using the Site window (Figure 7.8). You can also
generate files using a graphics program, word processor, etc., and then
save them direct to the appropriate folder within the site. Once files Ere
stored within the local site it is pest to use Dreamweaver to undertake
file management tasks such as moving or deleting files. Any links that
are affected will then be changed automatically so that they are still
correct. Changes made using the operating system could break links,
and any damaged links would then have to be repaired manually.

Here we generated a root folder and a subfolder using Dreamweaver
and then added files into one of the folders. If preferred, you can generate
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Fig.7.9 The newly created file is shown in the Site window

the directory that will be used as the root folder, equip it with files, and
then designate it as the root folder for your new site. The end result
should be the same either way.

New HTML files
If you are going to use Dreamweaver to generate a new HTML file, a
basic HTML file should be generated using the Site window first. This
file is then opened and completed using the desicn or code views in the
normal way. Start by selecting Site Files from the Site menu so that the
Site window is launched in the usual way. Next left -click on the entry for
the folder where the new file is to be placed. For the sake of this example
left -click on the entry for the root folder.

Next select New File from the Edit window of the Site window, and a new
file called "untitled.htm" will appear in the Local Folder panel. Edit the
name to something more suitable such as "home.htm" and then press
the Return key or left -click on a blank part of the window. The entry for
the new file will probably be at the bottom of the panel, well detached
from the root directory, but operating the Refresh button should move
up into place near its directory (Figure 7.9).

To open the new file simply double-click on its entry in the Site window.
The file will then be opened in the usual Dreamweaver document window,
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enabling it to be edited in the normal way in desicn view, code view, or
a mixture of both. Try typing some text into the document window when
using design view, and then load in one or two of the image files stored
in the "images" subfolder of tne local site. When you have finished, go
to the File menu and select Save to save the modified version of the
page.

If you launch Dreamweaver and then start adcing images into the
document window and saving the results, it will almost certainly generate
some error messages. These should be avoided by constructing a basic
site first and then building up the web pages from the files it contains.
This is not just of academic importance. With everything structured
properly Dreamweaver can keep track of all the files and the links between
them. This should ensure that everything in the site functions properly,
with no blank spaces instead of images or links that lead to nowhere.

File management
The Site window can be used to handle various file management tasks
such as moving or deleting files. These are undertaken in much 'he
same way as when the same tasks are performed using the operat ng
system. In order to rename a 91e, left -click on its entry to select it and
then left -click on the entry again. Be careful to leave a reasonable cap
between the two clicks or they will be construed as a double-click and
the file will be opened.

If all is well the text cursor w Il=NIESEMEMENINIMEN
appear and the filename can be

ate s tollowng hes, L Update-I
edited. Press the Return key or Upd

left-click on a blank area of the r C°"
+pdate

window to make the change take
effect. If the file concerned s
linked to another file or files, a
window like the one in Figure 7.10
will appear, asking for Fig.7.10 Links can be modified
confirmation that the link shculd automatically
be modified to suit the change of
name. Unless there is a good reason to do otherwise, operate the update
button. The site should then knction as before.

New folders and files can be added, and this process was cescribed
previously. A file or folder can also be deleted by selecting its entry and
either pressing the Delete key or selecting Delete from the File menu. If
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MKTIMEMEMINEr the file has a link or links to other
files, a warning message similar

NC; Can upo.eea use,ae..:hang Lmss Smerrle dialog to the one in Figure 7.11 will
Corr werho

appear. Operate the Yes button
4!e J to delete the file anyway, or the

No button to abort the deletion
Fig.7.1; Operate the Yes button process. Deleting a file that is

to ielete the file used by a page in the site will
result in the image disappearing

from the page, and it will be replaced by a grey rectangle containing a
question mark (Figure 7.12). It is then up to you to delete the defunct
image from :he page or restore the missing file.

Editing and deletion
The main parameters for a site can be edited by going to the Site menu
and selecting Define Sites. Select the site you wish to edit from the list
that appears, and then operate the Edit button. This takes you to the
Site Definition window for the selected site, where you can change its
name, the FITTP address, etc.

ter mr nee

Fig.7.12 The missing image on the right is due to a broken link
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In order to delete a site, select
Define Sites option from the Sites
window to bring up the list of sites
(Figure 7.13). Select the site to
be deleted and then operate the
Remove button. This will produce
the warning message of Figure
7.14. If you are sure you wish to
continue, operate the Yes button
to remove the site. You will then
be returned to the list of sites,
which should no longer co -ffain
the one that has just been
removed.

0=1=11101111111111111111111V

Ede

Dosoiced.

Fig.7.13 Use this window to
select the site for
removal

Note that the folders and files for 1=111.11111111`' .2_(1

the site are not deleted Dy this
action, and that everything wil still
be in place on the hard disc. The
difference is that Dreamweaver Yes 1 No

no longer considers those fi es
and folders to constitute a site. Fig.7.14 Con`imation is required
There is no one -click method of
undoing the removal of the site,
but defining a new site based on the folders and files of the old one can
effectively reverse the process. If the files and folders are no longer
needed they must be deleted using the file management facilities of the
operating system.

You car not undo Ibis action
Delete vie see named "Second See"?

Site selection

before the site is removed

When two or more sites have seen defined, you can switch from one to
another by selecting Open Ste from the Site menu to produce a submenu
of the available sites (Figure 7.15). There is a tick against the name of
the site that is currently selected. To open a dterent site simply left -
click on its entry in the menu., which will bring up the Site window for that
particular site. You can thei choose a file in the site to open and edit,
make an "empty" HTML file and open it, etc.
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Fig.7.15 The current site can be changed by way of this submenu

Site map
A site map can be produced by selecting the Site Map option from the
Site menu. However, initially this will probably produce the window of
Figure 7.16, pointing out that a home page has yet to be specified. To

specify a home page
you must first operate
the Define Sites
button. This brings
up the familiar list of
defined sites. The
(me to be edited is

Dein* Sites Camp& selected and then the
Edit button is

Fig.7.16 A home page must be specified operated. This brings
before a site map can be produced up the Site Definition

window, and Site Map
Layout should be selected in the Category panel down the left-hand
side of the window. This produces the window of Figure 7.17.

Dreamsreaver

The see map cannot be built because either
A home page na snl been specihei
The specified home page doesn't enst
The home page s outside st Me toot toklet

Soled a home cage by choking Deane Sees
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r DsplayQependem Files

OK Cancel
I

Help

Fig.7.17 The Site Map Layout section of the Site Definition window

The full path and filename for the home page can be typed into the
Home Page textbox, or operating the folder button to the right of this
box will launch the file browser. If you use the second method, Iccate
and select the home page HTML file and then operate the Open button.
There are various options available that control the way the site map is
displayed, but for the time being leave these as they are. Once the
filename has been added to tie Site Definition window, operate the OK
button to return to the Define Sites window, and then operate the Done
button to return to the main Site window. Close this window and select
the Site Map option again, and this time a site map should be produced
(Figure 7.18).

The difference between a normal view showing folders and files and a
site map is that the map does not show the file and folder structure at all.
It shows the pages in the site plus the main links between then. In most
cases there will be additional links, and some pages could well link to
dozens of other pages. Having hundreds of lines criss-crossing
everywhere would be confusing and not very informative. Therefore,
the minor links are shown as optional lists of linked pages. A list can be
displayed by left clicking on the "+" symbol displayed to one side of
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Fig.7.18 A simple site map

each icon that has additional links (Figure 7.19). Left -click on the "+"
symbol again to retract a list.

Planning
With a small site that uses few files there is no necessity to resort to any
subfolders at all. Even with everything in the root folder there will be no
difficulty in finding any file you require. With larger sites a more planned
approach is required. Dreamweaver should always be able to find the
files it requires provided you always abide by the file management rules,
and do not move or rename something while Dreamweaver's "back is
turned". Getting the files and folders organised properly is more for
your benefit, so that you can easily locate any file that you wish to work
on.

Using a different subfolder for every page is one approach to things,
with all the files needed for each page stored in the relevant subfolder.
With a large site this could result in a complex structure, with subfolders
of subfolders of subfolders, and so on. Most users find it easier to have
a separate subfolder for each section of a large site, rather than one per
page.

Where large numbers of image files, audio files, etc., are involved, each
subfolder can have its own subfolder for storing these files. If few media
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Fig.7.19 The minor links for each page can be oisplayed if required

files are involved, a single subfolder off the root folder is the mcre popular
option. Presumably some general planning will be undertaken before
starting work on anything other than a very basic site, with a sketch of
the page structure being made. This should provide a good basis for
working out a sensible file and folder structure for the local site.
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Links

Adding links
It may be "love that makes the world go round" but it is that other four
letter word beginning with "I" that makes the Internet go round. While
using the Internet you click or one link after another. Links enable users
to move around web sites with just a few clicks of the mouse, and move
from site to site just as easi y. People can and co surf the net for tours
without typing in a single web address. Unless you put in links to enable
users to easily move around your web sites they will probably give up
and go elsewhere. Links t-iat do not work properly are another 'sure
fire" way of getting rid of vis tors to your site. It is the links from one
page of the site to anothe- that make it a web site rather than j Jst a
collection of separate pages.

Links to other sites are perhaps less important, and on the face of it
there is no point in making it easy for people to leave your site and go
elsewhere. However, if ever/one took this attitude it would become much
more difficult to navigate the Internet and find what you require. The
secret of success with links to other sites is reciprocity, or "I'll scratch
your back if you scratch mine" if you prefer. Provide links to other relevant
web sites, but try to make sure that plenty of other sites have links that
bring users to your site as well.

Relative links
Hyperlinks, or just plain "links" as they are often called these days, provide
a quick way of directing a browser from one page to another. The cage
containing the link is the "referring" page, and the one that it is linked to
is the "target" page. Obviously the link on the referring page must include
the path and filename for the target page so that the browser k -tows
exactly where to go. As Ne have seen already, web pages can be
addressed using absolute or relative addresses. A link to mother web
site must use absolute adcressing, while links within a site are relative,
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but relative to what? We have previously considered relative addressing
using the site's root directory as the basis. With this method the path to
the target file is given with the site's root directory acting as the starting
point. Internal links can use this method of relative addressing.

Dreamweaver also supports document relative path names, which use
the subfolder of the referring page as the starting point for the path.
This is very convenient when linking to a page in the same subfolder,
since no path is needed. To link to a page called "LondonBridge.htm"
in the same folder as the referring page the target would simply be given
as "LondonBridge.htm". Giving the path to somewhere lower in the
directory structure is also very simple. Suppose that this target file was
in a subfolder called "Tourism", and that this branched directly from the
subfolder containing the referring page. The path and filename for the
target would be " \Tourism \ LondonBridge.htm".

Matters are a little more complex if the target is in a subfolder that is
higher in the directory structure, or it is in a subfolder that has its origins
higher in the directory structure. In either case it is still possible to use a
document relative path, and two full stop characters (..) are used to
indicate each move up one level in the directory structure. Consider
these two paths and filenames:

../LondonBridge.htm

../../Bridges/LondonBridge.htm

In the first example the file is in the folder one level higher up the directory
structure. This is indicated by the two full stops at tie beginning of the
path. In the second example there are two pairs of full stops, indicating
that the file is two levels further up the directory structure. However, it is
then down one level in a subfolder called "Bridges". Using this method
it is possible to provide a path to anywhere in a local site, from anywhere
within that site, but the site -root relative method is the simpler of the two
systems. If you use a link that is relative to the referring page, always
make sure that the page has been saved first. Until the page is saved
there is nothing for the link to be relative to.

Making links
Adding links from one page of a site to another is very easy using
Dreamweaver, using either text or images as the sources of links. To

experiment with links make up a dummy site having two or three pages
containing some text and an image or two per page. The Copy and
Paste facilities enable a small amount of text to be repeatedly duplicated
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Fig.8.1 Some previously linked pages are available from a pcp-down
menu in the Properties Inspector

so that the dummy pages can be filled quite rapidly. In this example the
word Parliament will be linked to a page containing a picture of the
Parliament building, but for testing purposes you can link any word to
any page. Even a blank page will do, but it is better if you add a few
words to identify the page.

To use text as a link it must first be selected using the usual dragging
technique. Drag the cursor over the text while holding down the left
mouse button. If only a single word is involved, double clicking anywhere
on the word will select it. If the Properties Inspector is not already active
it should be launched now. The name of the page to link to can be
typed into the Link textbox in :he bottom left-hand section of the Properties
Inspector. When the filename nas been entered, Dress the Rer.urn key to
make the link active.

If a link to the same page has been used recently, an alternative method
is to left -click on the downward pointing arrowhead at the right-hand
end of the textbox. This will produce a pop -down menu showinc the
link pages that have been used recently (Figure 8.1), and the required
page can then be selected by left clicking on its entry. There is a Third
method available, which is tc operate the Browse for File button (the
one that uses the folder iccn, and then use the file browser to locate
and select the file for the correct page. The Relative To menu provides
the option of using document relative or site-roct relative paths.

Testing links
Once the link is active the selected text will be underlined and i-. will
change colour. Left -click somewhere on the screen so that the link s no
longer highlighted, and it should change to the default colour for linked
text (Figure 8.2). The link can not be tested by simply left clicking on the
text in Dreamweaver's desicn view. As we will see later, there is a simple
method of testing links using Dreamweaver. The alternative is to test
them using a web browser, either within Dreamweaver or externally. This
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As well as Nelson's Column and one of the famous pigeons. Big Ben can also he
seen in the background of this shot taken from the steps of th:. National Gallery.
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Fig.8.2 The word "Parliament" is used as a link, and it is therefore
underlined and in a different colour to the main text

subject has been covered previously and will not be considered further
again here. Figure 8.3 shows the link being tested using Internet Explorer
5.5 within Dreamweaver. The linked text has been left clicked in Internet
Explorer, and the correct page has been loaded.

A link can also be added by selecting the relevant text and then selecting
the Make Link option from the Modify menu. This brings up a file browser
(Figure 8.4) which is used to locate and select the link page. This is
actually the same file browser that is produced via the Properties
Inspector. Once the correct file has been selected, operate the Select
button to return to the document where the linked text should be shown
underlined and in a different colour. Yet another method of selecting the
file for a link is to use the Point to File button, which is the one immediately
to the right of the Link text box. In order to use this the Site window must
be on view. If necessary, bring it to the fore by selecting the Site Files
option from the Window menu. The Point to File icon is then dragged to
the required file in the Site window (Figure 8.5).

Here we have only considered relative links for use within the web site.
To make an absolute link the text is selected and then the full URL is
typed or pasted into the Link textbox of the Properties Inspector.
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Fig.8.6 Links are easily removed

Removing links
If you change your mind and wish
to remove a link, this is easily
achieved. One way is to select
the linked text and the erase the
entry in the Link textbox of the
Properties Inspector. Left -click on
an inactive part of the Properties
Inspector or somewhere on the
document to make the change
take effect. Another method is to
select the linked text and then
activate the Modify menu. This
menu charges to suit the
situation, and with linked text
selected it will offer a Remove
Link optiol (Figure 8.6).
Selecting this will immediately
delete the link.
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You will notice that the Modify menu also provides a Change Link opt on.
Selecting this brings up a file browser, and a new file to link to can then
be selected. The same thing can be achieved by selecting linked text
and then either editing the tex` in the Link textbox, or activating file browser
so a different file can be selected. In the Modify nenu there is an Open
Linked Page option, which gives a crude but effective means of checking
that you have chosen the right page for the link. Once the linked page
has opened, close it and return to the original page by left ciickinc on
the "X" icon in the top right-hand corner of the w,ndow.

Linking images
Images are linked in much the same way as text. Select the image and
then use any of text linking methods described previously in this chapter.
Note that as far as links are concerned there is no difference between an
image and any border that is placed around it. When the page is
displayed in a browser, left clicking on either the image or its border will
move the browser to the target page.

Links from images have an
interesting optional extra it the

Imips.701C )1/ f,4

form of multiple links. In other ti 44,

words, rather than linking the
T xy. r-

entire image to one page, ItL4M. i=cks,e 4 Lg..

separate parts of the image can
be linked to different pages. Fig.8.7 The Hotspot buttons

Hotspots and image maps are the
key to this feature, and they are accessed using the buttons in the bottom
left-hand section of the Properties Inspector (Figure 8.7).

To try out this feature, loac a page of the "dummy" site that has an
image, and then select the image. In the Map textbox of the Properties
Inspector add a name for the image map. Only use letters and numbers,
and do not start the name with a number. Left -click on the hot:spot
button having the rectangular icon and then use the mouse to drag a
rectangle somewhere on the mage. The selected area will De filled in
with pale blue, but the image will still show through to some extent. This
gives something like Figure 8 8, where the central part of Tower Br dge
has been used for the image map.

Next a target page is selected by operating the Browse for File baton
and then using the file browser in the usual way. Some text can be
added to the Alt textbox if desired. With most browsers this *.ext wRI be
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it
now cxt IINTS-Beitaqt.

Fig.8.8 The rectangular hotspot added to Tower Br'dge

displayed below the pointer when it is positioned over the relevant part
of the image. Where it will not otherwise be clear what the link actually
links to, this gives an opportunity to clarify things for users. In our Tower
Bridge example, the link could be to a page giving a brief history of the
bridge. The Alt text could then be something like "History of bridge"
(Figure 8.9).

Polygon hotspot
Now try another hotspot using the Polygon Hotspot Tool, which is
obtained using the button at the right-hand end of the row. Repeatedly
left clicking on the image leaves square markers on the screen, and the
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Fig.8.9 The hotspot is not visible when the page is viewed in a
browser, but the cursor changes and the Alt text appears
to indicate its presence

Fig.8.10 Adding a polygon hotspot
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Fig.8.11 The completed polygon hotspot

area between them is filled in with the pale blue mask to show the "hot"
area. Figure 8.10 shows part of the area occupied by HMS Belfast filled
in, and Figure 8.11 shows the completed job. This system is rather
crude by the standards of graphics programs, but it is good enough for
this application. Left -click the Arrow Tool when you have finished the
polygon.

The handles (the square markers) can be moved by dragging them
around the screen, so "fine tuning" a hotspot is straightforward. If you
make a mess of things, press the Delete key to remove the hotspot and
then start again. When you have finished, select a target page and add
the Alt text, as before. Note that you can return to 3 hotspot to change
the link or edit other details. If you left -click on a hotspot, it is the hotspot
that will be selected and not the image as a whole.

You might like to try the Oval Hotspot Tool as well (the middle of the
three buttons). By left clicking on the image and then dragging the
pointer, a circle of the required size can be produced. It is difficult to get
the circle exactly where you require it, but with a little resizing using the
handles it is possible to edge the circle into the right position. You
should then have something along the lines of Figure 8.12. The page
and the links are then ready for testing using a browser.
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Fig.8.12 Circular hotspots car also be used

Of course, when viewed in a browser the shadinc showing the hotspots
is not shown, and there is nothing to indicate their presence other than
the text that appears when the pointer is placed over a hotspot. However,
the image can be edited to incicate the hotspots before it is loaded into
Dreamweaver. The relevant areas can be shown paler than the rest of
the image, tinted, or something of this nature. Once loaded into
Dreamweaver, these areas then act as guides to help get the hotspots in
the right places.

Link Checker
Ultimately you will
probably wish to
check all links by
giving them the "acid
test" using a browser,
even if this takes a fair
amount of time.
Initially it is still a good
idea to use
Dreamweaver to

DZEZMIIIMIIM Pinks to Mes rot found on ocel

Broken Unks 1

t;

ornpleta

OK 1 Broken. 0 Eutemei

Save gose Help

Fig.8.13 The Link Checker window
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search for problems with links so that they can be sorted out early in the
proceedings. Then, hopefully, everything will be fine when your site is
tested in practice. Dreamweaver's Link Checker can be used to test all
the relative links of a page in a local site, but it wiq not check external
links. To launch the Link checker go to the Edit menu and select the
Check Links option. This will produce a window like the one in Figure
8.13.

The main panel of the window lists any broken links. In other words, it
lists links from the current page to files that are not present on the local
site, or are not in the right place. In this example a file has been

deliberately erased
mnscram=mimmwv.:;;;;,,,' j, using the operating

SCnw
system instead of

trn links to files not bound on local

=des Bro1,en L ;
file handling facilities.
This has resulted in a
broken link, which is

Nos 1 Total 1 HTML duly listed by the Link
links 8 Total 8 OK °Broken °External Checker. A broken

link can be repairedeve close I Help I

INt by reinstating the
Complete missing file, or the

Fig.8.14 With the file restored the link is source of the link can
no longer broken be removed. In this

example the erased
file was reinstated from the Windows Recycle Bin, and a further check
then showed that the broken link had been successfully repaired (Figure
8.14).

The Link Checker can also be used to check links over the files in a
folder or an entire local site. Go to the Site menu, select the Open Site
option, and then choose the appropriate site from the submenu that
appears. This will open the Site window, which wi I show the files and
folders for the selected local site (Figure 8.15). Sel acting the page and
then activating the Site Checker will check the links for a single page in
the site. In this case we wish to check the contents of a folder, so one of
the folders is selected by left clicking on its entry (the root folder will do).
The Link Checker is activated by going to the File menu of the Site window
(not the document window) and choosing the Check Links option. This
will produce a window like the one of Figure 8.16, which lists any broken
links.

using Dreamweaver's
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Fig.8.15 The Site window snows the files and folders in the selected
local site

It also provides a summary o' what has been checked and the results
obtained. The results can be saved to disc by operating the Save button,
which produces the
usual Save As file
browser. This could
be useful if a large
number of problems Flee I Eliolten Links

in odes/CI,
are reported. Note itool Win London ipq
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Lill, Checker - First Seel Site
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Lci To check an entire
site, bring up the Site
window in the manner
described previously.
Then select Check
Links Sitewide from
the Site menu of the
Ste window. This will
bring up the Link
Checker window as
before, but this time it
will check all the links
in the local site. Try

Show menu (Figure 8.17).

Fig.8.17 Orphan files can be detected

selecting the Orphan files option from the
The so-called "orphan" files are "unloved" files that are part of the local
site but do not link to anything. It could be that any files listed are not
supposed to be linked to anything, but it is useful to check the list to
ensure that you have not forgotten to add links to any files.

External checking
Although Dreamweaver can not check external links, it can provide a list
of them. Start by checking the internal links for the current page or the
whole site as before. Activate the Show pop -down menu at the top of
the Link Checker window, and select the External Links option. A list of

external links will then
appear in the main

show L (links to pages outside site not
panel of the Link

El=1111111111.1110L.

Checker window
Files 1 External Links

0. hr http //rmw babanthoot. s co u1 (Figure 8.18).
at;.? h13 //woe. robenpentolc coin Although it is not

possible to check an
external link using
Dreamweaver, you
can copy a URL from

Lave I close j Help
the Link Checker to

complete the address textbox of
Fig.8.18 External links can be listed a browser. You can

then check that the
browser goes to the right page. The point of this method is that it makes
sure that the text used as the address in the browser is exactly the same
as the text used for the external link. To copy a URL from the Link Checker,

Files 1 Total, 1 HTML

s 11 Total 8 OK 1 Broken. 2 External
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Change Link Sitewide (Site - First Site!)

change All Links To:

ihttp //www robertpentold co uN

Into Links To:

ihttp //woe*. rapentold co ukl

_J
cancel

Help

Fig.8.19 Using this dialogue box it is possible to alter all the links to
a file or external page

simply left -click on it and then press Control -C (Windows) or Command -
C (Macintosh). It should the.i be straightforward to use the Paste facility
of the browser to put the URL into the browser's address text box.
Incidentally, the same method can be used to copy and paste a URL
from the Link textbox of the Properties Inspector.

Sitewise change
It is possible to simultaneously change all the links to a giver page, be
it internal or external. Suppcse you have several pages in a sire that link
to a web page that is switched to a new site. One option is to go to all
the affected pages and change the links one by one. The alternative is
to first open the site
by going to the Site
menu, selecting Open
Site, and then
choosing the
appropriate site from
the submenu. Next
select Change Link
Sitewise from the Site
menu of the Site
window (not the

Help

document window). Fig.8.20 The links to the file or page are listed,
This produces a and you have an opportunity to
window like the one in change your mild
Figure 8.19. In the
Change All Links To text box -.ype the URL of the existing link that you
wish to change. In the Into Links To textbox type the name of the new
URL that you wish to use for the links. Then operate the OK button,

Update Files

Ur dee links in the following hies? 4irate,..:

Dore! Update
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which will bring up another window, this time showing the links to the
old URL that have been found (Figure 8.20). Operate the Update button
to implement the changes, or the Don't Update button to abort the
operation.

Named anchors
The links covered so far are the most common type where the link takes
the user to a new web page. There is another type that takes the user to
a particular point on a page, and these are known as "named anchors".
There is obviously little point in using a named anchor on a small page
that can be viewed in totality on the average monitor, or which requires
minimal scrolling in order to view the whole page. This type of link is
used in long pages that have to be viewed bit by bit, with perhaps only
about 10 percent of the page being visible at any one time. In general,
this type of page is best avoided, and in most cases it is better if large
amounts of material are broken up into separate pages of moderate
size.

The long page option tends to be taken where there is not enough
material to fully merit breaking things up into several separate pages,
but there is too much material to be used easily as a single page. It is
also popular where something like a series of news stories has to be put
together and published on the web as quickly as possible. This could
be done as separate pages, but one large page is easier to put together
and test. A list of contents is used at the top of the page, with each item
in the list linking to a named anchor in the relevant part of the page. By
left clicking on an item in the list a user is immediately taken to the
relevant part of the page.

Each section of the page normally has a link back tc the top of the page,
so that it is easy to return to the list to select another section of the
document. The single page method is slow initially because there is a
large page to download. However, thereafter the system is very quick,
and left clicking on a link produces an almost instalt response. This is
due to the fact that there is nothing to load when a link is activated. The
browser just has to move to a new point in the page that has already
downloaded.

Anchors and links
To try out named anchors produce a document that is suitably long.
The Cut and Paste functions can once again be used to repeatedly copy
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a small amount of text so that it
soon fills a long page. Break the
text into several sections, with a
heading for each one. A named
anchor consists of two parts,
which are the link and the anchor.
The link is much like any other
link, except that it points to a
named anchor rather than a
page. When the link is activated,
the browser jumps to the poirt in
the page where the ancho7 is
placed.

An anchor is added at the current
position of the text cursor, so eft -
click in the document at the
position where the ancho- is
needed. To add an anchor, go to
the Insert menu, select Invisible
Tags, and then choose Named
Anchor from the submenu (Figure
8.21). This brings up the small
window of Figure 8.22, and a
suitable name for the anchcr is
typed into the textbox. The name
should only contain letters and
numbers (no spaces, etc.), and
should not start with a numoer.
When the name has been
entered, operate the OK button.

If Dreamweaver is set up to
display anchors, as it probably
will be, a small marker will be
shown on the page at the point
the anchor was added (Figure
8.23). If it is not, the warring
message of Figure 8.24 will
appear. Operate the OK button
to remove the message wincow.
The anchor will still be added to
the page, but it will not produce
any visible result in the
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Fig.8.21 Anchors are added via
the Insert menu
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Cas_a_s.

Her j
Fig.8.22 Use this dialogue box

to name the anchor

J UllIP 1'1 jumped over the lazy dog
wintas snow.

.SECTION 5
The slow black dog fell over the lazi fox.
over the lazy dog again. The quick brown
a little lamb, its fleece was white as snow
jumped over the lazy dog. The slow black
The quick brcwn fox jumped over the lazy
fell over the lazy fox. Mary had a lirle Ian
again. The quick brown fox jumped lver tl
fleece was Wine as snow. The quick brow
dog. The slow black dog fell over the lazy

Fig.8.23 The anchor marker can
be seen here
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Fig.8.24 A warning message is given if anchor Which invisible
markers are switched off elements are

rendered visible is
controlled via the relevant page in the Preferences window. Select
Preferences from the Edit menu to bring up the Preferences window,
and then select Invisible Elements from the Category list down the left-
hand side of the screen. This produces the Prefererces page of Figure
8.25. Tick the checkbox for an element to make it visible, or remove the
tick to render it invisible. If you wish to edit the name of an anchor it
must be visible. Select its marker and the edit the name in the Properties
Inspector (Figure 8.26). Left -click on the Apply button (the anchor symbol
in this case) to make the change take effect.

Having added one anchor, add one or two more at substantially different
places in the document. It is then time to add the links to them. One

Inkrisrbie Elements

code Format
Code Frewnting
CSS Styles
Ftle Types 'lir:,

onamomon

Show l l Named Anchors

s,...npN

Comments

r Lire Breaks

r- J Client Side Image Haps

ki *I Embedded Styles

r..", I Hidden Form Fields
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r- 1 Cancel A beip

Fig.8.25 The Invisible Elements section of the Preferences window
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Nernedarsehts den* 4'

tart

Fig.8.26 The name of an anchor can be edited it the Properties
Inspector

way of doing this is to use the Point to File button in the Properties
Inspector. Select the text that will contain the link and then scroll down
to the appropriate anchor. Then drag the Point to File icon from the
Properties Inspector to the marker for the anchor and release the mouse
button (Figure 8.27). Obviously the marker must be visible for this met iod
to work. The name of the anchor will then be added into the Link textbox
of the Properties Inspector, but a hash (#) symbol will be added ahead
of the name to indicate that the link is to an anchor and not a file.

The alternative method is to select the text that will hold the link and then
type the name of the anchor into the Link textbox. Remember to add the
hash symbol ahead of the name. For example, for an anchor named
"Specifications", it is actually "#Specifications" that would be typed into
the Link textbox.
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Fig.8.27 The pointing method can be used to add a link to an anchor

155



8 Links

.; =11111111111111111111:

SI.< Ili r.\: 4

the 10w hawk fleg It II flyer the 110) Ins Miry had 8 link 1.1111, IV, tlerlr WM, while RN 41low Illt .11116.1,

brown fox lumped user the lazy doe ..cam The quo k broom toa lathed eon the lazy tkoc The ,Inor

tit black,. black dog fell ON., the lazy lox Mars had a little lank. its fleece was co hat .1..4 ,110... The quick 14'0%11
' for Licumed ON CV the lazy dog Vain Ilse Tuck brown fox jiantsed over the lazy dos, the slow black dog

the quo
tell over the lazy, lux. Miry had a little lamb. its fleece en as while as now Ile quack brown too lumped
os et the lazy dolt arm. The think brown lux jumped mace the lazy dog The low !dark dot tell ox et thew.

slow
wh Thelazy tow Mary hod a little Iamb. its fleece was white . mow 'Ilw quick brown fox jingled over the lazy
W. ,kor again The quthk brown Wallowed user the lory ring the slow Mask dog let flyer the foil lox

the lay littleMarxlade little Iamb. its fleece w. white as snow. The quick brown lox pooped over the lazy dog
Into. d' twain. The yuck brown fax iiinthed rw er the lazy dog The dow black dose till over the lazy lox Mar, N rt
the lazy had a little lamb. Its fleece was whit.: to .now the quick brown fox loathed /war Ire hay doe. swain the row,

fox pay quick b,,,,, 11 lox limped oxen the lazy dui. The slow block dog fell over the lazy f Ix M.!, 1111a A little
i 1`,7

x

lank, Us fleece wasMultle C. nowThe quick brown fox japed over the laz) do. againThe quick
t°' ,..I brown fox .1.8,1.11er! over the Ivy dog The slow black dog tell over the lay lox Mary had a little look its
the quo fleece was wt.. as now The quick brown lux toothed over the lazy doe again The gunk brown lox fell

ovet the junated over the lazy dog, The glow black dog tell oser the lazy fox Mary had .r hale lamb. its fletce wit '
"Ilan tit" ewhite os slimy The think brown Inapt/wed over the lazydog town llye quick la swo hot jumped over
was yd
slow Id

diesnow lazy dog The slow block dog fell °sc. the buy lox Mrs had d little boob. us fleece W. wInte as
-nee quick brown lox lunged user the lazy dog atom The think 140,1110, 'moped OP,en the lazy

1,7

the lazy
Iamb. IL

dog The doss black slog tell over the lazy fax. Mary had a little lamb. its fleece its. white as snow The
`r

lull,
.,mock brown ION 1111011Coi user the lox .loo omen kla otink INCOHOI I,,. ruinedDyert1tt IN, sine The

Ilia 1..) r.,,....enainai.oe sin ,T.01%I.All',111P5vebevaa... r bit C.W1SHON, coo.,
lox 111111fRIZARTMCIETTIVOTIITIliff Tire xraran runpt, Oi rr mac eatyatuo Tor IVY 1 /MIT ISIErjr1l11nrso T11,110 to
Alan: had a little longs. 115 fleece wait white as ,11.1%, The quids frown Inc limped river the la.7y doe again The quick bronco

Fig.8.28 If everything is working well, the anchor should be in the top
left-hand corner of the browser's window

Having completed the links, save the file and then test the links using a
browser. Figure 8.28 shows a link that has been tested using Internet
Explorer 5.5. The line of text containing the anchor should appear at the
top of the screen, and in this example things have gone according to
plan.

Email links
Even if you have not used the Internet very much you are likely to have
encountered Email links on web sites. In order to contact someone at

the site you click on

===111111111111111111111k.
the link and your
Email program is
launched, completeText ICunted oe at Emad ndthe,

with the correct EmailCancel I

Inerneme@sornedconnel c address already
Help

te inserted. It is a good
idea to include your

Fig.8.29 The dialogue box for Email links Email address as well
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link has caused the computer's default Email
program to be launched

as a link, but a link of this type makes it easier for most users to cortact
you.

An Email link is easy to add using Dreamweaver. Start by highlighting
the text you wish to use for the link. Next select Email Link from the
Insert menu of the document window. A small window like the one in
Figure 8.29 will then appear. The upper text box will show the text selected
as the source of the link. Tie appropriate Emai address is typed into
lower textbox, and then the OK button is operated. The text used foi the
link will be shown as a normal link, so it is up to you to make sure that it
is obvious to users that it is an Email type. If you try out an Email link in
a browser you should get something like Figure 8.30, with the Email
program launched within the browser, and the righ*. Email address already
present in the To field.

An Email link can also be acded by selecting the text to be used as the
source, and then typing the Email address into the Link textbox of the
Properties Inspector. However, the address should be preceded with
"mailto:" so that Dreamweaver knows it is an Email address rather than
a normal link. For example, "mailto:mynamegdomainname.com" would
be used instead of "myname@domainname.con".
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Fig.8.31 A link to something like a program
to download the file

Downloading
You may well have encountered web sites that have Ii iks to downloadable
files. You click on the link, and the browser enables you to download
the target file to a selected disc and folder under its original name or one
of your choosing. This type of thing is used for downloading programs,
large documents in PDF format, or just about anything in the form of a
ZIP file. A link of this type is added just like a link to an HTML page, but
the browser will respond differently because the rile will not have an
HTML extension.

Figure 8.31 shows the link to a PDF file being tested in Internet Explorer
5.5. There is the choice of opening the file or saving it to disc. In most
cases the file will be saved to disc, and choosing this option brings up a
file browser (Figure 8.32). The destination folder for the file is then
selected, and it can be renamed if required. Next the save button is
operated, and the file will gradually be downloaded and saved to disc.
Of course, if you are testing the link on a local site the download will be
almost instant. Most browsers show how things are progressing (Figure
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Fig.8.34 This Adobe PDF file is being displayed within Internet
Explorer 5.5

8.33), which is important, because real downloads have been knowr to
grind to a halt.

Once the file is downloaded the browser may be returned to normal
operation, or you might have the choice of open ng the downloaded
file. In most cases the Download window is closed and the file is checked
out later. Note that this method only works with types of file that the
browser can not handle in the normal way. If you make a link to something
like a Jpeg image file, it will be displayed in the browser as a web page.
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Fig.8.35 Linking to an MP3 music file resulted in he Windows media
Player being launched to play the file

Playing files
Links to some types of file will result in them being played or displayed
rather than saved to file. For example, if the user's PC has Adobe Acrobat
Reader installed and there is a link to a PDF file, with most browsers the
file will be displayed. Adobe Acrobat Reader augments the browser,
with an additional tool bar appearing near the tcp of the screen. -his
provides the controls available in Adobe Acrobat Reader itself. Ficure
8.34 shows a PDF file that is being displayed within Interne: Explorer
5.5.

Many multimedia files are handled in the same way, and Figure 8.35
shows an MP3 file being play.ac by the Internet Explorer 5.5 media player.
If you add links to files that need some form of p ayer or plug-in for the
browser to handle them properly, it is a good idea to include a link :o a
source of the plug-in or player
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Frames

What are they?
Frames are a feature of mary web sites these dais and they seem to be
found on most commercia sites. Using frames a web page cal be
divided into sections, with each one containing a separate HTML
document. In other words, you effectively have HTML pages within an
HTML page. A common use of this feature is to have (say) the left-hand
section of the screen devoted to a list of conterts complete with I nks,
and perhaps including a brief summary of each page. This is often
referred to as the "navigation" frame. The centre and right-hand section
of the screen is devoted to an introductory document giving deta Is of
the company, organisation, or whatever. Frames can have independent
scrollbars, so the navigatioi frame can be fixed while the introductory
document can be scrollable. This keeps the entire navigation frame
instantly accessible at all times, since scrolling down the main document
leaves the navigation links in position.

In fact some sites have this arrangement for every page in the site, so
that users always have easy access to every part of the site. The larger
frames are often called the "content" frames, because they have the
actual content of the site. With frames it is easy to produce sites based
on this arrangement, with one HTML page (the navigation page) always
visible. The reason for th.s s that links in the navigation frame can load
new documents into the content frame. If you have something like 50
pages in the site, you only have to make an initial page having the two
frames, plus 49 ordinary HT V1L documents. The 49 ordinary documents
are loaded into the content frame, as and when necessary.

This avoids having to make 50 pages with the nav gation section included
on every one of them. Of course, with frames ycu are not limited to this
basic two -page arrangement, and it is possible to have numerous frEmes
per page. However, the more complicated the arrangement the greater
the opportunity for things to go wrong, so it is best to settle for relatively
simple arrangements at first.

9
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It is only fair to point out that frames are not universally popular, and
there are plenty of good sites that are totally frame -free. One advantage
is that they are popular with users, since they can make site navigation
much simpler. Frames also make it easier to update a site. There is just
one navigation frame to update rather than having to alter what could
otherwise be dozens of pages. On the downside, frames can be
confusing if the site is not well designed, and many feel that frame based
sites are aesthetically challenged. There can also be practical problems
with frame based sites. For instance, in order to prirt out an entire page
it is normally necessary to print the frames one by one. Like any facility
of any program, frames should not be used simply because they are
there. However, you should certainly learn the basics of using them and
consider their use in web sites where appropriate.

Framesets
In order to understand the use of frames you have to understand
framesets. In the example arrangement described previously there are

trree documents
involved. The
navigation and
content documents
constitute two of
these, and the third is
tie page that
contains the two
frames into which the
other two documents
are fitted. This third
document that
contains the other
two is the frameset.
To experiment with
framesets have a
blank document
open in

Fig.9.1 Framesets are available via Dreamweaver. If
necessary, open
another document by

choosing New from the File menu of the document window. Next go to
the Modify menu and choose Frameset, which will produce a submenu
like the one in Figure 9.1.

del /Frames Atm) - Dreamweaver

Modify Text commands ante Window Help

gage Properties pdJ
aelection Properties CtdSAAtJ
Quid Tag Editor OdT

Make kink

Link Target

Table

CtdL

Split Frame Left

Spud Frame Bight

Split Frame Qp

Split Frame Down

6rronge

Align

convert

Library
Templates

Timeline

a submenu
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Fig.9.2 The result of selecting the Split Frame Left option
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Fig.9.3 The result of selecting the Split Frame Up option
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Fig.9.6 Having added a frame border, the border can be dragged to
split the frame

There are four options availaole, and Figures 9.2 and 9.3 respecively
show the result of selecting the Split Frame Left and Split Frame Up
options. The Split Frame Right option gives a result that looks the same
as Figure 9.2. Similarly, the Split Frame Down option produces a split
screen that looks the same as the one of Figure 9.3. Select one cf the
options to produce two frames in your test document. The dividing line
between the two frames can be dragged to a new position, as in Figure
9.4.

Another way of making frames is to go to the View menu, select Visual
Aids, and then choose Frame Borders from the submenu. This produces
a frame border around the page, but does not civide the page into two
frames (Figure 9.5). However, you can drag one of the borders into the
window to provide a split, as n Figure 9.6. In fast two or more of nese
drag operations can be used to split the page into four or more frames
(Figure 9.7). Drag the lines pack to the borders again in order to remove
them.
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Fig.9.7 Further dragging permits more splits in the border frame
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Fig.9.8 This submenu gives access
to preset frame structures

Quick and easy
There is a quick and easy method
of adding preset frames available
from the Insert menu. Selecting
the Frames option brings up the
submenu of Figure 9.8. This
gives seven preset frame
structures, a -id the example of
Figure 9.9 shows the Left and Top
frameset. The Split option divides
into four equal frames whatever
frame the cursor is in when the
command is issued. The same
facilities are available from the
Frames page of the objects
palette, and the icons in this
palette show the frame
arrangements that are available.
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Fig.9.9 The Left and Top frameset

The frames look different when produced using hese methods, but this
is simply because the frame borders are switched off. Changing the
frame parameters is covered later in this chapter.

Frames window
The Properties Inspector can be used to show the properties cf an
individual frame or a frameset but you have to make sure that what you
have selected and what you think you have selected are one anc the
same. It is possible to see Nhat is currently selected, and alter the
selection, using the Frames window. If this is no-. already on the screen
it can be launched by goirg to the Window menu and selecting the
Frames option. By default the Frames window is grouped with the Layers
and History windows. If this group is already on the screen, left -click on
the Frames tab to bring this window to the fore.

The Frames window shows a thumbnail version of the current document,
complete with borders for the frames. It also shows the name for each
frame, but they will all be called "(no name)" until they are named properly.

169



9 Frames

L

Fig.9.10 The Frames window

Nested frames

The frameset will probably be
selected initially, but you can
switch to any frame simply by left
clicking within its section of the
Frames window. Holding down
the Alt key and left clicking within
a frame in the design view has the
same effect. The border of the
selected window is shown wider
than the other borderlines (Figure
9.10). To switch back to the
frameset, left -click on the outer
border.

A frameset can have either columns or rows, but not both. On the face
of it this is rather limiting, but arrangements having rows and columns
can be produced using nested frames. In other words, by inserting one
frameset into another frameset. Try editing the frames of your test
document so that the page is split into two halves with a left -right
arrangement. Left -click on the left half of the design view and then from
the Modify menu select Frameset and Split Frame Up. This should give
an arrangement like the one in Figure 9.11. Next select the frame in the
bottom left-hand corner by left clicking in its area of the Frames window.
If you look at the tag selector in the bottom left-hand corner of the screen
you will notice that its reads " <frameset> <frameset> <frame > ",
indicating that the selected frame is within a frameset that is itself within
a frameset. The same is true for the frame in the top left-hand section of
the screen, but not the large frame to the right.

Saving
Saving your work is a little more complicated when using frames, and
you need to take care to save everything correctly. The normal Save
and Save As functions are not present in the File menu when the current
document uses frames. If you left -click in one of the frames to place the
text cursor there, the File menu offers Save Frame and Save Frame As
options. These save the HTML document in the appropriate frame, much
like Save and Save As when not using frames. If you select the frameset
and then go to the File menu, Save Frameset and Save Frameset As
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Fig.9.11 A simple example of nested framesets
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options are available. Again, these operate much like the normal Save
and Save As commands, but they save the HTML document that contains
the frameset.

There is also a Save All Frames Dption, which is a cuick and easy way to
save changes to any frames that have been altered since the previcus
save operation. Initially, most users prefer to select each frame and
save it under a suitable name. Suppose that the page is about rocks,
and that it is split into upper and lower frames. These could be called
"rocktop.htm" and "rockbottom.htm" respectively. The frameset could
be saved as just "rock.htm", but it is helpful to add an "f" to the beginning
or end of a frameset file to help distinguish them from ordinary HTML
documents. The frameset would therefore be saved as either "rockf.ht-n"
or "frock.htm".

This method ensures that each part of the page is saved under a suitable
name, and that none of the names are accidentally swapped over. Having
successfully saved everything *.o disc, the Save All Frames command
provides a quick and easy way of saving all the frames and the frameset.
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Naming
Returning to frames and the Properties Inspector, when used with frames
there are two versions of the Properties Inspector. The one for framesets
is shown in Figure 9.12, and the one for individual frames is shown in
Figure 9.13. In both cases the Properties Inspector must be in its

I
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Anders o :j Budet Goior
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Bader LVidVr

Yalue

Nrclm

Fig.9.12 The Properties Inspector for framesets

MR _6

expanded form in order to show all the parameters. We will consider
the frame version first. By default each frame is called "no name", and
this is not altered by saving the frame to disc. The Src textbox contains
the name of the file used for the contents of the frame, but the frame has
a separate name. This enables alternative contents to be targeted at the
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e.clers

r NoBear.s Bordir Cdor

Fig.9.13 The Properties Inspector for an individual frame

frame by a special form of link. Type an appropriate name into the
Frame Name textbox, such as "right", "bottomleft", etc., and then operate
the Apply button to make it take effect.

Borders
The menus in the top right-hand corner of the Properties Inspector control
the border colour and type. Matters are less than straightforward when
dealing with borders, since adjacent frames share a common border or
borders. Consequently, a change to the border setting of one frame
may affect the border of another. Try altering the border colour and you
will soon see what I mean. This colour control works in standard
Dreamweaver fashion incidentally. The Border menu offers three settings,
which are on, off, and default. Some designers prefer to switch off borders
or merge them into the background colour in order to make the use of
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frames less obvious. Although the appearance of the site might be
improved, hiding borders could also make things more confusing for
users.

With the default setting, borcers are switched on or off depending on
the default setting of the browser used to view the page. Note that
borders are displayed or hidden in Dreamweaver's design view
depending on the View setting used. Borders are :oggled on and off by
selecting Visual Aids from the View menu, and then selecting Frame
Borders from the sub -menu. This just controls the way in which borders
are displayed in Dreamweaver's design view. It is the border settings
that determine whether the torders are switched on or off in the
document.

Scroll and resize
The Scroll menu determines how horizontal and vertical scrollbars will
be used by the frame. These are the four options:

Yes

Scrollbars even if they are not necessary. If

they are not required, the scrollbars will still be present, but it will not be
possible to adjust them. The use of unnecessary scrollbars is not of
great importance, but it does waste screen space.

No

Scrollbars are never used for the frame, even in situations where oily
part of the contents can be displayed. This setting might have its uses,
but it could leave users with no means of viewing anything other than
the top left-hand section of the cocument. Do not use this settirg unless
you are sure you know what ycu are doing.

Auto

This is the option normally used, where scrollbars are used only when
they are actually needed. In other words, if a frame is not large enough
to display the full contents, horizontal and (or) ver.ical scrollbars will be
added so that the full content is accessible.

Default

The browser's default setting for scrollbars is used. In most cases tnis
will be the same as using the Auto setting.
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Fig.9.14 Where appropriate, scrollbars are shown in the design view

If in doubt it is best to use the Auto setting. This avoids the use of
unnecessary scrollbars, and ensures that users can access all the content
of the document. Where appropriate, Dreamweaver's design view will
display the scrollbars (Figure 9.14). There wou d have to be a very
good reason for using the No option, which could easily leave important
content inaccessible to many users.

By default the No Resize checkbox is not ticked. Users are then able to
drag the frame boundaries in the same way that they can be moved
around in the Dreamweaver document view. Ar advantage of being
able to do this is that users can minimise frames that they are not using
and thereby have more material on view in the other frames. In doing so
they will make a mess of your beautifully designed layouts, but in general
it is best not to suppress the resizing capability.

Width and height
The margin width and height sets an exclusion zole for the contents of
a frame around the frame edges. The figures entered into these textboxes
set the margin sizes in terms of pixels. By default settings of 0 and 0 are
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Fig.9.15 The margins are individually adjustable for each frame

used, enabling the content b go right out to the frame border. This is
the setting used in the bottom left-hand frame in F gure 9.15. In general,
pages look much better if a margin is used. The top left-hand frame of
Figure 9.15 uses width and height settings of 20 and 40 respectively,
while the right-hand frame les these settings at 40 and 20. A l'ttle
experimentation with the margin settings should soon produce the effect
you desire.

Frameset settings
The Properties Inspector has border controls when the frameset is
selected, and these provide a convenient way of changing to a different
set-up for all the borders. Nate though, that these settings can be
overridden by the border settings for the individual frames. There is no
name textbox in the frameset version of the Properties Inspector, but a
name for the page can be set in the usual way by selecting Page
Properties from the Modify menu. The name of the page is entered in
the Title textbox, and this is the name that will appear in the title bar at
the top of the browser when the page is displayed. If you require
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Fig.9.16 The frame background colours are indivic'ually adjustable

individual title bars for the frames, these must be added like any other
content in the frames.

Note that some of the parameters in the Page Properties window do not
have any effect when a frameset is selected. In particular, the colours
must be changed for the various frames individually. It is quite possible
to have a different background colour for each frame, as in Figure 9.16.
To change the settings for a frame, select that frame and place the text
cursor somewhere within it. The go to the Modify menu, select Page
Properties, and change the settings in the usual way.

Adding content
To add content directly to a frame, place the text cursor in the right frame
by left clicking within the frame, and then type in text, add images, etc.,
in the usual way. Things like text size, font, and colour are also edited in
the normal fashion. The contents of an HTML file can be placed in a
frame by placing the text cursor in the appropriate frame and selecting
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Fig.9.17 The Target menu of the Properties Inspector

Open In Frame from the file menu. This brings up the usual file browser
so that the desired file can be located and opened.

Targeting
Using links with frames is inevitably more complicated than using them
with ordinary HTML pages. The link leads to an internal or external
document in the normal way, but there are varicus options governing
where the new document is opened. The link to the document is made
in the usual way, and then the Target menu in the Properties Inspector
Figure 9.17) is used to determine where the linkec document is opered.
These are the first four options in the menu and the methods of displaying
the document that they select:

blank

This opens another browser window and displays the document in the
new window. The original browser window and page are left intact but
"underneath" the new browser window.

_parent

This opens the new document in the parent frameset. Where nested
framesets are not in use this means that the new document will occupy
the browser's entire window area. Where nested framesets are used,
the document will only occupy the part of the window that does not
contain any child framesets. As you will probably have gathered, in
frameset terminology the main frameset is the parent, and any smaller
framesets it contains are its children.

self
With this option the new document is opened in the frame that contains
the link. This is the default cption incidentally.
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Fig.9.18 The initial state of the demonstration frames page

_top

The new document occupies the full browser window, and replaces the
existing document in the usual way.

Additionally, the names of any frames currently on view in the document
window will be listed in the menu. This enables documents to be opened
in the desired frame, and it is a feature that is used a great deal with
frame based sites. It is an essential part of sites that use the navigation
frame and content frame arrangement. Pages selected in the navigation
frame are opened in the content frame.

Targeting a link is pretty straightforward, but it is a good idea to try out
some simply dummy sites to check that things work as expected. It is
certainly worthwhile making a dummy site that has a navigation frame
and some simple pages for the content frame. Start by making the
page having the frames, and use a simple left -right split with a narrow
frame on the left. Name the frames "leftframe" and "mainframe". In the
left-hand frame put four lines of text to use as links. It is best to keep it
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Fig.9.19 Operating the Page Two link has correctly opened that page
in the content frame

simple by using something like "Page One", "Page Two", etc. In the
large frame add some suitable text, such as "This Is Page One". Save
the document in the left frame as "navigation.htm", and the document in
the main frame as "pageona.htm". Remember to save the frameset as
well.

You now need to make three ordinary HTML pages called "pagetwo.htm".
"pagethree.htm", and "pagefojr.htm". These should respectively coitain
text saying "This Is Page Two'', "This Is Page Three", and "This Is Page
Four". Obviously you can add further content i1 you wish, but use the
text labels to make it perfectly clear which page is which. Next you need
to return to the frames pane so that the four pieces of text in the left
frame can be linked to their respective documents. Select the "Page
One" text string and use the Properties Inspector to link it to
"pageone.htm". Use the Target menu of the Properties Inspector to set
"mainframe" as the target. Repeat this process to link the three remaning
pieces of text to their respective HTML documents, and in each case set
"mainframe" as the target.
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This Is Page Three.

Fig.9.20 Use of the _top option has resulted in this page occupying
the entire window

Having saved everything to disc, the dummy site is ready for testing in
the browser. Initially you should get something like Figure 9.18. The
navigation links are displayed in the left-hand frame, and the content for
page one of the site is in the main frame. Left clicking on the "Page
Two" link should leave the left-hand frame unchanged, with the content
for page two of the site loading into the main frame (Figure 9.19).
Operating any of the links should result in the appropriate page appearing
in the main frame while the left-hand frame remains the same. Left clicking
on the link for a page that is already loaded into the main frame will
cause it to be reloaded.

You may like to return to the navigation page in Dreamweaver and try
some different target settings for some of the pages. In Figure 9.20
page three of the site has been opened via a link that has _top as the
target. It has correctly been opened to use the entire window of the
browser. The _blank target was used the target for page four of the site,
which has resulted in this page opening in a new browser window in
Figure 9.21.
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Fig.9.21 The _blank option has resulted in this page loading in a new
browser window

Frame -free
A major problem with frames when they were first introduced was that a
fair proportion of the browsers in use at the time did not support frames.
Unfortunately, without suppol for frames the cc ntent of frame paces is
not displayed. This is less of an issue these days because practically
everyone uses a browser that can handle frames. You might still prefer
to include some material that can be accessed with a browser that can
not handle frames, even if it the non -frames content is nothing more
than a message apologising for the fact that the user can not access the
site properly. This makes the situation clear to users who have a brcwser
that can not handle frames, or to visually impaired users running software
that is not fully compatible wth frames.

One solution is to have a splash page that makes it clear to users that a
frames compatible browser is needed to use the site. A splash page is
simply an initial page that gives some brief details of the site before
users enter the main pages of the site. It is only fair to point ou: that
splash pages are not universally popular with web users, and splash
pages that take a long time to download are a good way to get people
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to make an early exit
from your site. The
neater solution to the
frames problem is to
include some content
that is accessible
using any browser.
In Dreamweaver
terminology this is
called "NoFrames"
content. To add
NoFrames content go
to the Modify menu,
select the Frameset
option, and then
choose Edit
NoFrames Content
from the submenu
(F gure 9.22).
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Fig.9.23 Selecting the NoFrames Content option prcduces a blank
page. Text, etc., is loaded into this in the normal way
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Fig.9.24 The first four preset framesets from the Objects palette

The frames will disappear from the screen and will be replaced by a
window headed "NoFrames Content" (Figure 9.23). Material is added
into this window in the normal way. You can acd a simple message of
apology, or put in material to take the place of the framed ve-sion of the
site. To switch back to the normal page, go to the Modify menu and
select Frameset and Edit NoFrames Content again. Testing :his feature
is likely to be problematic, s nce any modern browser will displai the
pages with frames and ignore the alternative non -framed cortent.
Presumably it can only be done using an old browser that does not
support frames, if you can find one.

Keep it simple
It is easy to get carried away with frames, probably ending up wih an
over -complex layout that users find baffling. In general it is best to use
the simplest arrangement that will do the job. This reduces the risk of
errors when building tha site, and should make matters more
straightforward for users of the site. For most purposes the eight p-eset
frame arrangements available from the Objects palette are all tl-at is
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Fig.9.25 The lower set of four preset framesets from the Objects
palette

needed. In Figure 9.24 the screen has been split into quarters, with the
first four preset frame arrangements shown in the four sections of the
screen. Figure 9.25 follows the same basic scheme of things with the
other four preset frame arrangements. Do not forge-. that the borders of
these framesets are adjustable in the normal way, and that a frameset
can be nested within another frameset.
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Tables

Rows and columns
Tables were originally intrcduced into HTML as a means of displaying
things like scientific and financial data in tabular form. However, the use
of HTML tables has expanded beyond basic functions such as tiese,
and tables can be used for aligning images and other tasks. Therefore,
even though tables may seem to be irrelevant to the types of wei site
you will be producing, it is as well to learn something about them. They
might actually be very useful to you if used in the right way. In fact you
will probably use them a g -eat deal.

Producing a table is a two or three stage process. First the Dasic
parameters for the table are set and it is added tp the document. Where

necessary, the table is
then "fine tuned" to==.11111=.11111V.; get it exactly as

jc

Paws g - Cell Padding r required. Once any
modifications have

h Call Spacing r been completei the
Width Fr- 1Percel,:j data or otner ccntent

for the table is added.

In order to add a table
to a document, go to

Fig.10.1 The Insert Table dialogue box the Insert menu and
select the -able

option, or left -click on the table icon in the Objects palette. Eithei way,
the Insert Table window of Figure 10.1 will appear. The first thing to
decide is number of rows and columns in the table. In the example of
Figure 10.2, there are five columns and sever rows. The boxes in a
table are called cells, and there are some 35 of them in this case.

It is not essential to carefully plan the table so that it is the perfect size
right from the start. Once a :able has been insarted into a document it

Berder

OK

Cancel

Help
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Fg.10.2 A table structure having seven rows by five columns

can be freely edited using the Properties Inspector. It can also be resized
using the handle dragging method, and the cell "walls" can also be
dragged into new positions. It obviously helps if you can make an
intelligent guess about a suitable size for the table. but the table can
evolve if you get things wrong or the requirements change.

Properties Inspector
For some initial experiments with a table, increase the row and column
settings to produce a slightly larger table and then operate the OK button
to insert the table into the current document. Next the table is selected
so that it can be manipulated using the Properties Inspector. To select
the table, position the cursor over the table's outer border or a cell wall

abe ',erne Rows wI: Z.1 COr.e.d

cols d

13,

Di I,

Brds Color

Fig.10.3 The Properties Inspector with a table selected

so that the cursor changes to one consisting of a cross with arrowheads
at the end of each line. Left clicking with this cursor present will select
the table. Incidentally, the cursor will not give the desired change if it is
positioned over the left or top borderlines of the table. With the table
selected the Properties Inspector should then look something like Figure
10.3.
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Fig.10.4 The Properties Inspector with a single cell selected

To select a single cell of a table it is merely necessary to left -click within
the cell. You can select an entire row by position ng the cursor over the
left-hand borderline for the row, and the cursor will then change :o a
black arrow pointing to the right. Left clicking with this cursor showing
will select the row of cells. Similarly, to select a complete column, posrtion
the cursor over the top borderline for the row so that the cursor charges
to a black arrow pointing downward. Left clicking will then select the
complete column of cells. With a single cell selected the Properties
Inspector looks like Figure 10.4. It looks much the same with a row
selected, but a row of cells is shown in black on the Apply button. With
a column selected, a column of cells is shown in black on the Apply
button.

When it is applied to tables, many aspects of the Properties Inspector
are the same as when it is used with text and (or) images. Some of the
other parameters are fairly obvious and do not merit an explanation
here. A few are worthy of SOME amplification though. As already pointed
out, you can select the table and then use the three handles to resize it,
just like resizing an image. It is also possible to drag the wall fo- an
entire column or row of cells. If you try this you Tray soon enc up with a
table that has a lot of uneven cell spacing. This may be what you require,
but where things get out of hand the Clear Row Heights and Clear Column
Widths buttons can be used to restore uniformity. The table will probably
shrink somewhat when either of these is used, out it can be dragged
back to a more suitable size.

The Properties Inspector enables a specific height and width to be set
for the table as a whole, or for a selected row or column. If a height is
set for a single cell, that height will be used for a I the cells in the same
row. Similarly, the width settirg for a single cell will be used for all the
cells in the same column. By default the sizes are set in pixels, b_rt a
percentage option is available. Percent in this case means so many
percent of the browser winaow at its initial size. Incidentally, the table
will not be resized if the browser's window is resized.
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Fig.10.5 A table with the spacing set at 10

Padding and spacing
The cell padding parameter in the table version of the Properties Inspector
enables the contents of the cell to be kept away from the cell outline.
This is rather like the margin setting for a frame. The spacing parameter
controls the amount of space between the pairs of lines used for the cell
walls. The default spacing setting is 2. Figure 10.5 shows a table with
the value raised to 10.

Merging and splitting
Merging two or more cells into one large cell is very straightforward.
First select the cells you wish to merge by holding down the Control or
Command key and left clicking on the cells. Alternat vely, drag the cursor
across the cells you wish to select. The selected cells will then appear
highlighted, as in Figure 10.6. To merge the cells either operate the cell -
merging button in the Properties Inspector (just to the right of the Apply
button), or select Table from the Modify menu, followed by the Merge
Cells option from the submenu. The cells will then be merged, as in the
example of Figure 10.7. A complete row or column can be merged in
this way if desired. The selected cells must form a rectangle, and cell
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Fig.10.7 Here the six cells Lave been merged in one large cell

merging will not work wit ''T" shaped arrangements, "I: shaped
arrangements, etc.

A cell can be split by selecting t and then choosing Table from the Modify
menu, and Split Cell from the submenu. This produces the window of
Figure 10.8. Select rows or co umns as appropriate, and set the number
of rows or columns required. Then operate the OK button and the cell
will be split. This
command does not c=ilimr:
always provide the

Spilt Cell Into* a Bows 01.exact effect you
Crequire. In the olumns

Cancel

example of Figure jumbo, of Rows [7

10.9 the splitting of
the centre cell has Help

widened the cells
above and below at Fig_10.8 The Split Cell window
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Fig.10.9 A cell has been split, but this has caused a shift in the cell
borders
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Fig.10.10 Some manual editing has produced the desired structure

the expense of the cells in the end columns. However, a little dragging
of the cell walls will usually set things exactly as required. Figure 10.10
shows the table adjusted to give the set up I required.

Deleting and inserting
Deleting a row or column is very easy. Simply select a cell in the row or
column you wish to remove, and then select Table from the Modify menu,
followed by Delete Row or Delete Column from the submenu that
appears. A complete table can be removed by first selecting it and
choosing Cut from the Edit menu. Selecting the table and pressing the
Delete key also removes it.

To add a column, place the cursor in the column you wish to duplicate,
select Table from the Modify menu, and the select Insert Column from
the submenu. Figure 10.11 and 10.12 show "before and after" versions
of a table that has been given an extra column on the right. The table
has not been made larger to accommodate the additional column.
Instead, the existing columns have been reduced in size to make way
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Fig.10.11 The table before t,le new column was added
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Fig.10.12 The "after" versior cf the table, with an added column
on the right

for the new column. If this is not what is required, the table can of
course be resized. A row can oe added
Place the cursor in the
row that must be
duplicated and then
select Insert Row from
the Table submenu.

It is possible to add
more than one row or
column at once. Go
to the Modify menu,
select Table, and then
select Insert Rows or

using the same basic method.

Insem Rows or Columns

Insert a por
r columns

butrzer of Rows.

Where r Above the Selecton

a Below the Se{ecton ljelp

. xi

r OK

c.c.,

Fig."0.13 The dialogue box for adding
multiple rows or columns
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Fig.10.14 The top cell in this table is used as a header cell

Columns from the submenu. This produces the window of Figure 10.13.
Use the two radio buttons at the top to select rows or columns, set the
number to be added, and then use the lower radio buttons to choose
where on the table they will be added. Operate the OK button and the
new rows or columns will be added to the table. Do not forget that the
number of columns and rows in a simple table can be altered by editing
the Row and Column figures in the Properties Inspector. The complete
frame must be selected in order to do this, and not just a cell or group of
cells.

Header cell
Tables often have a single large cell to take a label that states exactly
what the table is for. This cell is usually at the top, but it can be placed
elsewhere if desired. A cell of this type is called a "header" cell. Where
appropriate, merge several cells to produce a single cell of adequate
size to take the legend that will be used in the cell. To designate the cell
as a header type, left -click in it and then tick the Header checkbox in the
expanded version of the Properties Inspector. Any text added into the
header cell will be in bold type and will have centre alignment (Figure
10.14). The exact way in which the text is displayed in a browser will
vary somewhat from one browser to another, but it will normally be
centred and fairly prominent.
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Untitled Document (Frames/Tables.html - Dreamwenver

Etle Edit View insert Modify :ext commends site window Help

!,It -11- !Title Untiiied Document Ct. 0. 4'ro

This Is The Header Cell

This cell uses the No Wrap Option;

This cell does not use the No
Wrap option so word wrapping
has been used

Fig.10.15 Cells that do and do not use the No Wrap option

No Wrap
With one or several cells selected, the Properties Inspector has a No
Wrap checkbox. By default This is left uncheckec, and text entered .nto
the cell then has the usual ward -wrap function, like text typed into a
document in the normal manner. With the No Wrap option selected, text
is not wrapped at all, and is all placed on one line unless it contains any
carriage returns. Figure 10.-5 shows some text added to twc cells of a
table. The text in the top left-hand cell has been added with the No
Wrap option enabled, and the text is all on one I, ne. This cell, and the
others in its column, has autcmatically widened to accommodate the
text. The text in the cell below was added without the No Wrap op:ion
selected, and the text has wrapped to fit the existing width of the cell.
Because there is more than one line of text the height of the cell, and the
others in its row, has been aLtcmatically increased to accomrrodate the
extra lines.

The No Wrap setting can be altered after a cell nas been given some
content. Simply select the oell or cells you wish to change and hen
alter the Word Wrap setting in the Properties Inspector. This may cause
some changes to the cell and the existing arrangement of text. In Figure
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Untitled Document (Frames/Tables him") - Dreamwenver

rile Ldlt View Insert Modify Iext Qornmands Site Aindow1p
.2.ff. I Title:rtilnetled Document

This Is The Header Cell
This cell uses the No Wrap
Pption
This cell does not use the No
Wrap option so word wrapping
has been used

r

1

Fig.10.16 Changing the No Wrap option can cause changes to any
text in the cell

10.16 the table used in the previous example has had the No Wrap
option removed from the top left-hand cell, which has resulted in a slight
narrowing of that column. As a result of this, the line of text in the cell
has word -wrapped onto the next line. The Drea-nweaver WYSIWYG
design view does a good job of showing things as they will look when
viewed using a browser, but as always, results should always be checked
using a browser or two. In this case (Figure 10.17) there is a slight
difference in the upper cell as viewed using Internet Explorer 5.5, but
nothing too drastic has happened.

Full-size tables
Tables can be a small part of the page or they can be set at the full -page
width and used to hold all the contents of a page. Remember that cells
can be as large as you require, and that they can contain images and
other objects in addition to text. Laying out a number of images neatly
on a page is a common use of tables. In order to use a table as a full
page, select the table and then set the width to 100 percent in the
Properties Inspector. To make sure that the table also fills browser
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a Untitled Document - Microsoft Intc.rnet Explorer

rile adit View Favorites Tools Help

+0 Search Favorites ,,,History

I Address IcjC \Frames \TMP81xen8Ilip.htm

This Is The Header Cell
This cell uses the No
Wrap Option

This cell does not use the
No Wrap option so word
wrapping has been used

Fig.10.17 The table looks mush the same when viewed in a browser

windows vertically, repeat Mis process with the height setting. Figure
10.18 shows the same table as the one shown in Figure 10.16, but is has
been stretched to fill the browser window. The text in the header cell
has also been enlarged.

Adding content
Adding, text, images, etc., to a cell in a table is much like adding the
same objects straight onto the page. Once in a cell, the content can be
edited in the usual fashion as well. By dragging on its cell borders an
image can be positioned at the desired point on the page, with text
being added around it (Figure 10.19). It is not possible to switch off the
cell borders, but making them the same colour as the background, as in
Figure 10.20 can effectively eliminate them. The title at the top of the
page is in a header cell, and its borders are still visible, but none cf the
other borderlines are visible. Remember that the border colour for each
cell can be set independent y. Select the cell anc then change its border
colour using the Properties Inspector. Figure 10.21 shows three cells
with the borders made visible, and the others (apart from the header
cell) hidden from view.
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This Is The Header Cell
This cell uses the No Wrap Option

This cell does not use the No Wrap option so
word wrupping bus been used

Fig.10.18 Here the table has been expanded to fill the page

?Cio Links

Incidentally, if you use the table method to lay out a page, this does not
prevent a "proper" table being used on that page. I: is possible to have

a table in a table cell.
Simply place the
cursor in the cell

English Fishing Ports where the table is
required. Then
select Table from the
Insert menu, put the
appropriate settings

.ale mom ma in the Insert Table
window, and operate
the OK button. The
table will then appear
in the selected cell,
as in Figure 10.22. It

Fig.10.19 A table used to position an image
seems to be possible
to have a table within
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Fig.10.20 The page viewed using a browser

a table, within a table, although this probably has limited practical
applications.

Layout view
The table method of
laying out pages is
better suited to some
types of page that it
is to others. Within
reason, practically
any layout could
probably be
produced using this
method, but with
many layouts a lot of
splitting, merging,

r  r- . 4111t1t, .111:

English Fishing Ports

lb.. or r woo id, Wu Os Nr

a ham el Cotl m
nrid

Fig.10.21 The borders can be shown or hidden
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Fig.10.22 A table can be placed within a table cell

and other editing is needed to produce the required layout. Dreamweaver
4 has an alternative method of producing table layouts that makes life a
lot easier when dealing with arrangements that are not easily achieved
using conventional tables. This feature is not availat le in earlier versions
of Dreamweaver incidentally. The two buttons at th?, very bottom of the
Objects palette are used to switch between Standard view and Layout
view (Figure 10.23). When switched to layout view, the two buttons
above are used to switch between drawing a layout table and a layout
cell.

What makes the Layout view different to the Standard view? With the
Layout view you can draw cells straight onto the screen and then fill
them with text, images, tables, or whatever. A layout table is used to
hold the layout cells. To experiment with layout cells, first select the
Layout mode by operating the appropriate button in the Objects palette.
Next operate the Draw Layout Cell button in the Objects palette, and
draw a cell somewhere on the screen. To draw a cell position the pointer
at one corner of the required cell, hold down the left mouse button,
move the pointer to the opposite corner of the cell, and then release the
mouse button. In other words a rectangle is dragged onto the screen,
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Draw layout cell

Standard view

44111

__Layout ,

D I D Draw layout tab e

Layout view

Fig.10.23 The four control buttons at the bottom of the Objects pa'ette

and you should end up with something like Figure 10.24. A layout table
has been made automatically, and the new cell las been added tc it. If

you require the layout table to occupy less that the full page, operate

ntrilegl n..,,,., 11 Oreewortmre

t t.

.bed, mar m.m

Fig.10.24 A layout table and cell added to a page
10-.1-1 341, of a 0
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the Draw Layout
Table button and
draw the table outline
before adding layout
cells to the screen.

To add more cells,
operate the Draw
Layout Cell button
and draw another
cell, operate the
button and draw a

Fig.10.25 A layout cell can be resized using third cell, and so on

the eight handles until all the required
cells have been
added to the table.

Dragging one of its borders to a new position will move the entire cell to
a new location. This does not resize the cell, but instead moves the
whole thing to a new position. To resize a cell, first lett-click on its outline
to select it. This produces eight handles on the outline (Figure 10.25),
and these can be dragged to resize the cell.

JiiJ T
Vogl. 0.1c

VS. O. I

More Fishing Villages
Ibis tranquil -retie ,vti
phottairaphed in the middle
of cum.ar at a local sea trIc

.ion The anginal is
41041 colour image AI .1
resolution of 2440 by I, 0.
pixels. but it has been
convened to a prey stale
unatte in Adobe PhotoShop
5 0 weld reduced in size

tttr Propeniex Inspector
was used to action Ihr sic,
of the cell so that it was a
precise ft for the digital
phobia:Taub, which is in
jpeo for,.

.V. an u ItxW

Fig.10.26 Blocks of text and an image added using layout cells
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Fig.10.27 The page viewed using a browser. Ths matches the
Dreamweaver WYSIWYG display quite accurately

Figure 10.26 shows three layout cells added to the screen with some
dummy content in each cell. The layout has been deliberately made a
bit haphazard to emphasise the point that with this method you can
easily add cells that do not conform to a regular table structure. Figure
10.27 shows the page viewed using Internet Explorer 5.5, and it matches
the Dreamweaver layout very accurately. The cell guide markers are not
shown in the Internet Explorer version of course, but in other respects
everything is very much where and as it should be.

Autostretch
The Properties Inspector can be used to examine and control E..ome

settings of a layout cell. With the Properties Irspector on the sc-een,
left -click on the outline of the layout cell and the Properties Inspector
should then look like Figure 10.28. Most of this is the same as for an
ordinary table cell, but there is one additional property in the form of an
Autostretch facility. To use the Properties Inspector for the layout table,
left -click on a blank area of the table or on its outline to select it. The
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Fig.10.28 The layout cell version of the Properties Inspector

Properties Inspector should then look something like Figure 10.29. Again
this is all fairly straightforward apart from the Autostretch option.

Normally the width parameter is set as a specific number, such as 250
pixels. With Autostretch the width automatically resizes to suit the size
of the window in which it is displayed. The usual width figure in the
appropriate box of the Properties Inspector is then replaced with a wavy

Leal Tabs Wrath a fend Lel ted

r howl, er. r Eg 13P FFFFF

Fig.10.29 The layout table version of the Properties Inspector

line. All the cells in the same column will be affected by selecting the
Autostretch option, and only one column per page can use this facility.
If you set a column to Autostretch operation, any coiumn that is already
in this mode will be switched back to normal fixed width operation.

A typical use of Autostretch would be with a page having a menu bar
down the left-hand side of the screen and the main content on the right.
The menu cell would be set at a fixed width in pixels to ensure that it
always had sufficient space to display the menu correctly. The right-
hand cell would be Autostretched so that it made full use of whatever
window space was left. A real -world layout would probably be much
more complex than this, with other elements that needed to be at a fixed
size or automatically adjust to suit the window. However, this very basic
example demonstrates the difference between the two types of sizing.

When the Autostretch option is selected for the first time in a site, the
window of Figure 10.30 will appear. The radio buttons offer these three
options:
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Choose Spacer Image

V
In order to make an aucistretch column. Dreamweerver
needs to put spacer images in the other columns
What would you like aeernweaver to do?

a. Create a spacer image file

Use an existing spacer image file

Don't use spacer images for autostretch tables

You can change these options later in Preferences > Layout View

deep

Tables 10

2.11

Cancel I

Fig.10.30 This window may appear when the Autostretch option
is selected

Create a spacer image file
Empty cells can have a tendency to collapse rather than retaining their
set size. The standard ploy to avoid this is to fill such cells with a srr all
GIF image that is transparent. Because of the image's transparent
property the cell looks exactly tie same as if it were empty. The image
is stretched to fill the cell so that it prevents it from shrinking when the
page is viewed using a browser. Incidentally, this method is often used
with troublesome cells in conventional tables. Non -breaking spaces
are sometimes used as a simple if less neat alterrative.

Use an existing spacer image file

This option can be used if there is already a suitable spacer image file
for Dreamweaver to use.

Don't use spacer images for Autostretch tables
With this option no spacer image is used. A waning message will be
produced, explaining tha: without the spacer image the cells may
collapse.

The easy and safe option is tp accept the default setting, which will get
Dreamweaver to create and use a spacer file. When the file browser
appears, accept the default file name and operate the OK button.

To try out the Autostretch op:icn, make a page having a narrow layout
cell on the left and a wider cell on the right. Add some words to form a
dummy menu in the left-hand cell. One way to set the width of :he
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Make Column Autostretch

narrow cell is to select it and then
edit the value in the Properties

Add Spacer image Inspector. A little trial and error
should soon locate a figure that
gives a sJitable width. The
alternative is to set a ridiculously
low value, which will produce an
error message stating that the

Fig.10.31 The pop-up column menu selected width is too narrow.
Operate the OK button and
Dreamwearer will then substitute

the narrowest width setting that will accommodate the contents of the
cell. This will not always give the desired result, but it usually works well
with something simple like a menu.

The right-hand cell can be set to Autostretch mode via the Properties
Inspector, or via the pop-up column menu. In order to bring up this
menu, left -click on the width figure at the top of the right-hand column
(Figure 10.31). Select the Make Column Autostretch option. The width
figure at the top of the column should change to a wavy line to indicate
that the Autostretch option is in operation.

Meer Cell Heights
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Fig.10.32 No text is lost off the right-hand
side of the window

Now add some
dummy content into
the right-hand cell
and save the
document. Use the
orowser preview
'acility to view the
page, and try varying
:he width of the
window. Compare
:he dummy page of
Figure 10.32 with the
wider version shown
in Figure 10.33. In

Figure 10.32 there is
no material that can
not be seen because
it is beyond the right-
hand limit of the
window. Similarly, in
Figure 10.33 there is
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Fig.10.34 1 -Ye effect of switching off the Autostret.::h option is clearly
apparent he -e
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no empty space down the right-hand side of the window. As the window
is made wider or narrower, the content of the Autostretched cell is
reformatted to suit the new shape. Compare Figure 10.34, where the
Autostretch option has been switched off, with Figure 10.33. The narrow
and fixed page width is wasting screen space in F gure 10.34, but not in
Figure 10.33 where the Autostretch facility is in use.

The Autostretch option is not appropriate to all types of material, and in
some cases the reformatting could produce some rather poor results,
with the automatic reformatting spoiling a careful y prepared layout. It

generally works well with a cell that only contains text, or is predominantly
filled with text.

Table to layers
Using layers is covered in the next chapter, so it is a subject we will not
consider in detail here. Suffice it to say that layers enable precise
placement of objects within a page, but they require a relatively recent
browser such as Netscape 4 or Internet Explorer 4, or later versions of

either. Dreamweaver
can convert a normal
table into a group of
layers, and the first
step is to select the
table. Then select
Convert from the

Fig.10.35 The Table to Layers dialogue box
Modify menu, and
Tables To Layers from
the submenu that

appears. This should produce the window of Figure 10.35, offering four
options via checkboxes. If you wish to make some preliminary
experiments with layers, accept the default settings and operate the OK
button to convert the table to layers.

You should end up with something that does not look too far removed
from the original table. There will be a grid of lines on the screen (Figure
10.36), but these can be toggled off by going to the View menu and
selecting Grid, and then choosing Show Grid from the submenu. The
grid lines are only an aid to laying out pages anyway, and they will not
appear when the page is viewed using a browser. The Layers window
will be activated, and it will give details of the new layers generated by
the conversion process. If you try viewing a converted table using a
suitable browser you should find that it accurately matches the version
seen in Dreamweaver's design view (Figure 10.37).

Convert Tables to Layers

Layout Tools P Legerkre:ventla-CW.erlap;,1

P Show Layer Palette

P Show cold

rj Snap To Crud

.2_1(

Ok

Cancel

Help
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Fig.10.36 A table that has been converted to layers
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Fig.10.37 The converted table viewed using a browser
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Fig.10.38 The Format Table dialogue box

Preset format

1

There are a number of preset formats that can be applied to tables, and
these control things like colours, alignment, and the cell borders. The
preset formats enable a data table to be almost instantly formatted to

give attractive and
readable results. To
format a table, start
by placing the text
cursor somewhere
within the table and
then select the
Format Table option
from the Commands
menu. This brings
up a window like the
one in Figure 10.38.
The preset formats

Fig.10.39 A table based on a preset format are listed in the menu

Lie tan yew 1,sert Modify born 5ornmentts Site Vendor, fjelp

0) ca.tt,

Results For 200012001

Jan . Feb 31.8 2-0 20.8 31.4

Mar. Apr 56.7 67 3 61.9 23.8

MayiJane 76.0 78.2 72.9 56.9

July/Aug 56.8 23.7 45.8 86.9

SepiOct 45.8 56.9 29.0 81.0

Nov/Dec 30.8 19.4 62.9 59.1
TT:Iffefte .
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Import Table Data

Data File
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Fig.10.40 The Import Table Data dialogue box

OK I

Cancel

Help

at the top left-hand corne cf the window, and the dummy table to the
right of this shows the colour scheme, etc., fry the selected format.
Operate the Apply button to apply the format to your table so that you
can see exactly what it will look like in the design view.

You are not forced to accept the preset values, and a number
parameters can be edited in the lower section of the window. Figure
10.39 shows a table produced using a preset format, edited enlarge
the border width but otherw se unchanged.

Import/export
If you already have the data for a table it will probably be possible to
import it into Dreamweaver -a*.her than having to type it all in again. In

order to bring the data into Dreamweaver it must be saved in text format
from the spreadsheet or otter program used to originate the data. To
import data select the table, go to the File menu and then select Import.
Next select Import Tabular Data from the submenu, and the dialogue
box of Figure 10.40 will appear. The name of the data file is typed into
the Data File text box, or the file can be selected using the Browse button
and the file browser. The delimiter must be spec fied, and this will cften
be a tab character, but an alternative can be selected.

To export data select the table containing the data, and then go to the
File menu and select the Export option. Next select the Export Table
option from the submenu which will produce the dialogue box of Figure
10.41. If necessary, alter the delimiter, and make sure that tie correct
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operating system is chosen in the lower menu. Operating the Export
button will bring up the usual file browser, which is used to name the

new file and save it in
the appropriate
folder.

Export Table

Delimiter r
Line Breaks

Export I

Cancel

Being realistic about
matters, it will

Help probably take some
experimentation in
order to get theFig.10.41 The Export Table dialogue box import and export
functions working as

desired. However, with a little trial and error this sor. of thing can usually
be made to perform satisfactorily.
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Layers

Adding a layer
Layers enable the precise placement of objects on a web page without
the need for complex tables. One slight problem Nith layers is that older
browsers cannot handle them. With more and more people switching
to modern browsers this is a diminishing problem, but provided one or
two restrictions are met, Dreamweaver can convert layers into tables if
required. Adding a layer is very simple, and one method is to select
Layer from the Insert menu. This will insert a box to represent the iew
layer, and it will be added at the current cursor position.

For most purposes the better way of adding a layer is to operate the
Draw Layer button on the Common page of the Objects palette. This is
the third button down on the left-hand side. You can then drag a rectangle
onto the design view where the new layer is required (Figure 11.1). Note
that it is only possible to draw layers in standard view, and that this
facility is disabled in layout view.

The newly added layer can be moved around by dragging the tab it the
top left-hand corner, or by dragging anywhere on its outline. It is best to
use the tab, as otherwise it is very easy to accidentally select the contents
of a layer rather than the layer itself. The crossed -arrows pointer will
appear when the layer can be dragged. Left clicking when this pointer
is present selects the layer. When a layer is created, an invisib e element
marker is added to the page. Jnless this type of marker is switchec off,
you can hardly miss the arrive of this yellow marker on the screen. Left
clicking the marker is another way of selecting the layer.

Once selected, eight handler appear on the layers outline (Figure 11.2).
These can be dragged to resize the layer. The pointer changes to a
single line with arrowheads at each end when it is correctly in pos tion
over one of the handles. If they are not already active, select Layers and
Properties from the Window menu to bring up the Layers window and
the Properties Inspector (Figure 11.3). The Layers window (Figure 11.4)
will show the selected layer h,ghlighted. In this case there is only one

211



11 Layers

I..

.4.11111111MC.41-7-.," _ " !t1
te LtNr

Fig.11.1 A layer drawn onto the screen via the Objects palette
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Fig.11.2 Eight handles appear on the layer when it is selected
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Fig.11.3 The Layers window shows the new layer, and the Properties
Inspector shows its settings

layer, so this is the only one shown. By default the layers are called
"Layer1", "Layer2", etc., but you can rename a layer by double clicKing
on its name in the Layers window and then editing the text.

Well stacked
The right-hand column in the
window is labelled "Z", and with
only one layer there will only be a
"1" in this column. When us ng
tables it is not possible to have
overlaps, but layers live up to their
name and they can be stacked
one on top of the other. Layers
have X and Y dimensions that
determine their size, and a Z
dimension that gives their
position in the stack. The laver
having a Z value of 1 is the bottom

2JC

.; iistory[::,)Leyers Frames

F.; P -event Overlain

Name e

Fig.11.4 The Layers window
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y.. Fine*.

Fig.11.5 Layers live up to their name and can overlap

layer, the one having a Z value of 2 is the next ,ayer up, and so on. The
top layer is the one having the highest Z index value.

If you are experienced with graphics programs you should already be
familiar with layers in one guise or another, but do not worry if you have
not encountered them before. The concept is very easy to grasp. Try
drawing some more layers on to the screen, and see if you can get them
to overlap. This will not be possible unless the tick is removed from the
Prevent Overlaps checkbox in the Layers window. If you will need to
convert layers to tables it is advisable to leave this box ticked. Tables
can not accommodate overlaps, so layers can only be converted to
tables if there are no overlaps present.

Unless overlapping layers are used, the Z value is not usually of great
importance. If you intend to stack layers then it is clearly of great
importance, and the final appearance of the page can be changed
radically by altering the Z values. Figures 11.5 and 11.6 show the same
page but with the Z values of the two layers first set one way around and
then reversed. One way of altering the Z values is to drag the name of a
layer up or down in the Layers window. The layers are always listed with
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Fiig.11.6 Here the Z index values of the two photographs have been
swapped

the highest number at the top, going in reverse o -der down to the lowest
number at the bottom of the list. This is logical, s nce the one having the
highest value is the top layer when the page is viewed using a browser.

You may get some strange renumbering if you use this methcd of
manipulating Z values. You may find that you end up with something
like values of 2 to 5 instead of 1 to 4. This does not really matter, bu7 use
the alternative method or renumbering if you would prefer to avoid this,
or would like to correct it.

The alternative method is 70 edit the Z index value in the Properties
Inspector, having selected te layer first (Figure 11.7). It has to be pointed
out that a selected layer and its contents will be shown on top of any
other layers in the design view. However, this does not affect the way

..j
Lai., ID ' Z-iricie, El.,i,.^..r _J 2.

I , -It F.: ,..-x R:ii ir

oT 117 ---A Theirilirir - ---...- Clip l R

T e

Fig.11.7 The layers version og the Properties Inspector
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Fig.11.8 One layer can exist totally inside another

the layers will be displayed in a browser. The one t-aving the highest Z
value will always be on top, the next highest will be one lower in the
stack, and so on. One slight oddity is that you can give two or more
layers the same Z value. If the numbering is left to Dreamweaver it will
give each layer its own Z value, but you can edit the values so that some
or all are the same. This is perfectly valid in HTML code. If two layers
have the same Z index value, the one that appears first in the HTML
code has precedence, but it is better to make sure that stacked layers
have unique Z values.

Nested Layers
There is no restriction that says one layer can not exist totally within
another layer. In the example of Figure 11.8 the photograph is in the
original layer. The caption was placed into a second layer that was
drawn outside the first one. The required background colour was set
using the Properties Inspector and then the caption layer was dragged
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into position. Of course the
Prevent Overlaps checkbox in the
Layers window must not be
ticked when doing this type of
thing.

It is also possible to have layers
within layers, or nested layers as
they are termed. When the parent
layer is moved, the child aver
moves with it. This does not
happen if you simply position cne
layer over another, as in the
example of Figure 11.8. In order
to nest existing layers go to the
Layers window, and then drag the
name of the child layer over the
name of the parent layer while
holding down the Control key.
Figures 11.9 and 11.10 show The
Layers window before and after
an operation of this type. In

Figure 11,10 the child layer is
indented to make it clear that it is
a child of the parent layer above.

2g

i LaYes 111=31= ; o

r Prevent Overlaps

At Name 2

Fig.11.9 The Layers window with
twD normal layers listed

11.LAaversIA Frarnesi., H3toryI -! 10

r Reverie Overlaps

at] Name 2

When nesting layers some
shifting of their positions may
occur, but this can be corrected
by dragging them back into Fig.11.10 The Layers window
suitable positions. When using showing that tne twc
layers it can be difficult to select layers have been nested
the one that is required. The most
reliable method is to select tie required layer by left clicking on its name
in the Layers window. A layer can be un-nestec by dragging its name
away from the parent name it the Layers window.

Visibility
When using large numbers of layers it can sometimes be easier to work
with one or more of the layers switched off. This renders the layer and
all its contents invisible in tie Dreamweaver design view. The setting
used in the first column of the Layers window controls the visibility of
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layers. There are three options

LayersLaFramesit> listoryl available, and all three are shown

Prevent Overlaps in Figure 11.11. With the closedr
I Wm: eye icon the relevant layer is

Layers i switched off, and with the open
Caption

= eye icon it is switched on. With
picsi neither present the layer is

switched on or off depending on
the visibility setting of the parent
layer. If there is no parent layer,
the document itself becomes the
effective parent. Since the

Fig.11.11 The layers window document is always visible, with
showing the three no parent layer this setting is
visibility options effectively the same as having the

layer switched on. Repeatedly left
clicking in the visibility column cycles through the three settings. To
select the one that is required just keep left clicking until it appears.

It is important to note that the visibility setting does not only affect the
way a layer is displayed in Dreamweaver's design view. If a layer is
switched off in the Layers window, it will not appear when the page is
viewed using a browser. In Figure 11.12 the caption layer is still present,

but it is still switched
off. Consequently, it
has failed to appear
when the page is
viewed using a

browser. If you
switch any layers off,
i: is clearly essential
to switch them back
on again before
uploading the page

,Ire.r

Fig.11.12 The caption layer is still present. but
it has been switched off

to the server.
Incidentally, left
clicking on the eye
icon at the head of
the visibility column
will switch on all the
layers.
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Content
Content is added to a layer in much the same way as it is added direct to
a page or into a table cell, etc. Most types of content are permissible,
including text, images, tables, and forms. The one major exception is
that frames are not permitted within a layer. To add content to a layer,
start by left clicking within its perimeter to place the text cursor within the
layer, and then add text, images, or whatever in the usual fashion.

Layer properties
Some of the parameters in t-ie layers version of tne Properties Inspector
are straightforward, but a few require some explanation. The four Clip
settings enable a clipping area to be defined. 'f you try adding some
content to a layer you will scon notice that the size you set initially is
regarded as no more than a starting point, with the layer outlines
expanding to fit whatever you put in them. In this respect they are like
cells in a table, but unlike cells a clipping area can be set. In other
words, you do not have to cisplay (say) a complete image even though
the layer expands to accommodate the image. An image can be cropped
to the required size using a suitable graphics program, or the clipping
area can be used to provide the same effect.

The figures used in the Clip boxes control the amount you wish to clip,
and the unit of measurement s pixels. However if you need to remove
a 50 pixel wide strip from the bottom of an image it is no use specifying
a B figure of 50. The clipping system operates in a slightly less than
obvious fashion with measurements that are relative the top left-hand
corner of the layer. In the example of Figure 11.13, nothing had t3 be
clipped from the top of the photograph, so a T value of 0 was used. If 20
pixels had to be removed, :hen a figure of 20 would have been used.
Matters are equally simple with the clipping on the left-hand side. It was
necessary to clip 30 pixels, so an L value of 30 was used.

The R setting is not an amount in from the right-hand side, but is instead
the distance from the left -hale side of the layer tc the right-hand edge of
the visible picture area. A value of 600 was foLnd to give the desired
effect, with about 60 pixels being clipped from the right-hand side of the
picture. Similarly, the B value does not directly set the amount that is
clipped from the bottom of the photograph. It sets the depth of the
visible part of the photograph, but also includes any clipped section
along the top. In this example a setting of 380 gave the desired effect. It

results in about 100 pixels oeing clipped at the bottom of the picture.
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Fig.11.13 The picture on the left has been clipped on three sides

Fig.11.14 The frame borders are not visible in normal viewing

220



Layers 11

E. E* es
*6  i1 3 2 *sm. S.

.440,4c

1211110.?" -'4+

0.300. Al Or COWAN
- _

Fig.11.15 The darkened background is not visib'e around the
picture on the left. It is hidden by the clipped area of the
photograph

The layer remains the same size incidentally, and clipping the picture
governs how much of it is visible, not the size of the layer. The outline of
the layer is not visible when the page is viewed in a browser (Figure
11.14), and all the viewer sees is the non -clipped part of the image.

If you need to make an image smaller without any clipping, it is just a
matter of selecting the image and resizing it in the normal way. This has
been done with the right-hand image in Figures 11.13 and 11.14. In

Figure 11.15 a darker background has been added to both layers. As
one would expect, this background is visible in the unoccupied part of
the layer on the right-hand side. The background is not visible around
the edges of the left-hand image because it is effectively covered by the
image even where the imace is clipped.

Size and position
The L (left) and T (top) parameters set the position of the layer relative to
the top left-hand corner of the page. In the case of a nested layer, these
values set the position relative to the top left-hand corner of the parent
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Untitled Document (Frames/Untitled-51- Drenmwenver

File Edit View Insert Modify Text commends Site Window Ije1p

Title. Untitled Document Ott. 02.

ere is too 'IA text to fit into
his layer so an overflow has
occurred. There is too much text
o fit into this layer so an

overflow has occurred. There is
oo much text to fit into this layer

so an overflow has occurred.
sere is too much text to fit into

iis layer so an overflow has
occurred.

Fig.11.16 The test layer as it appears in Dreamweaver's design view

layer. The W (width) and H (height) values set the width and height of
the layer. In many cases it is easier to set these by moving and resizing
the layer onscreen, but the ability to set these values in the Properties
Inspector can be useful when very precise sizing and positioning is
required.

Overflow
The overflow setting governs how excess content will be treated if the
layer is too small to display the entire simultaneously. When content is
added to a layer it expands to suit, but the dimensions of the layer can
be reduced using the Properties Inspector. In Figure 11.16 the height of
the layer has been reduced, but this produces no visible effect. However,
when the page is viewed using a browser (Figure 11.17) the reduced
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gi Untitled Document - Microsoft Internet Explorer

File edit View Fgvontes Tools Help

).7,:e.5rch _igavorites History

Address

There is too much text to fit
into this layer so an overflow
has occurred. There is ton

Fig.11.17 The test layer with the Scroll option selected

height of the layer is
apparent. In this
example the Scroll
option has been
selected from the
Overflow menu in the
Properties Inspector,
and scrollbars have
been produced so
that all the content
of the frame is
accessible.

In Figure 11.18 the
Visible setting has
been used, and the
full content of the
layer has therefore
been displayed by

L UNION Cleassent nficrosoft Internet reptorer

F,011.

Addles: :e'

1,1-

'wrens 41+stoni

There is too much text to fat into
this layer so an overflow has
occurred There is too much text
to fit into this layer so an
overflow has occurred. There is
too much text to fit into this layer
so an overflow has occurred.
There is too much text to fit into
this layer so an overflow has
occurred.

Fig.11 18 The test layer using Visible setting
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this layer so an overflow has
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Fig.11.19 The Hidden setting can result in
some content becoming
inaccessible
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tie browser. The
width and height
values set using the
Properties Inspector
r'ave been
cverridden by the
browser so that the
full content has been
made visible. The
Hidden setting is
used in Figure 11.19,
and the excess
content is hidden
from view. Not only
is it hidden from view,
but also there is no
way for the user to
access it. This option
should only be used

there is a good
reason for doing so.

Finally, in Figure
11.20 the Auto option
has been used. With
the Auto setting a
scrollbar will only beThere is too much text to fit

into this layer so an overflow used if it is needed.
has occurred. There is too this case a verticalds tun, in fit min tb.. -7.1

scrollbar is needed,
but there is no need
hr a horizontal type.
Consequently only
tie vertical scrollbar
is included.

Fig.11.20 With the Auto settings scrollbars Compare this with
are only used if they are necessary tne Scroll version of

Figure 11.17, where
a horizontal scrollbar has also been included even though it serves no
useful purpose.
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Preferences
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Highlighting
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Site
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Fig.11.21 The layer defaults are set in this section of the Preferences
window

Layer preferences
When a layer is added via the Insert menu a default layer is added a: the
current cursor position. Sorne of the characteristics of a default layer
can be adjusted by way of the ,.ayers section of the Preferences window.
Select Preferences from the Edit menu to launch the window, and 'hen
left -click on Layers in the Category menu down the left side of the window.
This will give the window of Figure 11.21. Apart from the size settings,
the defaults set using the Preferences window will also be used for lagers
added using the Objects palette.

The Tag menu gives four tag options for layers, but simply leave this at
the DIV setting unless there is a good reason to do otherwise The next
five options set things like tie size and backgrcund colour, and these
operate in the same way as their equivalents in the Properties Inspector.
A background image can be added, and this operates in much the same
way as adding a background image to a page. The background image
will be tiled if it is too small to fill the layer, or clipped if it is too large.
With the Nesting checkbox ticked, a new layer will be automatically nested
if it is created within another layer.
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When selected, the final option results in a resizing fix being added so
that the layers operate properly with Netscape Navigator 4 and later.
Without this fix layers might shift out of position when the size of the
window is adjusted.

Layers to table
In the previous chapter the subject of converting tables to layers was
covered briefly. Dreamweaver can make the opposite conversion
provided none of the layers on the page overlap. To make this conversion

select the Convert
option from the
Modify menu, andable Layout a t.loci6c.buratt;01then choose the

r images! Collapse Empty Cells
Cancel Layers to TableLess elan r--- Pmels Wide

option from thew Denspereni GIFs

r Ceniet on Page submenu. This will
produce the Convert

Layout Toots r enoveni Leryart Over,e4.
Layers To Table

r Show Leye, Pelelte

r shoe Clad dialogue box (Figure
t

r Snap Tt: Gnd Heir, 1.22). It is likely that
everything will be

Fig.11.22 The Convert Layers to Table converted properly if
dialogue box you simply accept all

the default settings,
operate the OK button, and proceed with the conversion. Figure 11.23
shows a simple layout using three layers, and Figure 11.24 shows the
result of the conversion to a table. The layout was reproduced accurately
when viewed using a browser (Figure 11.25). These layout options are
available:

Most Accurate

By default the Most Accurate checkbox is ticked, and this results in every
layer being converted into a table cell, and any other cells that are needed
are then added around them. This does not necessarily give the simplest
conversion, but the table should mimic the layers as accurately as
possible.

Smallest
With this option, rather than putting in very narrow columns or rows only
a few pixels high, Dreamweaver adjusts the layer boundaries to align
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Fig.11.24 The table structure produced by the conversion
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Fig.11.25 The converted layout shows good accuracy when viewed
using Internet Explorer

them. This simplifies the table layout, but obviously accuracy will be
lost to some extent. The minimum acceptable cell width and height
have to be specified. The higher the number used the greater the loss
of accuracy that can result.

Figure 11.26 shows a layout produced using layers, and it has been
designed to avoid having everything neatly aligned. In fact it has been
designed to have things almost aligned but not quite. Figure 11.27
shows the result of letting Dreamweaver make compromises during the
conversion. The design has been closed up slightly in addition to some
aligning of layer boundaries. It would presumably be possible to use
this feature to tidy up a slightly haphazard design.

Use Transparent GIFs

As pointed out previously, transparent GIF image files can be used to fill
otherwise empty cells to prevent them from collapsing and probably
ruining the layout.
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Fig.11.27 The simplified layout produced by the conversion
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Centre on Page

By default the completed table is left aligned. If this option is selected
the new table will be centred on the page instead.

Layers clearly provide a neat way of accurately placing practically any
type of content on a page, and you need to become reasonably fluent in
this aspect of Dreamweaver. It is certainly worthwhile spending some
time experimenting with layouts based on layers. Remember that most
layouts designed using layers can be converted to tables so that they
are compatible with older browsers. Make sure overlapping layers are
avoided if you intend to convert them to a table.
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Forms and
Flash

Form problems
Forms are undoubtedly a very useful component for web pages. They
can be used to collect various types of user input, permitting two-way
communications between a site owner and the users. Dreamweaver
makes it easy to add forms to a page, and then add radio buttons, text
boxes, menus, etc., to the forms.

Unfortunately, adding forms to pages using Dreamweaver is one thing,
and actually getting those forms to do anything useful is quite another.
In order to use information from a form it is necessary to have a proc ram
to transfer the information tc a database on the server. With free or very
low cost server space this may not be possible, out most rented server
space comes complete with a range of facilities to support this type of
thing.

However, it is a subject that goes beyond the scope of this book. If you
need to use forms to gather information from site users it will be necessary
to learn some programming, or to learn how to use the "off the slelf"
scripts that are available on the Internet. Alternatively, you can hire
someone to properly integrate your web site with the server. You also
need to make sure that the server you use supports the facilities you are
trying to implement and the methods of implementation you interd to
use.

Here we will only consider the use of forms to provide jump menus. A
jump menu is a pop -down menu that enables the user to go to a selected
page in the site. An ordinary menu can be made by having a list of
words on the page, with ea: -.1- word linked to the relevant site. A jjmp
menu provides a more compact alternative and is often preferred w-iere
links to a large number of pages are required.
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Adding a form
A form is added by placing the cursor at the point in the page where the
form is required and then selecting Form from the Insert menu.
Alternatively, operate the Insert Form button in the Forms page of the
Objects palette. If the warning message of Figure 12.1 appears, forms

are switched off in the

r=11.1111111111111.1far 1.41
Invisible Elements
section of the

see ma element Ln es s View > Vsud Adds)
Elements Is dseciked and the PretellaCe Solar) lot Preferences window.

las elernert .>
This can be corrected
by selecting
Preferences from the
Edit menu, and then
selecting the Invisible

Fig.12.1 A warning message is issued if Elements category in
form outlines are switched off the Preferences

window (Figure 12.2).
Make sure the Form Delimiter checkbox is ticked arid then operate the
OK button. With the form added to the page you should have something
like Figure 12.3, with a broken red line representing the outline of the
form.

r Omit show me Mrs message again

Prelereaces

T F rr.

Panel>
Prewar NI Browser
aura, Teg Edam
See
Status Bar

Itmskie Elements

Show Si U Named Anchors
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Fig.12.2 Make sure that the Form Delimiter checkbox is ticked
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Fig.12.3 The newly added form is visible at the top of the page

If it is active, the Properties Inspector will show the form's properties.
Left clicking on its outline will select a form, incidentally. With a form
selected the Properties Inspector will only show three parameters.. I

would not worry too mucl about these for the moment, but you will
probably wish to change the default name to something more
appropriate.

Ordinary objects such as text tables and images can be added to a
form, as well as the objects that are designed specifically for use in
forms. You will find nine of these on the Forms section of the Objects
palette. In most cases it will he necessary to add text so that users of the
form know exactly what they are supposed to do. Remember that what
is obvious to you will probably be far from obvious to someone visi-ing
the site for the first time.

Try adding some text and an image to a form. The form starts out at the
full page width but only one I ne of text high. However, as you add more
objects to a form it expands to take the new material. If a narrower form
is required, simply make a table cell of the required size and put the
form into it. Altering the background colour of the cell can effectively
change the background colour of the form.
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1 Title unlined Document
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Cats are well known for always being
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even at night!

Fig.12.4 Ordinary content can be used in a form
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Fig. 12.5 The form as it appears in a browser
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Figure 12.4 helps to illustrate these points. The form has been pla:L'ed
inside a layout cell, and it has been expanded verically by adding some
text and a small bitmap image. The backgrounc colour of the cell has
been changed to mid -grey. 01 course, the various guide lines in Fic ure
12.4, including the red outline of the form, do not appear when the page
is viewed using a browser (Figure 12.5).

Jump menu
A jump menu is a good place to start when using forms because no
scripting or other programming is needed to make it work. It is not used
to obtain information from users and store it on a server. A jump menu
simply provides a means of moving to one of several pages listed in a
menu. To try out a jump menu, make a small layout cell and add a form
in it. Next place some text at the top of the form and press the Return
key to move down to the nex-. Now add the jump menu by operating
the appropriate button in the Objects palette, or by selecting Form Objects
from the Insert menu, and then choosing Jump Menu from the submenu
that appears. This will produce the dialogue box of Figure 12.6.

The first task is to add the list of menu items and the link for each one.
There is a default entry, and This is edited to produce the first entry ir the
menu. The Text field is the text that will be displayed for that item ir the
menu. Edit this to the text you require and then left -click on the enty in
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Untitled Document (Frames/Forms4 htm") - Dreamweaver

Eile Edit !few Insert Modify Text commands Site Vindow Help

41=.1
Title I Intitled Dorurnent tt. 10. I C-* Z?

Please choose a book

'Vertically challenged women/Jr

Fg.12.7 A jump menu added in a form, which has in turn been added
to a layout table cell

the Menu Items list. The text here should change to match the text you
have just put into the Text field. Next left -click on the Browse button and
choose a file for the menu item to link to. This operates in the same
fashion as choosing a normal link, for the very good reason that it is a
normal link. Now operate the + button to add a new menu item, edit the
text field, left -click on the new entry in the Menu Items list to change the
text there, and select the URL for the new entry. Repeat this process a
few times until you have added all the entries you require.

When you have finished adding entries operate the OK button, and the
main screen should then show the form complete with the newly added
menu (Figure 12.7). The pop -down menu will not operate in the
Dreamweaver document view, so you must use the browser preview
facility to try out the menu. Placing the cursor on the downward facing
arrowhead should activate the menu (Figure 12.8). and left clicking on
an entry should switch the browser to the appropriate page in the site.
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41) Done
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Fig.12.8 The expanded version of the jump menu

Go
In the Insert Jump Menu window there is a checkoox that enaples a Go
button to be added to the menu. With the standard version of the menu
it is not necessary to press a
button to confirm your selec:icn.
Left clicking on an entry
immediately moves the browser
to the linked page. With the Go
button added (Figure 12.9) left
clicking on an entry closes the
menu and the selected item is
displayed in the menu's textoox.
Left clicking the Go button
activates the link and moves tie
browser to the selected page. An Fig.12.9 The menu plus Go button
advantage of the Go button is that
it gives the user a chance to change their mind, or to reselect the page
if they make a mistake the first time.

Choose one of these books

Lady Lovellies chatter

La
The bit shee

Lovellies chatter

How green was my valet
Done with the wind
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' .

Fig.12.10 The jump menu version of the Properties Inspector

The Open URLs in menu will only offer one option unless you are using
frames. This is the Main Window option, which means that the linked
page will replace the existing page in the current browser window. If

frames are in use, the names of the frames will appear in the menu.
With one of these selected the linked page will be opened in the selected
frame.

Menu editing
The Properties Inspector permits a limited amount of editing on a jump
menu after it has been added to a form. To select a jump menu simply
left -click on any part of it. The Properties Inspector should then look
something like Figure 12.10. The name of the menu can be edited in
the textbox at the left end of the window. The item to be shown initially
can be selected from the list of menu entries. Usually the item at the top
of the menu is the one that is displayed before the menu is expanded,
but this facility enables a different entry to be selected if desired.

Operating the List Values button brings up the dialogue box of Figure
12.11. This enables the existing entries to be edited. The + and -
buttons permit entries to be added or removed. There is no file browser
facility available from this window, so any URLs have to be added or
changed by editing the text for their entries in the list.

133=MMOMMINW
Lt1

I ValueItem Label

-.keep

How green was my valet
Done with the wind

PageOne htm
PageTwo htm
PageThree htm
PageFour htm rS

OK -1

Cancel

Help I

Fig.12.11 The List Values dialogue box

adv Lovellies cher.
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The two radio buttons in the
Properties Inspector give the
option of using a menu or a list.
Using the default settings there is
actually no difference between a
menu and a list. However with
the list option selected the Height
textbox becomes active (Figure
12.12). In this case the height
setting is the number of items that
will be shown in the list. If this
number is less than the actual
number of items in the list, you
get a sort of cross between a list
and a menu. With eight items in
the menu and a height setting of
four, four items would be
displayed at once, but the others
could be displayed by scrolling
the list up and down. In Figure

Type r hpnu U4401

1...1 Selechcne I- Allow makide

Irvbally Se/laded
Th tit

.....__. . . .

Fig.12.12 Setting the height of a list

Choose one of these books

The big sheep
How green wes my valet
Done with the wind

Fig.12.13 A simple list having
four items

tr Buion More

&At

Labil Go -o Action r Buyre fwm

r epee mem

Fig.12.14 The Properties Inspector for the Go button

12.13 there are four items in the
menu, and a height setting of 4
has been used so that all four are
visible at once, and a true list has
been produced.

If you left -click on the Go button
the Properties Inspector will show
its parameters, as in Figure 12 14. Go To Pagel
The Label textbox enables the
lettering on the button to be
changed. The button will be Fig.12.15 The Go button with
enlarged if a longer text string is added text

Choose one of these books

The big sheep
How green was my valet
Done with the wind
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Fig.12.16 The Insert Flash Text dialogue box
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Cancel
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used, as in the example of Figure 12.15. There was too little space for
the enlarged button in its original position, so it has been moved onto
the next line.

Flash text
As many readers will be aware, Flash is a graphics and animation
program produced by Macromedia. In order to prcduce sophisticated
Flash graphics and animations you have to buy the program, but basic
Flash text and buttons can be produced using Dreamweaver. You do
not need to have Flash installed on your computer in order to add these
objects using Dreamweaver 4, but note that earlier versions of
Dreamweaver do not support this function.

Flash text has a few advantages over normal HTML text. Perhaps the
most important is that it is possible to use any TrueType font that is
installed on your computer. Furthermore, anyone viewing the text does
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not need to have that font installed on his or her computer. Another
important factor is that Flash text can handle larger sizes than no-mal
HTML text. A further advantage is that anti-aliasing can be used or the
text. This feature helps to give smooth edges to text, giving a rr uch
neater appearance. This can work on most sizes of text, but it is

particularly effective with large sizes that can otherwise literally look a
little rough at the edges. Flash text can also be made to change colour
when the pointer is placed over it, giving a simp e rollover effect.

To add Flash text select Interactive Images from the Insert menu, and
then select the Flash Text option from the submenu that appears.
Alternatively, operate
the Flash Text button
in the Common page
of the Objects palette. plane save Me current docurnsnt nefore crewing nee tee umect

Either way, the
dialogue box of or I
Figure 12.16 will
appear. If an error Fig.12.17 An error message appears if the
message appears current page nas not been saved
instead (Figure
12.17), the current page has not been saved yet. If this happers, operate
the OK button, save the current document, and then try again.

The required text is typed into the Text textbox, and multi -line text can be
used. The Font menu is used to choose the required font from the
compatible types, and the required size is typed into the Size textoox.
In this case the text size is ii point sizes incidentally. If the Show Font
checkbox is ticked, the text you type into the Text field will be shown in
the correct font, but not at the correct size.

You can see what the text will look like by operating the Apply bu-ton.
The text will then appear in the main document window at the correct
position (Figure 12.18). You can keep making changes to the text and
settings, operating the Apply button each time to check its appearance.
If the rollover effect is required, choose a rollover colour from the
appropriate menu. Simply leave this blank if ordinary text is required.

Most of the other settings are fairly straightforward, and are the type of
thing that has been covered previously. One exception is the Save As
field. Unlike ordinary HTML. text, the Flash text is saved to disc as a
Flash movie file having a "swf" extension. You can use the default name
or choose something more appropriate if preferred. When the text is
exactly as required operate the OK button and it will be added intc the
document. Incidentally, if you use the Apply button, the Flash tear will
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This Is Some Flash Text!
c=immemesvour.,
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Fig.12.18 The Apply to be previewed in the

document window

not be erased from the document if you change your mind and exit from
the dialogue box using the Cancel button. However, the text is easily
removed by selecting it and pressing the Delete key or selecting Cut
from the Edit menu.

Flash Properties
With the Flash text selected the Properties Inspector can be used to
show its properties and edit them. For Flash text the Properties Inspector
will look like Figure 12.19. If the rollover effect was selected, one way of
testing it is to view the page in a browser. The quicker alternative is to
operate the Play button on the Properties Inspector. Positioning the

FIcall Ter ,-"' " Fde II I,' r .. ' ._...r I EA'

Lb) ogn lEIrc.,ser :eau.' --"E 1,12 r ,.... F...2:_i

ID Y SI.c. Wally I'll ..- r- rr, j

H -p.f: 5 " 7 '',' 7i -J._

Fig.12.19 The Properties Inspector for Flash Text
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1. Untitled Document (Frame3rlasti2 htm") - Dreamweever

File Edit View insert hod ty Text .ommiands age Window beir

9j I Title Untitled Document tt. go. I c <? .

This is some flash text

Fig.12.20 The Flash text in its normal guise

Untitled Document (FramesjFlash2 him) - Dreamweever

File Edit view Insert Mode./ Text Qommends Zne window help

Title Untitled Docqrrent tt. 41). C ,1.7>

Fig.12.21 The Flash text in its alternative colour scheme. The
background colour foes not change incidentally

pointer over the text should then produce the rollover effect in
Dreamweaver's design view. Figures 12.20 and 12.21 show "before
and after" views of a Flash text -ollover. The Play button in the Properties
Inspector will change to a StDp button, and operating this will switch off
the rollover effect.

It is possible to resize the text using the three handles that appear w-ien
the text is selected, or by ed ting the W (width) and H (height) values in
the Properties Inspector. Using either method it s possible to produce
enormous text (Figure 12.22). Operating the Reset Size button in the
Properties Inspector returns st-etched or compressed text to its original
size. Operating the Edit button brings back the Insert Flash Text dialogue
box so that the text and its parameters can be changed.
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Fig.12.22 It is possible to produce enormous text in a wide range of
styles using Flash text

Flash buttons
Dreamweaver comes complete with a number of Flash buttons in a variety
of styles. The buttons can be used for navigation menus, and they give
a more professional looking result than simple having words on the
screen that are used as the sources for the links. Flash buttons can be
added using the Objects palette, or by selecting Interactive Images from
the Insert menu and then Flash Button from the submenu that appears.
Either way, the Insert Flash Button dialogue box (Figure 12.23) will appear.

The first task is to choose the required button from the Style menu. The
Sample box shows the appearance of selected buttons, so it is quick
and easy to go through the buttons looking for something suitable for
your requirements. Placing the pointer over the Sample button will show
the change that will occur when the real thing is used, as will left clicking
on it. Typically, the button appears to light up when the pointer is placed
over it, and it gets even brighter when it is left clicked.

Operating the Get More Styles button will connect the computer to the
appropriate page of the Macromedia web site where more designs are
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Fig.12.23 The Insert Flash Btit!on dialogue box

available. Of course, this will only work if your PC has an active
connection to the Internet at the time, so where necessary activate the
Internet connection before trying this option.

By default buttons are not marked with any text, and for most applications
a suitable label must be entered into the Button Text textbox. Note that
some buttons are marked with symbols and that no text can be used on
these. The Size textbox enables the size of the lettering to be set in
point sizes. In practice it is not possible to use large sizes as they will
not fit on the button. Operating the Apply button enables you to seethe
button in place on the page (Figure 12.24). The rest of the dia ogue box
is pretty straightforward. arid is the same as for Flash text. When a
suitable button has been selected, together with the desired settings,
operate the OK button.
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Fig.12.25 An outsize Flash button

When selected, the
button has three
handles that enable
its size and aspect
atio to be adjusted.
Dragging the button
:o a suitably large
size can produce an
outsize button
;Figure 12.25). If a
Dutton with large text
is required, use small
:ext that will fit onto
the button initially,
and then stretch the
Dutton and text to the
-equired size. This
avoids having the
:ext bursting out of
:he button.
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Fig.12.26 The version of the Properties Inspector for Flash buttons

The Properties Inspector for a Flash button is much the same as the one
for Flash text (Figure 12.26). To test the button in Dreamweaver, first
operate the play button on the Properties Inspector. Then place the
pointer over the button and also left -click on the button to check that the
correct changes are producec .

Behaviours
Behaviour modification enables objects on a web page, or the web page
itself, to do clever things with the aid of JavaScript programs. This is a
fairly involved subject, and here we will only consider the use of
behaviours to play a sound file when the mouse pointer is placed over
an image. In this example the image is of a robin, and the sounc file
contains the song of a robin.

You can obviously try the same general scheme of things using any
image file in a standard web format and any sound file that is reasonably
small (about 20 to 80 kilobytes). For test purposes it is preferable bit by
no means essential for the sou -id to be an appropriate one for the image.
If you do not have a suitable sound file there are plenty of them available
on the Internet. In fact there are probably a large lumber of short sound
files already on your computer, because the operating system and
probably other programs use teem. The search facilities of the operating
system should be able to locate a WAV file that can be copied to the
local site you are using for test purposes.

There are three parts to an action added using behaviours. First there
must be an object that is used to trigger the action. In this example it is
an image, but practically any object including the page itself can be
used as the source. Next sorr ething must happen to trigger the action,
which in this instance is the mouse pointer being positioned over the
image. Other methods of triggering include the object being loaded
onto the page, the object being left clicked or double-clicked, etc. Firally,
there is the action itself, and -sere we are playing a sound. There are
other possibilities, such as a message being displayed on the screen or
an image being swapped for aiother one. The options available depend
to some extent on the object used as the source of the action.
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Fig.12.28 The Actions menu

Adding behaviours
Start by adding the source object
to the web page and then making
sure it is selected. Next select
Behaviours from the Windows
menu, or operate the Behaviours
button in the Launcher or Mini
Launcher. Whichever method
you use the Behaviours window
of Figure 12.27 will appear.
Operate the + button to produce
a pop-up menu giving a list of the
available actions that can be
applied to the object (Figure
12.28).

In this case we wish to play a
sound, so it is the Play Sound
option that is chosen. This will
produce the dialogue box of
Figure 12.29, and the filename for
the sound file can be typed into
the textbox or it can be selected
via the Browse button and the
usual file browser. Once this has
been completed the OK button is
operated. The screen should
then look something like Figure
12.30, with a new entry in the
Behaviours window. The
behaviours marker should be
visible to the right of the image.

If you wish to delete an entry in
the Behaviours window, simply
select it and operate the - button.
In order to edit an entry it should
first be selected. The entry in the
Events column might be one you
require, but it will probably have
to be altered Left clicking on the
arrowhead between the Events
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and Action columns produces a menu of available events. The nurr ber
of options depends on the browser compatibility selected.

To change this compatibility, move the pointer down to the bottom entry
in the menu (Show Events For) (Figure 12.31). This produces a subrnenu
with various browser
options. If you 21.1

require compatibility
with older browsers
the list of available

Cana

events will be quite
I

short. Opting for Fig.12.29 This dialogue oox is used to
compatibility with just
one recent browser

specify the sound file

gives a much greater
range to choose from. Choosing the 4.0 and Later Browsers option is a
good compromise that gives a good range of events to choose f-om
while giving compatibility with most of the browsers currently in use.
The On Mouse Over event is tie one we require to run the sound file.

t.:J.

MI= .
_J _J_J

Fig.12.30 A new entry has appeared in the Behaviours window anc the
behaviours marker can be seen next to the image
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Fig.12.31 The browser compatibility
submen LI
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When viewed using a browser the
test page looked like Figure
12.32. A lot of sites that have
clever features leave users "in the
dark" about accessing them. It

is best to g ve some onscreen
instructions, as in this example,
or users might leave the site
without discovering the clever
features. Obviously it is not
possible to see from the screen
dump that the sound file played
successfully (which it did), but
you can see that the pointer has
changed from the normal arrow
to a hand, showing that the image
is not a passive part of the page.

You might like to try
experimenting with some of the
other events and actions. Note

Move the potnter over the ithotog,mph to hear the robot nog'

Fig.12.32 The page as viewed using a browser

_:J
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Fig.12.33 A popup message produced by left clicking on the
robin image

that it is not necessary to remove one entry in the Behaviours windcw in
order to add another one. Several behaviours can be assigned to a
single object. In the version of the page shown in Figure 12.33 a Pc pup
Message action has
been used in
conjunction with an
On Click event. The
message box is
primarily to provide a
warning message
when an On Error
event occurs, but it Fig.12.34 The dialogue oox for adding the

can be used for other popup message
purposes. When this
option is selected a dialogue box like the one in Figure 12.34 appears.
Simply type the required message into the textbox and then operate the
OK button. The Set Text action is another simple one to experiment
with. It can be used to display a message in the status bar when the
appropriate event occurs.

===1111111111111116:
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Style sheets

Cascading what?
Cascading style sheets, or jest CSS as this system is better known,
enable designers to define the appearance of text in a more flexible
fashion than is possible wits standard HTML. As the style part of the
name implies, a style is imposed on the selected text. Normally if al the
links on a page needed to be in bold text, each link would have to be
manually changed to a bold setting. Using the style method the link tag
would be modified to include the bold setting so that all the I nks it the
page would be automatically set to bold text.

If you did not like the look of the finished page it would not be necessary
to change each individual link back to normal. The link tag would be
altered and all the links would tien return to normal. Using Dreamweaver
it is not necessary to get deeply involved with the code in order to use
styles and style sheets, and everything can be handled using t -le
dialogue boxes, etc.

It has to be pointed out that style sheets are relatively new and only
work with newer versions of browsers. Microsoft Internet Explorer 4 and
later or Netscape 4 and later are suitable. Once again, it is sometiing
that is gaining in popularity as the older browsers fall out of use, bu it is
still not safe to assume that all browsers will work properly with style
sheets.

Types
Matters are slightly confused by the fact that there are four different types
of style sheet. The simplest variety is the type described previously,
where an HTML tag is modified so that is has additional properties. With
this type of style sheet, or just plain style as it is better described, the tag
gains new properties, but the original ones are retained. in our link
example, it may have other properties added, but it will always remain a
link. This is adequate for many purposes, but does limit the possibilities.

253



13 Style sheets

jCSS St111114=11xl
J HTI4 CSS Styles ? I r.1
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The second type of style is
termed a "class", and you use it
to name and define a new style.
Once defined, the new style can
be applied to text in standard
fashion. Select the text and then
apply the style by name, much as
you would set the font or put the
text in Italics. Using the new style
it is possible to set the font,
colour, and other aspects of
formatting in one operation.

Fig.13.1 The CSS Styles window The third and fourth style types
are the imported and linked
varieties. In doth cases the style

is defined by creating a separate document, and both the redefining
and class types can be included. These are true sty e sheets rather than
just styles, because you generate documents (the style sheets) that
defines the styles. Having created a style sheet, the styles it contains
can be applied to several or even all the pages in a site.

Style creation
To create a new style launch the CSS Styles window by using one of the
launchers, or choosing CSS Styles from the Window menu. This should
produce something like Figure 13.1. The main area of the window lists
the defined styles, but as no styles have been defined at this stage it will

simply say "none".
Next launch the New
Style window by

i-o-Kj CS'S 9,4 es k) Behi ? I t1
selecting New Style

X
("

°"`
)

from the pop -out
menu (Figure 13.2),

6Pply or by operating the
appropriate button at

New Style the bottom of the
Edit Style Sheet window. This is the

1.7 4111.t-11 J Attach Style Sheet
second button from
tie left in the row of

Fig.13.2 The popup menu of the CSS four buttons. Either

Styles window way, the dialogue
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box of Figure 13.3 xj
should appear.

IMMOOperate the Redefine
HTML Tag radio .. Make Custom Style (chess) Cancel I

button in the top r Bedehne HTML Tag

section of the C tjse CSS Selector

window, and the This Nene In. a INP.W;7,;iP ch e V! 1,

Document Only This Document Only Help I

radio button in the
bottom section of the Fia.13.3 The New Style aialogue box
window. Next select
a tag from the menu
(Figure 13.4) or type a tag name into the text box. At this stage do not
worry too much about the functions of the various tags. For iritial
experiment one of the heading style tags will do, such as the h6 tag.

Operate the OK button and the style definition dialogue box will appear
(Figure 13.5). There are plenty of settings to choose from on the first
section of this dialogue box, but several other categories available from
the list on the left. In this respect it operates in a manner that is very
much like the Preferences window. For an initial experiment, stick with
the initial category and make some changes to the font, size, colour,
etc. When you have finished making the changes operate the OK buton.

Now place some text on the screen, select it, and apply the new style to
it. In this case the h6 tag has been altered, sc Paragraph Format is
selected from the Text menu followed by Heading 6 from the submenu.
Figure 13.6 shows some text in the new style, plus some text in heading
styles 1 and 5. Heading style 6 was originally the smallest heading
style, but the new version is actually bigger than heading style 1. The

other changes made
to the style such as
the strikethrough and =0011111111111111111116M::::'

colour changes are
also readily
apparent.

will notice that the
Styles window you

you look at the CSS

new style is not
listed. However, it
will be listed in the
Edit Style Sheet Fig.13.4 The New Style tag menu

Tag:

Typo:

Defeo In.

ID,

co,
code

cen

d'''
dl

---!i

01( I

Cancel

dt
ern
hl
hZ

h3

Help
I

:..I

255



13 Style sheets

Style definition for Sonny

niegory

Hackgroun.i
Doti.
Box
Border
1151

Positioning
E .tensions

Type

Eard I

aim I I

Sbrle -
Line Height

E e :oration r ynderline

r *gyerline

r line -through

'tint
IT none

 indisares styles not currently displayed in Drearnore ever

Aw4,gh,
-y e 'lent I

otor 117,11 I

t.74 Apply HeIU

Fig.13.5 The Style Definition window is used to set the required
parameters. This is one of eight pages

This test is in paragraph style H1

This ten, Is tti par avFaph .,,Ir

Fig.13.6 The new Heading 6 style (top) plus the standard Heading 1
and 5 styles below
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dialogue box. Select
CSS Styles from the
Text menu, and then
Edit Style Sheet from
the submenu, and
this dialogue box will
appear (Figure 13.7).
The main panel lists
the existing styles
that have been
defined, which in this
case is just "h6". If

you select this style
its settings will be
shown in the Style
Definition panel. If

you operate the Edit
button the Style
Definition window
will appear so that

Slyl definition

no style rule selected

[tone 1

Lnk

New

1-elp I

Fig.13.7 The new style is listed in the Edit
Style Sheet window

Efi
Yr..* b.'

This text is in paragraph st:s le ti

Dm ten Is lo parsgr Mph st,le 115

Fig.13.8 Deleting a style remcves any formatting it provided
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the settings can be altered. The style can be dele-.ed by operating the
Remove button, but this will cause any text formatted with the new style
to return to normal (Figure 13.8).

Style class
To create a new style class, start by launching the Edit Style Sheet
dialogue box, which is accessed via the popup menu of the CSS window.
Operate the New button and the New Style dialogue box will appear.

Using the upper set

==111111.1111111111rs.r xof three radio
buttons select the

Nome e .te 01 Make Custom Style
Type ri Mel,* Cpstom sye (class) Cancel j class) option, and

r- Redefine I-ITML Tog in the lower
r Use CSS Selector

L< set select This
Document Only. A

 Th,s Document Only Help
name for the new
style must be typed

Define In rt.?. .4 F

Fig.13.9 Setting up and naming a new class

Edit Styte Sheet

into the textbox at the
top of the window.
Use lower case
letters with no
spaces or other

Link I punctuation marks.
'eou should then

New have something like

Edit
Figure 13.9. Left -
click the OK button

Duplicate
I

to continue.

Remove

Style definition

newstyle {font -family Georgia. "Times New Roman".
Times. sent, tont-size 36pix font -style normal.
line -height normal. tont-weight bold. color #FF0000,
text -decoration none background -color. #CCCOCC.

Done I Help I

Fig.13.10 The new class shown in the
Edit Style Sheet window

This brings up the
Style definition
window (refer back
to Figure 13.5). Next
go through the eight
pages of parameters
selecting the ones
that you wish to
apply to the new
style. The functions
of most of the
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settings on the first page are fairly obvious, and the more obscure cnes
on the later pages are most y optional. Quickly go through the pages
adding in the main parameters
and operate the OK button when
you have finished, This takes you
back to the Edit Style Sheet '?10
window, which should now show
the new class selected in the main

newinors ,PI

panel at the top of the windcw,
and the selected characteristics
in the panel beneath this (Figure
13.10).

Operate the Done button tc exit
the Edit Style Sheet window and
then look at the CSS window. efalAtti
The newly defined class should Fig.13.11 The new class in the
now be listed in this window CSS Styles window
(Figure 13.11). Try typing a line
of text into the document window, then with the text cursor still on the
same line as the new text, select the new style in the CSS window. The

Untitled Document (Untitled -11- Dreemweever

E le Echt Yiew Insert Modrty Tan commends bite t/md3w delp

2.4:41j TIde: Untitled L.cii:,,rneri .10. (7)

his is some text in the newstyle style;
L

Fig.13.12 Some text that has oeen formatted usiig the new class

text should then take on the characteristics of the new class, as in the
example of Figure 13.12. -ry selecting the "none" option ii the :SS
window. This should set the text back to its original settings.

Linked and imported
The styles described so far are strictly for use with the current page. If

you try making a new class in the manner described previously and
then move to another page the new class will disappear from the
window when the new page is opened. Return tD the original page and
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=111111111111111111111111111111111iiit
File/URL

Add As a Link

r import

Browse. OK

Cancel

Help

Fig.13.13 The linked style sheet must be given a filename

the new class will appear again. The new class is effectively part of
page, and is not available to other pages even if they are in the same
site. This is also true of redefined tags. In some cases this may be all
that you require, but often a style will be needed in several or even all
the pages in a site. This can be achieved using imported or linked style
sheets, which differ in the way that the new style is applied to pages.

To produce an imported or linked style sheet, start by launching the Edit
Style Sheet window in the normal way and then operate the Link button.
This produces the window of Figure 13.13 where the new style sheet
must be given a filename. The name used should conform to the normal
file naming conventions and should be given

===11111111M.,
hnksrylel CSS (link)

Stile definition

no style rule selected

r
f few

Done I Help j

Fig.13.14 The Edit Style Sheet window lists
the new style sheet

X 1-

a CSS extension (e.g.
Stylel5.CSS). Use
the radio buttons to
select either a linked
or imported style
sheet. Linking is the
more tried and
tested method
incidentally, and is
the one that we will
use here. Operate
the OK button to
return to the Edit
Style Sheet window,
where the new style
sheet should now be
listed (Figure 13.14).

This produces a new
style sheet, but as
Viings stand it does
not contain any
styles. In order to
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save and use a style al=1.1111111111111.111Mr..
sheet it must contain
at least one style. Do,

Left -click on the entry
for the new style New.

sheet to select it, and
then operate the
Edit button. This
produces the new
window of Figure
13.15. Left -click on
the new button to Style definition

no Wle rule selectedbring up what is
more or less the
same New Style
window that we have
encountered
previously in this
chapter. One Fig.13.15 The style sheet has been created
difference is that the
This Document Only
option is not available (Figure 13.16), and it is c.early inappropriate in
this case. In other respects pings are much the same as they were
before, and a new style is defined in standard fashion.

Redefine one of the heading tags and it will then appear in the window
for the new style sheet (Figure 13.17). The Save button is now enab ed,
but before saving the file ope-a*.e the New button and define a new class.
Operating the Save button w II move things back to the New Style St- eet
window. Left -click the Done button to return to the document, which will
then be linked to the
newly created style
sheet. C=1:111.111111111L 2_11

Save Cancel I Help j

As a first step in using
the new style sheet,
put a line of text or a
paragraph into the
document and format
it in the new version of
the heading style.
Then add another line
or paragraph, and

but does not contain any styles

Name I unna,er

-type. ideke Custom Style ( Aess)

r gedetine HTML Teg

r Use CSS Selector

or 1

Detne In a

Help

Fig.13.16 The New Style window for the
style sheet
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1M=I I I I I I I I I I I
1111111111111111111111111111111111111.1111

x

Link

New

Edit

Duplicate

Remove

Style definition

h6 { font -size. 36pt font -style italic line -height normal
font -weight bold, color. #666666, text -decoration
underline}

s Cancel Help

Fig.13.17 The redefined tag listed in the
style sheet's window

INiaded, CA* (F mossilmeddCBEr) - 0/...Wreyef
Jf s,, DM.

with the text cursor
still within that block
of text select the new
class from the CSS
Styles window. Both
sets of text should
then reflect the new
formatting, as in
Figure 13.18. So far
this is nothing more
than could be
achieved by simply
redefining a tag or
creating a new class.
The next step is to
use the new style
sheet with another
document, so go to
the File menu and
select New to create

This text is in the redefined Heading 6 (16) style, which is
contained in the new sit ie sheet.

Eg0101111111

Fig.13.18 Some text formatted using the new style sheet
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File/URL

Add As r- Link

Import

Browse

Cancel

Help

Fig.13.19 Specifying the style sheet that will be Inked to the page

a new document. The newly created class will then disappear from the
CSS Styles window, and text formatted using the redefined heading tag
will have the normal heading style.

In order to use the style sheet with the new document the style sheet
must be linked to the document. Go to the pooup menu of the CSS
Styles window and select the Edit Style Sheet option. Next operate the
Link button to bring
up the new window E=E:211.11111111t
of Figure 13.19. The
name of the style tnl.st el 1:,SS link L riF

sheet's file can be
typed into the

New.

textbox, or it can be Edrl

located and selected
using the browse
option. Using the file
browser is usually

Remove

the easier and more Re contents
reliable method. nalrile4h6
There are two radio
buttons that provide
Link and Import
options, and here we

Done I Help jare using the link
method so make
sure that this button Fig.1a20 The linked sty.'e sheet listed in

is selected. the Edit Style Sheet window

With everything set up correctly, operate the OK button to return to the
Edit Style Sheets window, whioh should now show the name of the style
sheet in the upper panel. The two styles held wi7hin that style sheet will
be listed in the lower panel 'Figure 13.20). Left -click the Done button to
return to the document, where the CSS Styles window should now show
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1E322:3111.11V,,:."
..i)css styles

I fig is J
Fig.13.21 The class linked from the

style sheet is now listed

the new class obtained from the
style sheet (Figure 13.21). There
is nothing obvious to show that
the heading style has been
successfully redefined, but if you
use the relevant tag and the new
class the text should be formatted
accordingly (Figure 13.22).

Style sheet editing
The styles held within a style
sheet are nct "set in stone", and
it is possible to edit or delete the
existing styles or add new ones.

Any changes made to an existing style will affect all instances of that
style in documents. If you wish to change some instances and not others,
a new style must be defined and applied to only pieces of text that need
to be changed. To edit a style sheet start by opening the Edit Style
Sheet window using the popup menu of the CSS Style Sheets window.

Mr-'221117-"-1111111110Seekti

tevt has been formatted usin,Q the
Ileadink 6 (h6) style obtained from a
linked style sheet.

Fig.13.22 Styles applied using the linked style sheet
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Ast

C.

This text has been fin -matted
using the Heading 6 (1,6) style

This text is
sheet

I itnougea .r1111.0 MOWRY". Tww. nior4

style

Fig.13.23 The apply button enables changes to he previewed in the
document window

Select the style sheet you wish to edit and then operate the Edit buton.
In the new window that appears select the style that you wish to alter
and then operate the Edit button. This brings up the usual Style Definition
window where any settings for the style can be altered as required.

Note that if you operate the Apply button, any changes that have been
made will be applied to appropriate blocks of text in the document
window, giving a useful preview facility. Compare Figure 13.23 with
Figure 13.22 for example. The Heading 6 style has been increased in
size from 36 points to 48 points and then the Apply button has been
used. When the necessary ct-anges have been made, operate the OK
button to return to the previous window where the Save button can be
used to save the changes to cisc.

Other editing is possible from this window, and a style can be deleted
by selecting it and then lett clicking the Remove button. Of course, any
formatting provided by the deleted style will be removed. Operatinc the
New button enables a new style to be defined, and this is just a matter of
repeating the processes used to produce the existing styles. The
Duplicate option enables a new style based on an existing one to be
produced. This avoids having to go through dczens of settings when
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Type (c,es)

Bedefine HTML Teg

r Vs. CSS Selector

Defineln C J

Fig.13.24 Duplicating a style

OK

Cancel

Heir

there are only one or
two that are different
from an existing
style. By
"borrowing" all the
settings from an
existing style, only
those that are
different in the new
style have to be
altered.

Suppose that a new heading style is required, and that it is the same as
the modified heading 6 style except that the size parameter is to be 24
point instead of 48 point. First the h6 style is selected and then the

Duplicate button is
eft clicked. Thisx!

orings up the
Duplicate Style
window (Figure
13.24), which is
essentially the same
as the window that
appears when
roducing a new

style. The tag that is
selected is h6, but
The new style must
be based on one of
The others, and the
h5 tag is the obvious
choice. This one is

Save I Cancel I Help therefore selected
from the Tag menu.

Fig.13.25 The cloned style added to the list If the new style were
based on a class
rather than a tag, the

textbox would have the name of the existing style with "Copy0f" added
ahead of it. This would be changed to a suitable name for the new style.

Having selected a new tag or name, operate the OK button to return to
the previous window where the new style will be shcwn in the list (Figure
13.25). The new style still has the same characteristics as the one it was

Style definition

h5 t font -family Georgia "Times New Roman" Times
sent, font -size 36pt font -style italic, font -weight bold.
color #666666 text -decoration underline,
background -color #CCCCL-C
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(11,1.1 0.1.11, 41 Ureumwearevr

This text has been formatted using the
Heading 6 (h6) style obtained from a
linked style sheet.
This text is in the h5 stile, which has been produced by
duolicatinz and editing the h6 style.

'61

,41.121:11

44 W .4 0

Fig.13.26 The original style at the top and the half size cloned
version below

cloned from, but it can be edited in the normal way. Figure 13.26 shows
some text in the original style at the top, and in the cloned half size
version below.

Removing classes
If you apply a class to some text and then try to use an ordinary paragraph
style instead, the original formatting will be retained. The class style will
override formatting applied using an ordinary paragraph style, but this
does not mean that once a class has been applied it can not be removed
again. Select the text that you wish to change and then left -click on the
"none" entry in the CSS Styles window. This will remove the class style,
and conventional paragraph formatting can then be applied. If any
formatting of this type has already been used on the text, it will assume
the new format as soon as the class style is removed.

With a class in use you may find that trying to alter some of the
characteristics of the text has no effect. There is one setting it the ciass
and another set via the Properties Inspector or menu system, and the
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Cascaduig style sheets, or Just ('SS as this system is letter known. enable der.gners to define the

appeannice of text in a more flexible fashion than is possible with standard liTML. As the style sheet part

of the name implies, a layle is imposed on the page. If all the links on a page needed to be in bold text,

each link would have to be manually changed to a bold setting using ordinary HTML. Using the style

method the link tag would be modified to include the bold setting so that all the links in the page would

be automatically set to bold text. If you did not like the look of the finished page it w otdd not be

necessary to change each individual link back to normal. The link tag would Oe altered and all the links

would then return to normal. Using lhasunweaver it is not necessary to get deeply Involved with the code

in order to use style sheets. and everything can be handled using the menus, dialogue boxes. etc.

It has to be pointed out this style sheets are relatively' new and only work with newer versions of

browsers Microsoft Internet Explorer 4 and later or Netscape 4 and later versions are suitable. Once

again, it is something that is gaimng in popularity zu the older browsers fall om of use. bull it is still not

safe to assume that all browsers will work properly with style sheets

Fig.13.27 Text with the standard line height (top) and increased line
height (bottom)

winner will be whichever places its tags closer to The text in the HTML
code. Style sheets work best with the blanket approach to formatting,
which is the type of formatting normally needed. If "bits and pieces"
formatting is required it will probably be necessary :o do it the hard way,
formatting each piece of text individually. This can be done using the
Properties Inspector, or by defining numerous classes if formatting
beyond the capabilities of the Properties Inspector is required.
Remember that a class does not have to be applied to a complete
paragraph. The dragging method (also known as spanning) can be
used to select a block of text and a class or paragraph style can then be
applied to that text.

Attributes
Having looked through the various pages in the Style Definition window
you will have noticed that it is possible to apply a lot more attributes
using styles than the usual size, font, colour, etc. Most of the settings in
the initial page (Type) are straightforward text attributes that do not merit
any further explanation. There are a couple of exceptions, one of which
is the Line Height setting. In Figure 13.27 the text in the top paragraph
has a text size of 14 points and a line height of 20. All the settings are
the same for the lower paragraph except the line height has been
increased to 30 points. By experimenting a little with the line height it is
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Fig.13.28 The style definitior, settings for backgrounds

possible to have the lines of text bunched together, spaced well apart,
or anything in-between.

The case menu enables the text to be set as all lower case, all upper
case. or capitalised. The latter means that the first letter in each word is
set as a capital letter. The capitalise and upper case options are good
for headings and short captions. Of course, a normal option is also
available.

Background
This is similar to setting the background colour or image for a page, but
there are more tiling options for images. Figure 13.28 shows the
background version of the Sty e Definition window. The Repeat option
provides normal tiling, and the No -Repeat setting switches off tilinc. If

the image is too small, with no tiling selected it w II only occupy the top
lett-hand section of the screen and the rest will have the normal
background colour. The X and Y versions of repeat tiling only proN.ide
this facility in the horizontal and vertical directions respectively. Figure
13.29 for example, shows a background image teat uses the Repeat -X
version. The horizontal and vertical offsets enable the background to
be offset from the top left-hand corner of the screen. In Figure 1.30
respective horizontal and vertical offsets of 100 and 50 have been used.
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IT.

Fig.13.29 A background thaf ises Rep3at-X cption
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Fig.13.30 An cffset background image
ttiiWsiator--
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Style lielinition Itn mnintexi in linkstyle2 CSS
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Fig.13.31 The Block section of the Style Definition window

The attachment menu offers Fixed and Scroll options. Scroll is the no-mal
method, whereby the background image scrolls together with ether
content on the page. With the fixed option, if the browser supports this
feature, the background image remains fixed when the other content is
scrolled.

Block
The block section of
the Style Definition
window (Figure
13.31) provides
control over various
typographical
settings that can be
used to alter the
appearance of the
text. In most cases
the defaults give text
having a very neat
appearance, and it is
not essential to alter

Cascading stylesheets or just CSS asthis system is better
known enabledesigners to define the
aPPearance of text in 3more flexible fashion
than is possible withstandard HT ML As thestyle sheet part of thename implies. a styletmoncori nn t ho

Fig.13 32 Word and letter spacing are adjustable
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Cascading style sheets. or lust CSS as this system is better known, enable
designers to define the appearance of text in a more flexible fashion than is
possible with standard HTML As the style sheet part of the name implies, a style
is imposed on the page If all the links on a page needed to be in bold text, each
link would have to be manually changed to a bold setting using ordinary HTML.
Using the style method the link tag would be modified to include the bold setting
so that all the links in the page would be automatically set to bold text If you did
not like the look of the finished page it would not be necessary to change each
individual link back to normal The link tag would be altered and all the links
would then return to normal Using Dreamweaver it is not necessary to get
deeply involved with the code in order to use style sheets, arid everything can be
handled using the menus dialogue boxes, etc.

It has to be pointed out that style sheets are relatively new and only work
with newer versions of browsers Microsoft Internet Exporer 4 and later or
Netscape 4 and later versions are suitable Once again, it is something that is
gaining in popularity as the older browsers fall out of use, but it is still not safe to
assume that all browsers will work properly with style sheets

Fig.13.33 These paragraphs have full justification and indents

any of these settings. The word and letter spacing, as one would expect,
simple adjust the spacing between words and characters in a word. In
Figure 13.32 these have deliberately been set very large at 2 millimetres
and 4 millimetres in order to illustrate the range of control available.

Options in the Text Alignment menu include the usual left, right, and
centre justifications, but it is worth noting that full justification is also
available. This is not a normal HTML alignment option, and it is not
available by way of the Properties Inspector, etc.

Using the Text Indent option it is possible to indent the first line of each
paragraph by a specified amount. In Figure 13.33 tiis facility has been
combined with the full justification option. The amount of indentation in
Figure 13.33 is a nominal 10 millimetres incidentally, but a very wide
range of settings can be used.

Whitespace governs spacing within the text. With the No -Wrap option
any soft returns are ignored and each paragraph is forced onto a single
line.
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Fig.13.34 The Box section of the Style Definition window

Box
The box page of the Style Definition window is shown in Figure 12.34.
The padding option enables a "no-go" area to be placed around the
selected text, and this opera:es much like the similar facility for table
cells. This facility is very effective when used in conjunction with the
Float menu. The float facility enables a block of text to effectively b 3 set
aside from the main flow of text. It can be left or right aligned, with the
rest of the text flowing around it. In Figure 13.35 the main body cf the
text is in the normal Paragrapi style, but some of it has been formatted
using a style that includes floating with right alignment, plus 20 pixel
padding on all sides. Some soft returns have also been added to the
text to break it up into lines of a similar length.

Unfortunately, the Dreamweaver design view can not show a fair
percentage of the style sheet attributes, including the ones used here.
Hence the text does not look particularly good in Figure 13.35. However,
the formatting is produced properly when the text is viewed using a
browser (Figure 13.36). On the face of it there is no difference between
the padding and margin facilities. The difference seems to be that
padding is placed between the border of the element and its content,
while the margin is placed outside the perimeter of the content. In other
words, under some circumstances the margin option will reduce the
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Cascading style sheeis or lust CSS as this system is better known enable designers to define the appearance ol
text as a more flexible lashion than is possible with standard HTML As the style shee part ol the name impies a
style is imposed on the page q all the links on a page needed to be as bold text each fink would have to be manually
changed to a bold setting using ordinary HTML Using the style method the link tag would be modified to include the

bold setting so that all the links in the page would be automatically set to bold text If you did not like the

look of the finished page it
would not be necessary to
change each individual link
back to normal The link tag would be altered and at the links would then return to normal Using
Dreamweaver a is not necessary to get deeply involved with the code in order to use ityle sheets and everythrig can
be handled using the menus dialogue boxes etc

It has to be pointed out that style sheets are relatively new and only work with newer versions ol browsers Microsoft
Irdemet Explorer 4 and later or Netscape 4 and later versions are suitable Once again a is something that is gaining
in popularity as the older browsers fall out ol use, but it is still not sale to assume that all browsers will work property
with style sheets

Fig.13.35 This formatting does not look very good in the design view
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Cascading style sheets, or just CSS as this system is better known, enable designers to
define the appearance of text in a more flexible fashion than is possible with standard
HTML. As the style sheet part of the name implies, a style is imposed on the page. If all the
links on a page needed to be in bold text. each link would have to be manually changed to a
bold setting using ordinary HTML. t sing the style method the link tag would be modified
to include the bold setting so that all the links in the page would be automatically set to
bold text. The link tag would be altered and all the link, would then return to normal. Using
Dreamweaver it is not necessary to get
deeply involved with the code in order to If you did not like the
use style sheets, and everything can be
handled using the menus, dialogue boxes. look of the finished page it
etc would not be necessary to

change each individual link
back to normal.

It has to be pointed out that style sheets are
relatively new and only work with newer
versions of browsers. Microsoft hiternet
Explorer 4 and later or Netscape 4 itnif later

browsers fall out of use, but it is l not safe to assume that all browsers will work
versions are suitable. Once again, it is something that is gaining in popularity a the older

properly with style sheets.

.±_

My Comae..

Fig.13.36 When viewed using a browser the correct effect is obtained
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fltylelino-non for maintext in linkslyie2CSS

*Lett -A'

510e

Indic etas seyi?s not currently dtspleyed n Dreearmeaver

Cancel I Apply

Fig.13.37 The Border page of the Define Styles window

amount of space available to other elements rather than ccnstrai ling
the content of its own elemen:.

Border
The page for border settings is shown in Figure 13.37 and fairly
straightforward. Each section of the border is individually adjustable for
thickness and colour, and there are numerous styles available. Ir the
example of Figure 13.38 the Inset border style has been used with some
padding to keep the text ao.ay from the border.

List
This page, which is shown it Figure 13.39, is only relevant if a list is
being formatted. Various pullet styles are available, and there is a useful
facility that enables an image to be used for the bullets. Figure 13.40
shows a list that uses a 50 by 50 pixel Jpeg image for the bullets. Here
the formatting has been app ied to the complete list, but it can De applied
to a single line using the dragging method to select the line. It would
presumably be possible to have a different image for each line by creating
and applying a different style to each one.
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Ede y. Fs,... Do,
knows. edatolls driers* Is Mess -

2 a s",,, J R

Cascading style sheets. or Just CSS as this system is better known
enable designers to define the appearance of text in a more flexible
fashion than is possible with standard HTML As the style sheet part of
the name implies a style is imposed on the page If all the links on a
page needed to be in bold text each link would have to be manually
changed to a bold setting using ordinary HTML

It has to be pointed out that style sheets are relatively new and only
work with newer versions of browsers Microsoft Internet Explorer 4 and
later or Netscape 4 and later versions are suitable Once again, it is
something that is gaining in popularity as the older browsers fall out of
use, but it is still not safe to assume that all browsers will work properly
with style sheets

F.g.13.38 Borders added to two paragraphs

12=1=11111111111INE,
Ust

qype

vullet Image'

Eoselon

Indicates styles not currently displayed in Dreamweciver

A

Browse

OK I Cancel -Apply----- Lielp

Fig.13.39 The List section of the Style Definition window
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Positioning
The positioning
settings (Figure
13.41) are used with

layers, and they 111,,,11 1.+.111unnnor

should look familiar if bola; home dead mac or blvdt

you have read 1.1." twwne nietg or bord,

through chapter 11.
Although for use with
layers, the cs mck ,arpet

positioning not rat ,en mach

properties can be
FIV, iln te, mot

applied to other
objects such as
images and blocks of

Fig.13.40 Small images used as bullets

text, which are then
placed in new layers. The Dlacement parameters are worthy of some
amplification, since they prcviie a means of positioning objects or the
page with high precision. When used with absolute positioning, the
placement parameters set the layer so that its top left-hand corner is
offset from the equivalent cprier of the parent object by the spec fied
amount.

Style defimhon for !armies*

Pu- sMonor

.%tl% itir_attes or cats as pets:

PCSM fling

13,13e

Yosparty

Flocement

Left F

lop

ettp

:J I -,c,12 I :ii _LI

2-1. I _Id BP' Jr -73

Height I

I _:J

:_11 J Leitr

'Ind.:ales styles rot currenttydtspleyed m Dreenweevot

-I Cancel I Appty I dell)

Fig.13.41 The List page of the Style Definition window
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It -7M. iota *0. a+. too... Jo.

*I &Pk c er: Q.

Fig.13.42 An image plac 01 the page in the normal way

Eft ta. Y.,

At. 7.

Fig.13.43 The image has been placed in a layer by applying a style
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Pr*, I.,. [1.#0

.3 11

The Royal Yacht Rrftannia on Its last visit to London

Go-

Fig.13.44 The image and caption are perfectly positioned when the
page is viewed using a browser

Figure 13.42 shows an image placed on the page in the top left-hand
corner. In Figure 13.43 the image has had a style applied, and this has
moved it 300 pixels to the rght and 100 pixels down from tie parent
object. Of course, the parent object is the page itself, so the offset is
from the top left-hand corner of the page. The tab of the newly generated
layer can be seen at the top left-hand corner of the image. Next scme
text was typed onto the page and then moved into position just above
the image using another style. The Apply button plus some trial and
error soon found the optimum position for the text. When viewed Using
a browser the image and text were perfectly positioned (Figure 13..4).

Extensions
Figure 13.45 shows the Extensions page of the Style Definition window.
It is possible to apply clever effects using these options, although the
majority of browsers do not necessarily support them. The mouse pointer
can be made to change when it is over the object to which the style has
been applied (Figure 13.46), and various filter effects are available. Figure
13.47 shows the Invert effect applied to a photograph.
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1/P
Background
Bieck
Box

Li

POSONIM

Extonsioft

laelore:

Page Break

Indcates stytes not errantly displayed in Oman -weever

OK Cancel
I

APPI'l I
help I

Fig.13.45 The Extensions page of the Style Definition window

Fig.13.46 The standard pointer is replaced by the hand version
while it is over the image
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Eft Edo YOM rfno
4) Wan* Alf*.

 .1211!
1.

.0 St

I he Roltal 1 :Icht Britannia on its last .Isil to London

taimy

Fig.13.47 The Invert filter applied to the image

.argirt:

Finally
From this quick look at styles and style sheets it should be clear that
they enable pages to be set out in ways that would be difficult or
impossible using ordinary I-TML. If you need to design complex pages
then styles are well suited to the task. They are also very good wiere
there are numerous pages to be produced and a uniform style is needed.
Using style sheets it is possible to quickly format the pages. It is certainly
well worthwhile spending some time exploring their possibilities.
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Uploading

Look and learn
In a book this size it is not possible to cover all aspects of Dreamweaver,
but with the information in the previous chapters it is possible to produce
some quite sophisticated sites using this program. If you do a tour of
the web looking at a variety of sites you should now be able to see how
most of the sites are put together. Using the methods described
previously you can add text to a page and format it in various ways, add
images, sounds, jump menus, frames, flash text and buttons, link to
files for downloading, and a great deal more. It is a good idea to
experiment with methods available in Dreamweaver, making up some
dummy pages and sites so that you become reasonably fluent with tieir
use before going on to the real thing.

It is also well worthwhile looking at a good range of sites and casting a
critical eye over them. It is good to learn from your mistakes, but it is
much better to learn from the mistakes of others. For example, if vou
find some methods of site navigation easy to use and otiers very
confusing, it is quite likely that others will concur with your find'ngs. Jse
the methods you feel work we I and ignore the rest.

Upload info
Having completed your web site there is the minor matter of uploading
it to the server. If your computer is connected to the server via a LAN
(local area network) you will presumably know how to upload it, or
whoever looks after the system will be able to do it for you. For most of
us the connection to the server is via a modem and a telephone I.ne.
There are programs available that can be used to upload a site to a
server, but one of these is not essential with Dreamweaver as it has built-
in facilities for uploading sires. The method described here utilizes
Dreamweaver's integral uplcading facilities.
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M=MMIMMINIIIIINOW In order to upload
Giaiwy Loom,* the files in your site

you need to giveFoonabs Ink
Sk.N.... IIIIML'evsp Note,

Foie v... :csumr. 1.....eintEniekk 1 . -1 Dreamweaver the,-.........,,,,,,,

fie Iteunomakm., information it will
require to make the

217P A.*. transfer. It is
Mb.' elan. L.0' , presumed here that

treb s,e the site has been
k C

I f* mete meketaans 'le arxt essin ram, vf. defined, but that the
In,. Ale Ths  pop* ao Ito .tel r

information needed
to transfer the site to
the server has not yet
been entered. Start

Fig.14.1 The Site Definition window by selecting Define
Site from the Site
menu, which will

bring up a list of existing sites. Select the appropriate site from the list
and then operate the Edit button. This will bring Lp the Site Definition
window (Figure 14.1), but this is not the page that is required. Select
the Remote Info option in the Category list on the left, which will produce

a rather empty
looking page (Figure
14.2). Choose FTP
ifile transfer protocol)
Irom the Access
menu, which will
result in several
textboxes being
added to the window
;Figure 14.3).

The host directory
can sometimes be
left blank, but the
other three text
boxes must be filled

Fig.14.2 The initial version of the Remote with the relevant
Info page information. The

web space provider
should have supplied this information when you fist hired space from
them, or when you opened an account with a free web space provider.
If you are using free server space provided by your SP it is possible that

11====1111111111111M

284



Uploading 14

Site Definition for LeySite

Category Remora into

9c:f'

dost

Host pee /my I

Login

Password

I- Use Passive ETP

r- Use Firewell (,n Preferences)

r Say*

aeck InfOut r Enable File Checl, In and Died, Out

01 Cancel bap

/El

Fig.14.3 The FTP options available from the Site Definition window

this information was not provided when you opened your account, but it
should be available on request. Here is a brief explanation of the
significance of each of the four settings.

FTP Host

This is the web address of the host, and it will usually be similar to the
initial part of your new site's web address. However, it will start "ftp"
rather than "http".

Host Directory

This is the particular directory on the host's serve- that the new site Nill
occupy. This is not always needed, because the server will often be
able to find the right directory from the other information prov ded.

Login

This is also known as the User Name and User ID. Obviously the serer
does not give free access to anyone who would like to upload a s te,
and the Login name is a means of identifying the user to make sure they
have authorisation to use the server.
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Password

The password is used to verify that you are who you say you are. The
login and password operate in the same way as their equivalents when
signing on to an ISP. Get either of them wrong, even in a very minor
way, and you will not gain access to the server. Dreamweaver will
remember your password if you leave the Save checkbox ticked, and it
will then be unnecessary to enter it again. Note though, that the password
is saved as a simple text file on the hard disc, and that it is not encrypted.

Some web space providers, and particularly ISPs, have their own way of
handling things. It may be necessary to be logged into the host ISP
before the uploading can take place, which will only be of importance if
you use more than one ISP. You may then have to use somewhat non-
standard entries in some of the fields in order to access the server. It

pays to read the connection information provided by the host before
attempting to upload your files. Where the host provides software for
uploading sites it might be better to use this instead of the built-in facilities
of Dreamweaver.

Connecting
In order to upload your site it is necessary for the computer to have an
active Internet connection, so make sure the PC is connected to the
Internet before you start the uploading process. Uploading is done
from the Site window for the relevant site, so start by selecting Open Site
from the Site menu, and then select the appropriate site from the submenu

that appears. This
should produce the
Site window, with the
files for your site in

P4111016 s.r 1 Nn I s..el I INothe
right-hand

section. Figure 14.4
shows the Site
window for the
simple one page
dummy site used for
this demonstration.

Er Er Yr. tbrr., 1:19

1 sr . 0 I

II
I

II

Fig.14.4 The files for the site listed in the
Site window

There are two
buttons on the
toolbar that have
arrow icons. The
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4 Stle - Sdel ISOE
File Ldit View Site Window Help

Site )Srtel -14 C
Remote Site

L.1

I ft, I Sizej, Locsl Folder VIci

htm
A kohint jpg

4I 1

Fig.14.5 The folder for the remote site appears in the left-hand section
of the window

one having the upward pointing arrow is for uploading files, and the one
with the downward pointing arrow is for download ng files from your site
to the hard disc. In Dreamweaver terminology these are the Put and Get
commands respectively. In this case it is uploading Ne require, so operate
the Put button. If the FTP settings are incorrect you will get an error
message, and the settings will have to be checked. If all is well the left-
hand section of the window will show the folder that will be used for your
site, and there will probably be an index file already present (Figure
14.5). This file is placed there by the host and wil be overwriten wren
you upload your site.

One or two messages will appear
before the uploading takes place.
The one of Figure 14.6 asks if you
wish dependent files to be 17 L,..wio.or,ov,q

included. Answer yes to this or
there could be some blank
spaces left in some pages, b ind Fig.14.6 Answer yes if this warning
links, etc. The other message message appears
(Figure 14.7) asks whether the
entire site should be uploaded. Since this is the first time the site is
being uploaded it is clearly recessary to have all the files transferred.

Deponden1 f Ilff 13

1r [lade Ceennilent FoK7 Yes I

tin

Cancel
I
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-u-lx1 The upload should
then proceed, with
the progress being
shown in the status
bar of the Site

Fig.14.7 Operate the OK button if this
message appears

Er Edo

sft ISoe'

RIITICAS SAM

Weldor Help

window (Figure
14.8). When the
process has finished
the transferred files
should appear in the
left-hand section
of the screen,
confirming that
everything has
been transferred
successfully (Figure
14.9).

You can then exit
Dreamweaver and
use the browser to
access your new site.
Figure 14.10 shows
the page of the
dummy site used for
this demonstration.

i I J Unfortunately, the
Pang*, Rawl ipg 32768 o. 4411 trywg wow IMO u browser used to view

Fig.14.8 The status bar shows how the the page has been
upload is progressing set for large text,

which has caused
the caption to word-wrap. This does illustrate the point that that things
can easily go wrong with web page layouts, even with the most simple
of pages.

2:j Act '

1No 7.45.

Synchronising
It is likely that before too long it will be necessary to update your web
site. If new pages are added but no changes are made to any of the
other files, there is no problem. Just go through the standard upload
process and the new file or files will be added to tt-e site. In most cases
some existing pages will have been changed, if for no other reason that
some new links will be required for the new pages.
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Site - Site 1 ea©
Eile Edit View ,site LNmdow bielo

Site ISirel

Re -note Site I No Local Folder

Fig.14.9 The transfer has been completed and al, the files are now on
the remote site

I am beginning
to get cold feet

Fig.14.10 The dummy site viewed using a browser
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Site - Sitel P113113
Fcle Edit View aite Window belp

L. Site ISitel

'!mote Site
- irapentold/

41 Fox -2 tog
A index htrn
M Leigh htm

Pagel htrn
Robin! tpg

4j

.14 C
No Local Folder

1 local items selected totalling 236 bytes

Fig.14.11 The highlighted file on the right is the only one that
needs updating

Dreamweaver will not automatically overwrite any old files with new ones.
With Dreamweaver connected to the remote site a check can be made

to determine which
files have newer

_Laid versions on the local
site than on
the remote site.
In other words,
Dreamweaver can
detect the files that
need to be updated.
To do this, go to the
Edit menu of the Site

.1 J JI the Select Newer
window and choose

1.4.1*
Local option. The

Fig.14.12 Selected files or an entire site files that need
can be synchronised updating will then

appear highlighted in
the right-hand section of the window. In the example of Figure 14.11
there is just one file that needs to be uploaded.

Ehochniesre FAN

.37=712Mr.MIMMIMI -
DMGlIG,

r o444. nom* ,c1 or box du.

290



Uploading 14

Remote Sit

11

tl

Unchecked hles will not be processed

Action I File

.1; Put I Leigh htni

Files I will be updated

Unchecked tiles will not be processed

41
1 1 local items selected totalling 277 bytes

Status

Cancel delp

Fig.14.13 A list of proposed changes is provided

The safest way to update files is through the synchronising feature. This
is available from the Site menu of the Site window, and when selected a
window like the one of Figure 14.12 will appear. In the upper menu
you can opt to
synchronise only the
selected files or the t.
entire site. The
default setting in the
lower menu is the
one we require, and
it will result in newer
files on the local site
overwriting those on
the remote site. If the
checkbox is ticked,
files that exist on the
remote site but not e wade:MON 106 bytes

on the local site will Fig.14.:"4 Once completed, a summary of
be deleted. This will the changes is provided
automatically delete
any files on the remote site that are not currently in use, but if a file has
been accidentally deleted on the local site this will result in its removal

Sync hmnetelson curnpluir

File

P , Mtn

1

Srnctusszelo,

"" Lek

41

-11111111l1
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from the remote site as well. It is safer not to use this option, and to
manually delete unwanted files on the remote site. This is done in the
same way as deleting files from the local site. Select them in the Site
window and then select the Delete option from the File menu.

To proceed with the synchronisation operate the OK button. A form
showing any files that will be changed is then produced, and the
proposed action for each file is included in the list. Each action will only
be carried out if the corresponding checkbox is ticked, so you have a
chance to review things and abort any actions that you do not wish to
go ahead with. Left -click the OK button to continue, and the appropriate
files will be updated. A window like the one i I Figure 14.14 will then
appear, giving a summary of the changes that have been made. Operate
the Close button to return to the Site window, and your site should now
be fully updated.
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Appendix 1

Useful Web addresses

http://www.macromedia.com

http://www.macromedia.corm'support/dreamweaver/

http://www.macromedia.com,'exchange/dreamweaver/

This is the web site of Macromedia Inc., the company that D rod uces
Dreamweaver. A fully work ng 30 -day demonstration version of
Dreamweaver can be downloaded from this site (Windows PC and
Macintosh versions), and there are also demonstration versions of other
Macromedia products available. The Flash and Fireworks programs
are well worth trying. The second web address takes you direct to the
Dreamweaver Support Centre. The third address is for the Dreamweaver
Exchange, where various Dreamweaver extensions are availab e. These
enable the capabilities of Dreamweaver to be increased, and :he
extensions provided here are cesigned to be easy to install.

http://www.dreamweaverfever.com

This site also provides Dreamweaver extensions, but there are also some
documents about various aspects of Dreamweaver.

http://www.andrewwooldridge.com/dreamweaver/

This is the Dreamweaver Depot web site. It provides Dreamweaver
extensions and general Dreamweaver news.

http://www.macromedia.com/support/coursebuilder/

Various extensions for Dreamweaver are available for download hire
provided you are a Dreamweaver owner.
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http://www.owlnet.net/dwnews/

A Dreamweaver news site, but it actually has a lot more than news.
There is a used FAO section, numerous links to otter sites, etc.

http://hotwired.lycos.com/webmonkey/

Not a Dreamweaver site, but one that provides general news and
information about the web, such as web standards.

http://www.w3.org

Again, not a Dreamweaver site, but one that covers HTML, XML, Png,
and a great deal more. A very useful reference site.

http://www.htmlhelp.com

The name of the site tells you what this one is all about. In addition to
the substantial amount of reference material available from the site there
are useful links to other sites.

http://www.dhtmlzone.com/

The Dynamic HTML Zone web site. Again, not a site specifically for
Dreamweaver, but one devoted to DHTML. There are articles, forums,
tutorials, etc.

http://wdj.co.uk/JavaScriptWeenie.html

A general JavaScript site which has tutorials, discussions, articles, and
all the usual things.

http://home.netscape.com/browsers/

If you need to try out your web pages with the latest Netscape browsers
they are available for download here.

http://www.microsoft.com/windows/ie/

This section of the Microsoft Inc. site has the latest version of Internet
Explorer ready for downloading.
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http://www.opera.com

You could be forgiven for thinking that Netscape and Microsoft are the
only companies that brodLce browsers. However, there are others
available, and Opera is procably the most popular apart from the big
two. It is available for download at this site in various versions. including
Windows, Macintosh, and Linux types.

These web addresses have been checked, but note that web sites do
sometimes change addresses. There are numerous sites devoted to
Dreamweaver and web topics, so any search engine should proviae a
huge range of additional sites.
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Symbols
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colour -mixing
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content frame

176, 195
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conversion 33
convert 206
Copy 138
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CSS 12, 35, 253
CSS window 254
custom colours 46
custom style 258
customising 17
Cut 69
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define site 123
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delete row 190
deleting cells 190
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desktop publishing 23
DHTML 35
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DOM 36
download time 17

downloading 158
dragging
draw layout cell
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edit grid
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Flash 36 home page 132
Flash button 244 horizontal space 1)5
Flash properties 242 host director/ 234
Flash text 240 hotspots 143
float
folder
font
font list

37,
10,
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240
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HTML
HTTP address

12, 24, 39
124

font preview 58
fonts 56 icons 5

form delimiter 232 icons only 5

forms
frame border

8, 231

166

image
image alignment
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98

frame -free 181 image editing 108

frames 9, 163 image file 96

Frames window 169 image free 110

frameset 164 image rollover 113

frameset settings 175 images 6, 93

FTP 284 import table 209

FTP host 285 importation 53

full justification 60 imported style 254

full-size tables 194 importing 69
indent 272
indenting 60
inserting cells 190

Get command 287 interface 1

GIF 31, 203, 228 Internet Explorer 140
Go button 237 Invert filter 281

graphics conversion
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grouped palettes

17,

33
206
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invisible elements
invisibles
ISP
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H

handles
head

95, 200
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Java 35
header cell
heading style

192
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JavaScript 12,

Jpeg
35, 116, 247

29
Heading styles 256 Jpg 29
hexadecimal 26, 45 jump menu 235
Hidden setting 224 justification 60
History palette 14
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245
283
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221
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219
217

L

label
LAN
Launcher
layer position
layer preferences
layer properties
layer visibility
layers
layers to table

6, 211

226
Layers window 213
layout cell 198
layout view 9, 197
Left 103
left justification 60
letter size 10
line art
line breaks

31, 97
78

Link Checker 147
linked style 254
linking images 143
links
list options

26, 137
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lists 83
loading images 93
local folder 123
local site
login

95, 119
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low source 112

M

macro 15
Macromedia 240
margin 273
margin width 174
mark-up 25
markers 154
match case 66
menu (jump) 235
menu editing 238
menu system 4

merging 188
Middle 99
MIDI 34
Mini Launcher 12

modem 17

modified tac 253
Modify menu 41

Most Accurate 226
Mov 34
MP3 34, 161
Mpeg 34
Mpg 34
multiple selection 98
music file 161

N

named anchor 152
naming 98, 172
navigation frame 163
nested frames 170
nested framesets 171

nested layers 216
New 39
new file 128
new site 122
no resize 174
no wrap 193
NoFrames 182
non -breaking space 80
numbered list 84

0
Objects palette

3, 79, 185, 232
On Click 251
On Error 251
On Mouse Over 249
Open 37
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orphan files 150

300



outdenting
oval hotspot
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Reference window 12
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relative links
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137
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palettes 3 relative URL 120
paragraph 21 remove site 122
paragraph stile 75 removing classes 267
paragraphs 75 removing links 142
parent 177 Repeat -X 270
password 286 replace 64
Paste
path

69, 1:38

41
replay
reset origin

15

20
path name 138 reset size 108, 243
PDF
picture quality

25, 34
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resize
resized

173

95
pixels 174 Right 103
planning 134 right justification 60
Play button 243 rollover 113
Play Sound 248 root folder 121
playing files 151 root relative 138
Png 32 roundtrip 24
pointer
polygon hotspot
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rows
rulers
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popup message 251 rules 90
position (layer) 221

positioning 277
Preferences
preformattec
preset format
preset frame
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S

Save
Save As
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preset framesets 184 scroll -73
prevent overlaps 214 scrollbar 224
preview 49 scrollbars '73
printing 52 search 66
Properties Irspecto' 10 self 77
Put command 287 SGML 25

shading 91
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tab key 79

shareware
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show grid 206 table cell 187
Site Checker 148 table data 209
site deletion 130 table format 208
site map 132 table structure 186
site selection 131 table to 'aye's 206
Site window
site -root

122, 286
138
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tabular data
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size (layer)

151

221
tag
tags

21, 253
26

Smallest option 226 targeting 177
snap grid 17 testing links 139sound file
source files

33, 249
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text
text cursor

53
54source object 248 text editing 21

space 104 text only 5
spacer image 203 text size 54
spacing 188 text styles 59
special 9 Text Top 99
special characters 61 thumbnail 169spelling check 62 tiling 41splash page 181 toolbar 3split frame down 167 Top 100split frame left 165 top 178split frame right 167 tracing image 42split frame up
splitting
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188

transparent GIF
trigger

203, 228
247spreadsheet 209 TrueType 240stacked layers 213 Txt 32standard view 9
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strikethrough 60 U

style class 258 underlining 60
style creation 254 undo 15
Style menu 244 unordered list 84
style sheets 253 uploading 283
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symbols 7 user interface 2
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value 27
vertical space 105
visibility 217

WAV file 247
web address 137
web friendly 47
web safe 47
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window size 16
Word 2000 72
Word 97/98 72
Word cleanup 71

word processor 53
word-wrap
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54, 193
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Using Dreamweaver 4
It may be something of an advertising cliché, but Dreamweaver 4 really is
a top quality professional program that is easy to learn and use. You can
use it almost straight away to produce simple pages containing text and
graphics. As your expertise increases you will soon be able to produce
more complex layouts and add the latest gimmicks such as rollovers and
fancy buttons. With a copy of the Dreamweaver 4 software you can fol-
low the examples in this book and then experiment with your own ideas.
You will not become an instant expert in every aspect of Dreamweaver 4,
but you will quickly learn how to produce professional looking web sites
and publish them on the Internet.

This book shows you how to: -

 Create simple but effective web pages using text and graphics.
 Manage and upload your sites.
 Use tables for data or for page layout.
 Use the new layout tables for easy page layouts.

Create an image map and use hotspots.
Build framesets and use frames effectively.

 Use layers for creative page designs.
 Use style sheets for more precise page design.
 Produce fascinating and exciting web pages with sounds, rollovers, Flash

text, and Flash buttons.
 Create a form and use a lump menu.

This book is an essential addition to the library of anyone who wants to
produce a professional looking web site with the minimum of effort and
difficulty.
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